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I. Những điểm mới trong Microsoft Excel 2010 

1. Chức năng Backstage View  

Giao diện ribbon của Office 2010 được đưa vào tất cả các ứng dụng trong gói Office 2010.  

Công cụ Backstage View được truy cập qua phím Office (góc trên bên trái), hỗ trợ sử dụng các tác 

vụ như lưu tài liệu hoặc in ấn.  

 

Thanh định hướng bên trái của Backstage View chứa nhiều lệnh, như cho phép ai sửa tài liệu, kích 

cỡ file...  
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2. Thêm tính năng Sparkline  

 

Excel luôn có dữ liệu đồ thị và biểu đồ rất phong phú để mô tả dữ liệu và xu hướng. Với Excel 

2010, Microsoft đã bổ sung thêm một tính năng mới - Sparklines. Tính năng này cho phép người 

dùng đặt một đồ thị cỡ nhỏ (mini) hay một dòng nhận định khuynh hướng trong một ô (cell). 

Sparklines là cách nhanh nhất và đơn giản nhất để thêm thành phần đồ thị hiển thị vào một cell. 

  

 

Sparkline là cách hữu ích để thêm một yếu tố trực quan nhanh và gọn.  



5 

Trung tâm Công nghệ thông tin và Truyền thông Nghệ An 

3. Tính năng Slicers 

Slicers là một trong những tính năng trong Excel 2010 có thể giúp bạn giải thích dữ liệu của bạn 

dễ dàng hơn. Một cách nhanh chóng, bạn có cái nhình trực quan sâu thông qua số lượng lớn dữ 

liệu.  

 

Ví dụ, bạn có thể sử dụng Slicers để lọc thông qua các dữ liệu của bạn và có thể nhanh chóng tìm 

thấy những thông tin có liên quan 

Khi dữ liệu trong bảng trụ (Pivot Table) thay đổi, Slicer sẽ tự động được cập nhật.  

4. Định dạng dữ liệu có điều kiện 

Chức năng conditional format mới bao gồm nhiề kiểu định dạng và icons và khả năng tô sáng chỉ 

những mục được chỉ định như giá trị lớn nhất, nhỏ nhất .. với chỉ 1 cú click chuột 

 Đây là chức năng rất hay trong Excel 2010. Nếu bạn có một bảng với nhiều số liệu khác nhau, 

thông thường để đánh giá dữ liệu, chúng ta thường dùng các hàm rút trích và lọc dữ liệu. Tuy 

nhiên, với chức năng này, bạn không cần dùng hàm, càng không cần lấy dữ liệu ra khỏi bảng mà 

vẫn có thể đánh giá chính xác dữ liệu qua cách làm nổi bật các ô theo một điều kiện định sẵn. Thực 

hiện như sau: quét chọn một cột hoặc dòng dữ liệu cần đánh giá, sau đó bấm nút Conditional 

Formatting, một menu hiện ra với các tùy chọn: 

Kiểu đánh giá sàng lọc: Kiểu đánh giá này sẽ sàng lọc dữ liệu của bạn ngay tại trong bảng chứ 

không phải trích riêng ra ngoài như các phiên bản Excel trước đây. Chương trình thực hiện “sàng 
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lọc tại chỗ” bằng cách làm nổi bật lên những ô đúng với điều kiện hoặc quy luật do bạn quy định. 

Sau đây là hai nhóm quy luật chính: 

Highlight Cells Rules: làm nổi bật các ô theo một trong các điều kiện: Greater Than... (lớn hơn), 

Less Than... (nhỏ hơn), Equal To (bằng) một giá trị so sánh nào đó, Between (giữa 2 giá trị), Text 

that Contains (ô chữ có chứa chuỗi ký tự quy định), A Date Occurring (theo quãng thời gian), 

Duplicate Values (ô dữ liệu trùng nhau). 

Khi bạn chọn xong một điều kiện làm nổi bật, sẽ xuất hiện một hộp thoại yêu cầu bạn nhập giá trị 

cần so sánh và màu tô nổi bật cho ô phù hợp với điều kiện so sánh đó. Xong, bạn bấm OK để 

chương trình thực thi trong bảng tính. 

- Top/Bottom Rules: quy luật này gồm các điều kiện: Top 10 Items (đánh dấu 10 ô có giá trị lớn 

nhất), Top 10% (đánh dấu 10% số ô có giá trị lớn nhất), tương tự với Bottom 10 Items và Bottom 

10%, Above Average (ô có giá trị lớn hơn giá trị trung bình của cột/hàng), Below Average (ô có 

giá trị nhỏ hơn giá trị trung bình của cột/hàng). Khi bạn chọn đánh giá theo dữ liệu hàng Top hoặc 

Bottom, một hộp thoại yêu cầu bạn nhập số ô cần làm nổi, chẳng hạn như Top 10 hay 20, Top 

10% hay 20%... là tùy bạn tinh chỉnh, sau đó bấm OK để hoàn tất. 

Kiểu đánh giá hiển thị mức độ: 

 - Data Bars: bạn bấm chọn kiểu đánh giá này, chọn một màu ưng ý trong menu hiện ra. Khi đó, 

trong vùng dữ liệu của bạn sẽ xuất hiện cột màu đánh giá mức độ dữ liệu giúp bạn dễ dàng so sánh 

cũng như nhận ra sự tăng giảm của số liệu nhập vào. Cột màu càng dài thì số liệu của bạn càng có 

giá trị cao, ngược lại là những ô giá trị thấp. 

- Color Scales: kiểu đánh giá này sẽ tô màu cho các ô dữ liệu theo 3 màu khác nhau, ứng với mỗi 

màu là mức độ thấp, trung bình và mức độ cao. Khi chọn nhóm Color Scales, bạn hãy chọn một 

nhóm màu bạn thích trong menu hiện ra và sẽ thấy chương trình áp dụng lên vùng chọn của bạn. 

Bạn cũng có thể tạo quy luật màu theo ý mình bằng cách chọn Color Scales > More Rules. 

- Icon Sets: bấm chọn Icon Sets, chọn một nhóm biểu tượng mong muốn, chương trình sẽ tự động 

đặt các biểu tượng trước ô dữ liệu của bạn, giúp bạn có cái nhìn trực quan về bảng tính.  

Ví dụ dấu biểu thị số liệu ở mức độ cao nhất, dấu biểu thị số liệu ở mức trung bình, và dấu biểu 

thị số liệu thấp dưới cả mức trung bình, đáng báo động. Mỗi biểu tượng ứng với một mức độ, 

chương trình sẽ tự động tính toán giá trị trung bình của toàn cột hoặc dòng đang so sánh và tiến 

hành đặt biểu tượng thích hợp vào từng ô theo giá trị phần trăm mà ô đó đạt được so với mức độ 

chung của cả cột hoặc dòng.  

Bạn có thể định lại quy luật đánh giá này bằng cách chọn More Rules trong nhóm Icon Sets. 
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Ngoài những kiểu định dạng có điều kiện trên, bạn có thể tạo riêng cho mình những quy luật đánh 

giá khác bằng cách bấm nút Conditional Formatting > New Rule, tuy nhiên việc này rất mất thời 

gian. Tốt nhất bạn nên sử dụng những quy luật có sẵn mà Excel đã cung cấp rất đầy đủ cho bạn. 

Khi bạn không vừa ý với các định dạng đã chọn, để xóa chúng mà không mất dữ liệu, bạn bấm 

Conditional Formatting > Clear Rules, chọn một trong các kiểu xóa như Clear Rules from: 

Selected Cells (chỉ xóa trong cột chọn), Entire Sheet (xóa trong cả sheet), This Table (chỉ xóa trong 

bảng đang xử lý). 

Có thể nói nhóm công cụ định dạng này của Excel 2010 rất thú vị, nó cho phép chúng ta tạo ra 

những bảng tính được trình bày rất khoa học và bắt mắt. Đặc biệt nhất là tính tự động cao, giao 

diện bảng tính đẹp và khả năng đánh giá, sàng lọc dữ liệu chuẩn xác và độc đáo. Chắc chắn khi sử 

dụng chức năng này, bạn sẽ thấy hứng thú hơn rất nhiều khi xử lý dữ liệu và tính toán trong Excel. 

5. PivotTables và PivotCharts  

Giống như PivotTables, PivotCharts cũng được thực hiện một cách dễ dàng trong giao diện mới 

này. Tất cả những cải thiện mới về việc lọc được cung cấp cho PivotCharts. Khi bạn tạo một 

PivotChart, các công cụ PivotChart đặc biệt và các menu nội dung được cung cấp để bạn có thể 

phân tích dữ liệu trong biểu đồ. Bạn cũng có thể thay đổi layout, style và định dạng của biểu đồ 

hoặc các thành phần khác của nó theo cùng một cách mà bạn có thể thực hiện cho các biểu đồ 

thông thường. Trong Office Excel 2010, việc định dạng biểu đồ mà bạn áp dụng được duy trì khi 

thay đổi sang PivotChart, điều này là một bổ sung nâng cấp để theo cách mà nó đã làm việc trong 

các phiên bản Excel trước đây.  

6. Share Workbook  
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Microsoft Excel 2010 có thể tích hợp với SharePoint để cung cấp các công cụ quản lý nội dung 

dễ hiểu, thuận tiện cho việc chia sẻ kinh nghiệm, tri thức, nâng cao năng suất làm việc nhóm. 
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II. Nội dung chính 

Chương 1: Làm Quen Với Microsoft Excel 

1.1. Giới thiệu Excel  

Excel là gì: 

Microsoft Excel là một phần mềm hay là một chương trình ứng dụng, mà khi chạyr chương trình 

ứng dụng này sẽ tạo ra một bảng tính và bảng tính này giúp ta dễ dàng hơn trong việc thực hiện: 

Tính toán đại số, phân tích dữ liệu 

Lập bảng biểu báo cáo, tổ chức danh sách 

Truy cập các nguồn dữ liệu khác nhau 

Vẽ đồ thị và các sơ đồ 

Tự động hóa các công việc bằng các macro 

Và nhiều ứng dụng khác để giúp chúng ta có thể phân tích nhiều loại hình bài toán khác nhau. 

Workbook: Trong Excel, một workbook là một tập tin mà trên đó bạn làm việc (tính toán, vẽ đồ 

thị, …) và lưu trữ dữ liệu. Vì mỗi workbook có thể chứa nhiều sheet (bảng tính), do vậy bạn có 

thể tổ chức, lưu trữ nhiều loại thông tin có liên quan với nhau chỉ trong một tập tin (file). Một 

workbook chứa rất nhiều worksheet hay chart sheet tùy thuộc vào bộ nhớ máy tính của bạn. 

Worksheet: Còn gọi tắt là sheet, là nơi lưu trữ và làm việc với dữ liệu, nó còn được gọi là bảng 

tính. Một worksheet chứa nhiều ô (cell), các ô được tổ chức thành các cột và các dòng. Worksheet 

được chứa trong workbook. Một Worksheet chứa được 16,384 cột và 1,048,576 dòng (phiên bản 

cũ chỉ chứa được 256 cột và 65,536 dòng). 

Chart sheet: Cũng là một sheet trong workbook, nhưng nó chỉ chứa một đồ thị. Một chart sheet 

rất hữu ích khi bạn muốn xem riêng lẻ từng đồ thị. 

Sheet tabs: Tên của các sheet sẽ thể hiện trên các tab đặt tại góc trái dưới của cửa sổ workbook. 

Để di chuyển từ sheet này sang sheet khác ta chỉ việc nhấp chuột vào tên sheet cần đến trong thanh 

sheet tab. 
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Các thành phần của Workbook 

Excel 2010 dùng định dạng tập tin mặc định là “.XLSX” (dựa trên chuẩn XML giúp việc trao đổi 

dữ liệu giữa các ứng dụng được dễ dàng hơn) thay cho định dạng chuẩn trước đây là “.XLS”. 

 

Giao diện Excel 

Nút lệnh Office chứa các lệnh rất thường hay sử dụng như tạo tập tin mới, mở tập tin, lưu tập tin, 

… và danh mục các tập tin đã mở trước đó. Nút lệnh Office giống như thực đơn File của các phiên 

bản trước.  
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Chúng ta có thể chế biến thanh các lệnh truy cập nhanh chứa các lệnh mà ta hay sử dụng nhất. 

Nhấn vào  để mở danh mục các lệnh và vào các lệnh cần cho hiện lên thanh lệnh truy cập 

nhanh. Nếu các nút lệnh ở đây còn quá ít bạn có thể nhấn chọn More Commands… để mở cửa sổ 

điều chế thanh lệnh truy cập nhanh.  

 

Các lệnh trong thực đơn Office  
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Bảng lựa chọn lệnh truy cập nhanh 

 

Hộp thoại để chế biến thanh các lệnh truy cập nhanh 
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Ribbon là gì? 

Ribbon: Excel 2010 thay đổi giao diện người dùng từ việc sử dụng các thanh thực đơn truyền 

thống thành các cụm lệnh dễ dàng truy cập được trình bày ngay trên màn hình gọi là Ribbon. Có 

các nhóm Ribbon chính: Home, Insert, Page Layout, Formulas, Data, Reviews, View, Developer, 

Add-Ins. 

 

Thanh công cụ Ribbon 

Home: Là nơi chứa các nút lệnh được sử dụng thường xuyên trong quá trình làm việc như: cắt, 

dán, sao chép, định dạng tài liệu, các kiểu mẫu có sẵn, chèn hay xóa dòng hoặc cột, sắp xếp, tìm 

kiếm, lọc dữ liệu,… 

Insert: Chèn các loại đối tượng vào bảng tính như: bảng biểu, vẽ sơ đồ, đồ thị, ký hiệu, … 

Page Layout: Chứa các nút lệnh về việc hiển thị bảng tính và thiết lập in ấn. 

Formulas: Chèn công thức, đặt tên vùng (range), 

công cụ kiểm tra theo dõi công thức, điều khiển việc tính toán của Excel. 

Data: Các nút lệnh thao đối với dữ liệu trong và ngoài Excel, các danh sách, phân tích dữ liệu,… 

Review: Các nút lệnh kiễm lỗi chính tả, hỗ trợ dịch từ, thêm chú thích vào các ô, các thiết lập bảo 

vệ bảng tính. 

View: Thiết lập các chế độ hiển thị của bảng tính như: phóng to, thu nhỏ, chia màn hình, … 

Developer: Tab này mặc định được ẩn vì nó chỉ hữu dụng cho các lập trình viên, những người có 

hiểu biết về VBA. Để mở nhóm này nhấn vào nút Office / Excel Options / Popular Chọn Show 

Developer tab in the Ribbon. 

Add-Ins: Tab này chỉ xuất hiện khi Excel mở một tập tin có sử dụng các tiện ích bổ sung, các hàm 

bổ sung,… 

Sử dụng thực đơn ngữ cảnh (shortcut menu) 

Khi muốn thực hiện một thao tác nào đó trên đối tượng (ô, vùng, bảng biểu, đồ thị, hình vẽ…) 

trong bảng tính, bạn hãy nhấp phải chuột lên đối tượng đó. Lập tức một thanh thực đơn hiện ra 

chứa các lệnh thông dụng có thể hiệu chỉnh hay áp dụng cho đối tượng mà bạn chọn. 
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Thực đơn ngữ cảnh 

1.2. Mở Excel, đóng Excel, phóng to, thu nhỏ cửa sổ 

1.2.1. Mở Excel 

Thao tác: 

B1. Từ màn hình (cửa sổ) chính của Windows nhấp chuột nút Start ở góc dưới bên trái 

B2. Di chuyển chuột lên trên đến chữ All Programs, rồi di chuyển chuột sang phải chọn Microsoft 

Office, sau đó di chuyển chuột đến chữ Microsoft Office Excel 2010 thì dừng lại. 

B3. Nhấp chuột vào biểu tượng  để khởi động Excel. 

Phóng to, thu nhỏ cửa sổ Excel 

 

Các nút điều khiển cửa sổ Excel 
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Thu nhỏ cửa sổ Excel 

Thao tác này chỉ thực hiện được khi cửa sổ đang mở to Nhấp chuột chuột vào nút  ở góc trên 

cùng bên phải. Khi đó cửa sổ Excel sẽ được thu gọn lại thành một biểu tượng trên thanh Taskbar 

của Windows bên cạnh nút Start. 

Phóng to cửa sổ Excel 

Thao tác: 

Thao tác này chỉ thực hiện được khi cửa sổ đang bị thu nhỏ 

Nhấp chuột vào biểu tượng  thu gọn của Excel trên thanh Taskbar bên phía 

dưới màn hình 

Thoát khỏi Excel 

Thao tác: 

Nhấp chuột vào nút  ở góc trên cùng bên phải để thoát khỏi Excel. Hoặc cũng có thể thoát Excel 

bằng cách nhấn nút Office chọn Exit Excel. 

1.3. Thao tác với ô và vùng 

Nhận dạng ô và vùng (cells, range) 

Địa chỉ một ô trong Excel được xác định bởi tiêu đề cột và số thứ tự của dòng. Một vùng trong 

bảng tính được xác định bằng địa chỉ của ô ở góc trên bên trái của vùng và địa chỉ ô góc dưới bên 

phải của vùng (có dấu : phân cách). Đặc biệt, địa chỉ của cả một cột hoặc dòng được xác định là 

<tên cột>:<tên cột> (ví dụ cột A thì được xác định ngắn gọn là A:A) và <số dòng>:<số dòng> (ví 

dụ địa chỉ của cả một dòng 4 là 4:4).  

Ví dụ: Hình bên dưới ô hiện hành có địa chỉ là B11 vì nó có tiêu đề cột là B và số dòng là 11, vùng 

được bao bởi nét chấm đứt có địa chỉ là H2:H12 vì ô đầu tiên của vùng có địa chỉ là H2 và ô cuối 

của vùng là H12. 
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 Địa chỉ ô và vùng 

Chọn vùng 

Nếu dùng chuột, trước tiên bạn dùng chuột di chuyển ô hiện hành đến góc trên bên trái của vùng 

cần chọn, sau đó giữ trái chuột kéo xuống dưới qua phải đến vị trí ô cuối cùng của vùng và thả 

chuột. Nếu dùng phím thì sau khi chọn ô đầu tiên bạn giữ phím Shift trong khi nhấn phím → và 

 để đến ô cuối của vùng và thả các phím. (Bạn cũng có thể làm ngược lại là chọn ô cuối của 

vùng trước và kéo chọn đến ô đầu tiên). 

Khi muốn chọn cả sheet hiện hành thì nhấn <Ctrl+A>, còn muốn chọn cả workbook (nghĩa là chọn 

tất cả các sheet) thì nhấp phải chuột lên thanh sheet tab và chọn Select All Sheets. 

Sao chép và di chuyển vùng 

Sao chép (copy) giúp ta nhân bản một vùng nào đó đến một nơi nào đó trong bảng tính và dữ liệu 

gốc còn nguyên, còn di chuyển vùng thì cũng như sao chép nhưng dữ liệu gốc sẽ được di dời đến 

vị trí mới. Để sao chép hay di chuyển trước tiên bạn phải chọn vùng cần sao chép hay di chuyển, 

sau đó có thể dùng nút lệnh, phím tắt hay dùng chuột để thực hiện: 

Dùng Ribbon: Chọn vùng → Home → nhóm Clipboard → nhấn nút  hay  (Copy 

hay Cut), đến nơi đích và Home → nhóm Clipboard → nhấn nút   (Paste). Bạn có thể gọi 

các lệnh trên từ thực đơn ngữ cảnh → nhấp phải chuột. 

Chuột: Chọn vùng → giữ trái chuột và giữ thêm phím Ctrl nếu là sao chép (không giữ thêm phím 

Ctrl sẽ là lệnh di chuyển) → kéo chuột tới nơi đích cần sao chép hay di chuyển đến và thả chuột. 



17 

Trung tâm Công nghệ thông tin và Truyền thông Nghệ An 

Dán đặc biệt (Paste Special) 

Trong quá trình sao chép đôi khi chúng ta cần dán nội dung đã sao chép hay cắt từ bộ nhớ vào với 

một số chọn lọc nào đó, khi đó thay vì dùng lệnh Paste bạn hãy sử dụng Paste Special… Sau khi 

chọn vùng, ra lệnh Copy, đến đích cần sao chép đến và nhấp phải chuột, chọn lệnh Paste Special…. 

hộp thoại Paste Special có một số lựa chọn như bảng sau: 

  

Giải thích hộp thoại Paste Special 

Hạng mục Mô tả 

All Dán cả giá trị và định dạng của vùng nguồn  

Formulas Dán giá trị và công thức, không định dạng  

Values Chỉ dán giá trị và kết quả của công thức, không định dạng  

Formats Chỉ dán vào định dạng, bỏ qua tất cả giá trí và công thức  

Comments Chỉ dán vào chú thích của các ô, bỏ qua tất cả giá trí và công thức  

Validation Chỉ dán vào các qui định xác thực dữ liệu cho vùng đích  

All using source theme Dán vào mọi thứ và dùng mẫu định dạng từ vùng nguồn  

All except borders Dán vào mọi thứ và loại bỏ các khung viền  
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Column widths Chỉ dán vào thông tin qui định chiều rộng cột  

Formulas and number 

formats  

Dán vào giá trị, công thức và các định dạng gốc của các con số, các 

định dạng khác bị loại bỏ.  

Values and number 

formats  

Dán vào giá trị, kết quả của công thức và các định dạng gốc của các 

con số.  

None Không kèm theo việc tính toán nào trên dữ liệu sắp dán vào  

Add Cộng các giá trị của vùng nguồn vào các ô tương ứng ở vùng đích  

Subtract Các ô mang giá trị của vùng đích sẽ trừ đi các ô tương ứng của vùng 

nguồn.  

Multiply Các ô mang gia trị của vùng đích sẽ nhân với các ô tương ứng của 

vùng nguồn.  

Divide Các ô mang gia trị của vùng đích sẽ chia cho các ô tương ứng của 

vùng nguồn 

Skip blanks . Không dán đè các ô rỗng ở vùng nguồn vào ô có giá trị ở vùng đích  

Transpose Dán vào và đảo dòng thành cột hoặc ngược lại  

Paste Link Dán vào và tham chiếu ô đích đến ô nguồn  

 

Đặt tên vùng 

Việc đặt tên vùng có lợi rất lớn trong quá trình thao thác và xử lý tính toán như: vùng được gán 

tên sẽ giúp gợi nhớ và dễ hiểu công dụng của nó hơn là các địa chỉ đơn thuần, đặt tên giúp việc 

tham chiếu tính toán ít sai sót hơn và di chuyển hay chọn các vùng đã được đặt tên rất nhanh chóng 

từ Name box (hoặc dùng Go to – F5).… Tên dài tối đa 255 ký tự không chứa khoảng trắng và 

dấu chấm, tên phải bắt đầu là ký tự không được bắt đầu là số, tên không được đặt giống các địa 

chỉ tham chiếu. Để đặt tên trước tiên ta chọn vùng cần đặt tên → chọn nhóm Formulas 

→ Defined Names → Define Name, hộp thoại New Name hiện ra. Ở đây, bạn hãy nhập tên 

vùng vào hộp Name chọn Scope, nhập chú thích nếu cần, xong thì nhấn OK. Ngoài ra bạn còn có 
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thể đặt tên trực tiếp từ hộp Name box hoặc đặt tên cho vùng chọn từ Formulas → Defined 

Names → Create from Selection hoặc dùng thực đơn ngữ cảnh. 

 

Muốn mở hộp thoại quản lý các tên đã đặt bạn vào nhóm Formulas → Defined Names 

→ Name Manager. Từ hộp thoại bạn có thể đặt tên mới, hiệu chỉnh thông tin cho các tên hiện 

hoặc xóa tên của các vùng không dùng đến,… 

Thêm chú thích cho ô 

hêm chú thích vào các ô giúp cho việc hiệu chỉnh và hiểu thông tin mà ô đang chứa được rõ ràng 

hơn. Để thêm chú thích và ô, chọn ô → chọn nhóm Review → Comments → New Comment 

và hãy nhập chú thích vào. Ngoài ra bạn có thể nhấp phải chuột lên ô cần chú thích và chọn Insert 

Comment. 

Để đọc chú thích chỉ cần rê chuột lên ô có chú thích hoặc vào Review → Comments 

→ Next hay Previous. 

Để ẩn/ hiện chú thích vào Review → Comments → Show All Comments (ẩn/ hiện tất cả) 

hoặc Show/ Hide Comment (ẩn/ hiện chú thích ô đang chọn). 

Hiệu chỉnh chú thích vào chọn ô cần hiệu chỉnh chú thích → Review → Comments 

→ Edit Comment. Ngoài ra để nhanh bạn có thể nhấp phải chuột và chọn Edit Comment từ thực 

đơn ngữ cảnh. 

Xóa chú thích vào chọn ô cần xóa chú thích → Review → Comments → Delete. Hoặc 

nhấp phải chuột và chọn Delete Comment. 
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Minh họa cho hiện các chú thích 

Chèn, xóa ô, dòng và cột 

Chúng ta có thể chèn thêm các ô vào bên trái hoặc bên trên của ô hiện hành trong worksheet và 

dịch chuyển các ô đang chọn qua phải hoặc xuống dưới. Tương tự, ta có thể chèn thêm các dòng 

bên trên, chèn thêm các cột vào bên trái và có thể xóa đi các ô, các dòng và cột. 

Chèn ô trống 

B1. Chọn các ô mà bạn muốn chèn các ô trống vào đó (muốn chọn các ô không liên tục thì giữ 

Ctrl trong khi chọn các ô). 

B2. Chọn Home chọn nhóm Cells Insert → Insert Cells… B3. Chọn lựa chọn phù hợp trong 

hộp thoại Insert 

Chèn dòng 

B1. Chọn một hoặc nhiều dòng liên tục hoặc cách khoảng mà bạn muốn chèn số dòng tương ứng 

phía trên các dòng này. 

B2. Chọn Home → chọn nhóm Cells → Insert → Insert Sheet Rows 
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 Minh họa chèn các dòng trống lên trên các dòng đang chọn 

Chèn cột 

B1. Chọn một hoặc nhiều cột liên tục hoặc cách khoảng mà bạn muốn chèn số cột tương ứng phía 

bên trái các cột này. 

B2. Chọn Home → chọn nhóm Cells → Insert → Insert Sheet Columns  

Xóa các ô, dòng và cột 

B1. Chọn các ô, các dòng hoặc các cột cần xóa 

B2. Chọn Home → Cells → Delete → chọn kiểu xóa phù hợp (xem hình) 

 

Thay đổi độ rộng cột và chiều cao dòng 

Trong worksheet ta có thể qui định độ rộng cột từ 0 đến 255, đây chính là số ký tự có thể hiển thị 

trong một dòng. Độ rộng mặc định của cột là 8.43 ký tự, khi độ rộng là 0 thì cột được ẩn đi. Tương 

tự, chiều cao của dòng qui định từ 0 đến 409, đây là đơn vị đo lường bằng điểm (point: 1 point = 

1/72 inch). Chiều cao mặc định của dòng là 12.75 point, khi chiều cao là 0 thì dòng bị ẩn đi. Các 

bước điều chỉnh dòng cột: 
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B1. Chọn dòng hoặc cột cần điều chỉnh chiều cao hoặc độ rộng 

B2. Chọn Home → Cells → Format → Chọn lệnh phù hợp 

Row Height… chọn lệnh này để qui định chiều cao của dòng 

AutoFit Row Height chọn lệnh này Excel sẽ tự canh chỉnh chiều cao dòng cho phù hợp với 

nội dung. 

Column Width… chọn lệnh này để qui định độ rộng cột 

AutoFit Column Width chọn lệnh này Excel sẽ tự canh chỉnh độ rộng cột cho phù hợp với nội 

dung. 

Default Width… chọn lệnh này khi bạn muốn qui định lại độ rộng mặc định cho worksheet 

hay cả workbook. Ta có thể qui định chiều cao dòng và độ rộng cột cho cả worksheet hay cả 

workbook bằng cách chọn cả worksheet hay cả workbook trước khi thực hiện lệnh. Ngoài cách 

thay đổi chiều cao dòng và độ rộng cột như trên, ta còn có thể dùng chuột để thao tác nhanh hơn. 

Muốn thay đổi độ rộng cột nào hãy rê chuột đến phía bên phải tiêu đề cột đó cho xuất hiện ký hiệu 

và kéo chuột về bên phải để tăng hoặc kéo về bên trái để giảm độ rộng cột. Tương tự, muốn thay 

đổi chiều cao dòng nào hãy rê chuột đến bên dưới số thứ tự dòng cho xuất hiện ký hiệu và kéo 

chuột lên trên để giảm hoặc kéo xuống dưới để tăng chiều cao dòng. 
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Ta có thể qui định chiều cao dòng và độ rộng cột cho cả worksheet hay cả workbook bằng cách 

chọn cả worksheet hay cả workbook trước khi thực hiện lệnh. 

Ngoài cách thay đổi chiều cao dòng và độ rộng cột như trên, ta còn có thể dùng chuột để thao tác 

nhanh hơn. Muốn thay đổi độ rộng cột nào hãy rê chuột đến phía bên phải tiêu đề cột đó cho xuất 

hiện ký hiệu  và kéo chuột về bên phải để tăng hoặc kéo về bên trái để giảm độ rộng cột. Tương 

tự, muốn thay đổi chiều cao dòng nào hãy rê chuột đến bên dưới số thứ tự dòng cho xuất hiện ký 

hiệu  và kéo chuột lên trên để giảm hoặc kéo xuống dưới để tăng chiều cao dòng. 

 

Nối (Merge) và bỏ nối các ô (Split) 

Nối nhiều ô thành một ô 

Khi nối nhiều ô thành một ô, nếu tất cả các ô đều có dữ liệu thì bạn cần chuyển hết dữ liệu lên ô ở 

góc trên cùng bên trái của nhóm ô cần merge vì chỉ có dữ liệu của ô này được giữ lại, dữ liệu của 

các ô khác sẽ bị xóa. 

B1. Chọn các ô cần nối lại. 

B2. Chọn Home → Alignment → chọn Merge & Center. Để canh chỉnh dữ liệu trong ô dùng 

các nút canh chỉnh trong nhóm Algnment. 

 

Chuyển một ô đã nối về lại nhiều ô 

Sau khi chuyển ô đã nối về lại nhiều ô thì nội dung sẽ hiện tại ô ở góc trên cùng bên trái. 

B1. Chọn ô đang bị nối. 

B2. Chọn Home → Alignment → chọn lại Merge & Center hoặc Unmerge Cells đều được. 
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1.4. Di chuyển trong bảng tính và sử dụng phím tắt 

Bạn có thể dùng chuột, các phím → , thanh cuốn dọc, thanh cuốn ngang, sheet tab, các 

tổ hợp phím tắt đề di chuyển qua lại giữa các sheet hay đi đến các nơi bất kỳ trong bảng tính. 

Thanh cuốn dọc, thanh cuốn ngang 

Thanh cuốn dọc và thanh cuốn ngang được gọi chung là các thanh cuốn (scroll bars). Bởi vì màn 

hình Excel chỉ có thể hiển thị (cho xem) một phần của bảng tính đang thao tác, nên ta phải dùng 

thanh cuốn dọc để xem phần bên trên hay bên dưới bảng tính và dùng thanh cuốn ngang để xem 

phần bên trái hay bên phải của bảng tính.  

Thanh cuốn dọc là thanh dài nhất, nằm dọc ở bên lề phải; hai đầu có hai mũi tên lên và mũi 

tên xuống; ở giữa có thanh trượt để cuốn màn hình lên xuống. 

Thanh cuốn ngang là thanh nằm ngang, thứ hai từ dưới màn hình đếm lên. Có hình dạng giống 

thanh cuốn dọc, chỉ khác là nằm ngang. 

 

Thanh cuốn ngang 

Thao tác: 

Nhấp chuột vào mũi tên sang trái để cuốn màn hình đi sang trái. 

Nhấp chuột vào mũi tên sang phải để cuốn màn hình sang phải. 

Thanh Sheet tab 

Để di chuyển qua lại giữa các sheet ta nhấp chuột lên tên của sheet trên thanh sheet tab. Ngoài ra 

chúng ta có thể dùng <Ctrl + Page Up> để di chuyển đến sheet liền trước sheet hiện hành và 

<Ctrl+Page Down> để di chuyển đến sheet liền sau sheet hiện hành. Để trở về sheet đầu tiên bạn 

nhấp chuột và nút  trên thanh sheet tab và để đến sheet cuối cùng thì bạn nhấp chuột vào nút 

trên thanh  sheet tab. Nếu muốn đến một sheet nào đó trong trường hợp có quá nhiều sheet thì 

bạn hãy nhấp phải chuột vào thanh  và chọn tên sheet cần đến. 
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Sử dụng các tổ hợp phím tắt để di chuyển 

Để đến được nơi cần thiết trong bảng tính ngoài việc dùng chuột cuốn các thanh cuốn ngang và 

dọc, các phím mũi tên thì bạn nên nhớ các tổ hợp phím ở bảng bên dưới để giúp di chuyển được 

nhanh hơn. 

Nhấn phím Di chuyển 

→ hoặc Tab  Sang ô bên phải  

← hoặc Shift + Tab  Sang ô bên trái  

↑  Lên dòng  

↓  Xuống dòng  

Home  Đến ô ở cột A của dòng hiện hành  

Ctrl + Home  Đến địa chỉ ô A1 trong worksheet  

Ctrl + End  Đến địa chỉ ô có chứa dữ liệu sau cùng trong worksheet  

Alt + Page Up  Di chuyển ô hiện hành qua trái một màn hình  

Alt + Page Down  Di chuyển ô hiện hành qua phải một mành hình  

Page Up  Di chuyển ô hiện hành lên trên một màn hình  

Page Down  Di chuyển ô hiện hành xuống dưới một màn hình  

F5  Mở hộp thoại Go To  

End + → hoặc Ctrl + → Đến ô bên phải đầu tiên mà trước hoặc sau nó là ô trống  

End + ← hoặc Ctrl + ← Đến ô bên trái đầu tiên mà trước hoặc sau nó là ô trống  

End + ↑ hoặc Ctrl + ↑  Lên ô phía trên đầu tiên mà trên hoặc dưới nó là ô trống  

End + ↓ hoặc Ctrl + ↓  Xuống ô phía dưới đầu tiên mà trên hoặc dưới nó là ô trống 
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Các phím tắt di chuyển nhanh trong bảng tính 

1.5 Thao tác với workbook 

Tạo mới workbook  

Chọn nút Office → New, một hộp thoại hiện ra (xem hình bên dưới) cung cấp nhiều lựa chọn để 

tạo workbook như: workbook trống, workbook theo mẫu dựng sẵn, workbook dựa trên một 

workbook đã có. Để tạo workbook trống, bạn chọn Blank workbook và nhấp nút Create. 

 

Mở workbook có sẵn trên đĩa 

Một tập tin có sẵn có thể được mở bằng nhiều cách: 

Ctrl + Page Up  Di chuyển đến sheet phía trước sheet hiện hành  

Ctrl + Page Down  Di chuyển đến sheet phía sau sheet hiện hành  
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1. Chọn nút Office → chọn tên tập tin trong danh sách Recent Documents, có thể có tối 

đa 50 tên tập tin được sử dụng gần đây nhất trong danh sách này (để điều chỉnh thì nhấn 

vào nút Office → Excel Options → Advance → phần Display → Show this 

number of Recent Documents ). 

2. Dùng trình quản lý tập tin như Windows Explorer, tìm đến nơi lưu trữ tập tin và nhấp 

chuột hai lần lên tên tập tin. 

3. Chọn nút Office → Open, hộp thoại Open hiện ra. Trong hộp thoại Open, chúng ta 

phải tìm đến nơi lưu trữ tập tin (tại Look In) và chọn tên tập tin cần mở sau đó nhấn nút 

Open để mở tập tin. Các tùy chọn của nút Open trong hộp thoại Open: Open (mở bình 

thường), Open Read-Only (Không lưu đè được những thay đổi), Open as Copy (Tạo bản 

sao của tập tin và mở ra), Open in Browser (Mở tập tin bằng trình duyệt web mặc định), 

Open and Repair (Rất hữu dụng trong trường hợp tập tin bị lỗi). 

 

Lưu workbook 

ột điều cần lưu ý khi làm việc trên máy tính là các bạn phải nhớ thực hiện lệnh lưu lại công việc 

đã thực hiện thường xuyên. Việc ra lệnh lưu trữ không tốn nhiều thời gian nhưng nếu máy bị hỏng 

hay cúp điện đột ngột có thể mất tong cả giờ làm việc của bạn. Nhằm an toàn cho dữ liệu, bạn nên 

bật tính năng Auto Recover, Excel sẽ tự động thực hiện lệnh lưu theo thời gian qui định (mặc định 

là 10 phút lưu một lần). Để sử dụng tính năng Auto Recover bạn chọn nút Office → Excel 

Options → Save, sau đó đánh dấu chọn vào Save AutoRecover information every

 minutes. 

Một số cách lưu workbook: 



28 

Trung tâm Công nghệ thông tin và Truyền thông Nghệ An 

1. Chọn nút Office → Save 

2. Nhấp chuột lên nút  trên thanh lệnh truy cập nhanh (Quick Access Tollbar). 

3. Dùng tổ hợp phím <Ctrl+S> hoặc <Shift+F12>. 

Nếu tập tin đã được lưu trước đó rồi thì Excel sẽ lưu tiếp các phần cập nhật, còn nếu là tập tin được 

ra lệnh lưu lần đầu thì hộp thoại Save As hiện ra. Trong hộp thoại Save As, bạn hãy chọn nơi lưu 

trữ tập tin (tại Look In) và đặt tên cho tập tin tại hộp File name, chọn kiểu tập tin tại Save as type 

và sau đó nhấn nút Save để lưu trữ. 

 

Minh họa lưu tập tin 

Qui tắt đặt tên: Đặt tên tập tin Excel dùng chung qui tắt đặt tên tập tin của Windows. Tên tập 

tin có thể dài tới 255 ký tự bao gồm cả khoảng trắng. Tuy nhiên trong tên tập tin không được dùng 

các ký hiệu như: \ ? : * “ < > | 

Để bảo mật tập tin, chúng ta có thể gán mật mã bảo vệ, khi đó cần phải biết mật mã mới được 

phép mở tập tin (trừ những cách tà đạo!). 

B1. Nhấn nút Office → Save As, hộp thoại Save As hiện ra. 

B2. Nhấn nút Tools → chọn General Options…, hộp thoại General Options hiện ra 

B3. Nhập mật mã mở và hiệu chỉnh workbook (hai mật mã này nên khác nhau để tăng bảo mật). 

Sau đó nhấn nút OK 
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B4. Xác nhận lại mật mã mở workbook. Sau đó nhấn nút OK 

B5. Xác nhận lại mật mã hiệu chỉnh workbook. Sau đó nhấn nút OK 

B6. Nhấn nút Save để hoàn tất. 

  

Dùng mật mã bảo vệ workbook 

Các tùy chọn trong hộp General Options: Always create backup (tạo bản sao có đuôi *.xlk trước 

khi gán mật mã), Password to Open (mật mã để mở workbook), Password to modify (mật mã để 

cập nhật nội dung workbook), Read-only recommended (mở dưới dạng chỉ đọc). 

Đóng workbook 

Một số cách đóng workbook: 

1. Chọn nút Office → Close 

2. Dùng chuột chọn nút  ở góc trên bên phải (trên thanh tiêu đề). 

3. Dùng tổ hợp phím <Ctrl+F4> hoặc <Ctrl+W>. Nếu workbook có sự thay đổi nội dung thì Excel 

sẽ nhắc bạn lưu lại các thay đổi đó. 

Sắp xếp workbook 

Chi mở nhiều workbook cùng lúc và cần tham khảo qua lại, để thuận tiện ta nên sắp xếp lại: Rê 

chuột nhấn vào nhóm lệnh View → chọn nút Arrange All → Chọn kiểu bố trí thích hợp. 
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Sắp xếp các workbook trong cửa sổ Excel 

1.6. Thao tác với worksheet 

Chèn thêm worksheet mới vào workbook 

Có nhiều cách thực hiện: 

1. Nhấn vào nút  trên thanh sheet tab  

2. Dùng tổ hợp phím <Shift+F11> chèn sheet mới vào trước sheet hiện hành. 

3. Nhấn chọn nhóm Home → đến nhóm Cells → Insert → Insert sheet 

4. Nhấp phải chuột lên thanh sheet tab và chọn Insert…, hộp thoại Insert hiện ra, chọn Worksheet 

và nhấn nút OK. Sheet mới sẽ chèn vào trước sheet hiện hành. 
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Minh họa chèn sheet mới 

Đổi tên worksheet 

Nhấp phải chuột lên tên sheet cần đổi tên ở thanh sheet tab, chọn Rename, gõ tên mới vào, xong 

nhấn phím Enter. Tên sheet có thể dài tới 31 ký tự và có thể dùng khoảng trắng, tuy nhiên không 

được dùng các ký hiệu để đặt tên như: : / \ ? * 

Xóa worksheet 

Muốn xóa work sheet, bạn làm theo các cách sau: 

1. Chọn sheet muốn xóa → chọn nhóm Home → chọn nhóm Cells → Delete → Delete 

sheet 

2. Nhấp phải chuột lên tên sheet muốn xóa sau đó chọn Delete, xác nhận xóa OK. 

Sắp xếp thứ tự các worksheet 

Có nhiều cách thực hiện sắp xếp worksheet như: 

1. Nhấp trái chuột lên tên sheet cần sắp xếp và giữ chuột kéo đến vị trí mới và thả chuột. 

2. Khi có quá nhiều sheet thì dùng cách này, nhấp phải chuột lên tên sheet cần sắp xếp, chọn Move 

or Copy…. hộp thoại Move or Copy hiện ra. Hãy nhấp chọn lên tên sheet trong danh sách mà bạn 

muốn di chuyển sheet đến trước nó, sau đó nhấn OK. 
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Sao chép worksheet 

Nhấp phải chuột lên sheet, chọn Move or Copy…→ chọn vị trí đặt bản sao trong vùng Before 

sheet → đánh dấu chọn vào hộp Creat a copy → nhấn nút OK. Ngoài ra để sao chép nhanh 

bạn nhấn giữ phím Ctrl rồi dùng chuột chọn lên tên sheet cần sao chép → giữ trái chuột rê đến 

vị trí đặt bản sao trên thanh sheet tab → thả trái chuột. 

Để sao chép nhiều sheet cùng lúc cũng làm tương tự nhưng phải chọn nhiều sheet trước khi 

thực hiện lệnh. Để chọn được nhiều sheet bạn hãy giữ phím <Ctrl + nhấp chuột> để chọn sheet. 

Để chép một hay nhiều sheet sang một workbook khác, bạn hãy mỡ workbook đó lên sau đó 

thực hiện lệnh Move or Copy… và nhớ chọn tên workbook đích tại To book (nếu chọn workbook 

đích (new book) thì sẽ sao chép các sheet đến một workbook mới). 

Chọn màu cho sheet tab 

Việc tô màu giúp quản lý thanh sheet tab được tốt hơn. Để tô màu cho các sheet tab bạn chỉ cần 

nhấp phải chuột lên tên sheet cần tô màu, tiếp theo hãy chọn Tab Color và chọn màu thích hợp. 
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Ẩn/ Hiện worksheet 

Khi bạn không muốn ngưới khác thấy một hay nhiều sheet nào đó thì bạn có thể ẩn nó đi. Không 

thể ẩn hết các sheet trong workbook mà phải còn lại ít nhất một sheet không bị ẩn. Muốn ẩn sheet 

bạn chỉ cần nhấp phải chuột lên tên sheet muốn ần và chọn Hide thế là sheet đã được ẩn. Khi muốn 

cho hiện trở lại một sheet, bạn nhấp phải chuột lên thanh Sheet tab và chọn Unhide… sau đó chọn 

tên sheet cần cho hiện và nhấn nút OK. 

 

1.7 Sử dụng các chế độ hiển thị trong quá trình thao tác 

Trong quá trình thao tác trên bảng tính đôi khi chúng ta cần phóng to hay thu nhỏ các cửa sổ để có 

được góc nhìn tốt hơn, hoặc xem nội dung của cùng một worksheet dưới nhiều góc độ khác nhau, 

hoặc chia cửa sổ worksheet thành nhiều Tab để dễ dàng tham chiếu, hay giữ cố định tiêu đề một 

danh sách dài trong khi cuốn các thanh cuốn,… 
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Sử dụng thanh Zoom 

Excel 2010 bố trí thanh công cụ Zoom dùng để phóng to thu nhỏ khung làm việc của bảng tính. 

Thanh zoom nằm ngay ở góc dưới bên phải màn hình và có thể giúp thu nhỏ và phóng to khung 

làm việc từ 10% đến tới 400%, phóng to thì nhấn và nút dấu cộng còn thu nhỏ thì nhấn vào nút 

dấu trừ. 

 

Thanh Zoom 

Xem và so sánh worksheet trong nhiều cửa sổ 

Tính năng này đặc biệt hữu ích khi bạn muốn xem một worksheet hay các worksheet trong cùng 

một workbook dưới nhiều góc độ khác nhau, mỗi một nhân bản để xem sẽ được gắn thêm chỉ số 

phía sau tên tập tin. Chọn nhóm View → Window → New Window 

 

Để so sánh hai worksheet thì sau khi làm bước trên bạn chọn tiếp nhóm View → Window 

→ View Side by Side. Khi sử dụng chức năng này khi bạn cuốn thanh cuốn ở cửa sổ này thì cửa 

sổ kia cũng được cuốn theo. Để tắt tính năng cuốn đồng thời này bạn vào View → Window 

→ Synchronous Scrolling (nếu nó đang bật). 

Chia khung bảng tính làm nhiều phần và cố định vùng tiêu đề 

Tính năng rất hay được dùng khi thao tác trên các danh sách dài hoặc trong tính toán cần phải thực 

hiện nhiều việc tham chiếu. Để chia cửa sổ bảng tính: Đặt ô hiện hành tại vi trí cần chia trên bảng 

tính, sau đó chọn View → Window → Split. Để bỏ khung bảng tính thì nhấn nút Split lại một 

lần nữa hoặc nhấp chuột 2 lần lên đường chia dọc và ngang. Ngoài ra, ở đầu của các thanh cuốn 

dọc và ngang có một ngấn nhỏ mà khi rê chuột lên sẽ có biểu tượng   (công cụ chia nhanh 

khung bảng tính), bạn giữ trái chuột và kéo ra nơi muốn chia trên cửa sổ làm việc của bảng tính. 
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Minh họa chia 4, chia 2 dọc, chia 2 ngang 

Ngoài việc chia khung làm việc, Excel còn hỗ trợ bạn cố định một vùng nào đó trên cửa sổ làm 

việc ví dụ như dòng tiêu đề của một danh sách. Việc cố định này rất hữu ích vì nó giúp ta luôn 

thấy được dòng tiêu đề mặc dù đã cuốn màn hình xuống phía dưới để nhập liệu. Để cố định bạn 

hãy đặt ô hiện hành tại vị trí cần cố định, sau đó chọn View → Window → Freeze Panes 

→ chọn kiểu cố định phù hợp. Nếu chọn:  

Freeze Panes: Sẽ cố định dòng phía trên và cột bên trái ô hiện hành  

Freeze Top Row: Cố định dòng đầu tiên đang nhìn thấy của danh sách  

Freeze First Column: Cố định cột đầu tiên đang nhìn thấy của danh sách 

 

Minh họa cố định các tiêu đề 

Để bỏ cố định thì vào View → Window → Freeze Panes → Unfreeze Panes 

Sử dụng Watch Window 

Tính năng này giúp ta theo dõi các ô trong quá trình tính toán. Bạn muốn giám sát ô nào thì đưa 

nó vào danh sách giám sát ở cửa sổ của Watch Window. Gọi cửa sổ Watch Window bạn chọn 

nhóm Formulas → Formula Auditing → Watch Window, sau đó chọn ô cần theo dõi và nhấn 

vào nút Add Watch trên cửa sồ Watch Window. 
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Cửa sổ Watch Window 

Chương 2: Làm việc với dữ liệu trong Excel 

2.1. Nhập liệu, hiệu chỉnh 

Các ô trong bảng tính có thể chứa các con số, các chuỗi văn bản hay các biểu thức toán học. Ngoài 

ra bảng tính còn có thể chứa các biểu đồ, sơ đồ, hình ảnh, … các đối tượng này không chứa trong 

ô mà nổi trên bề mặt bảng tính. 

Nhập liệu 

Nhập số, chuỗi, thời gian, ngày tháng năm 

B1. Trên worksheet, chọn ô cần nhập liệu 

B2. Nhập vào con số, chuỗi văn bản, ngày tháng hay thời gian,… mà bạn cần 

B3. Nhập xong nhấn Enter (ô hiện hành chuyển xuống dưới) hoặc Tab (ô hiện hành chuyển qua 

phải) để kết thúc. 

Lưu ý: 

Nếu nhập các con số vào mà Excel hiển thị ##### là do chiều rộng cột không đủ bạn bản tăng 

thêm chiều rộng cột. 

Mặc định Excel sẽ dùng dấu chấm (.) để phân cách phần số nguyên và phần số thập phân. 

Khi nhập các con số mà các con số này không cần tính toán thì bạn nên định dạng ô là Text trước 

khi nhập (Home → nhóm Number → chọn Text từ danh sách). 

Ngày và thời gian nhập vào ô thì nó dùng định dạng ngày mặc định trong Control Panel 

→ Regional and Language Options. 

Khi nhập ngày dùng dấu / hoặc - để phân cách, ví dụ 10/05/2007 hoặc 10-05-2007. Khi muốn nhập 

ngày hiện tại vào ô hãy gõ <Ctrl+;>. Khi muốn dùng định dạng ngày mặc định cho ô chứa ngày 

thì chọn ô và gõ <Ctrl+Shift+#>. 
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Khi nhập thời gian và muốn định dạng theo chuẩn 12 giờ thì thêm A hoặc P vào sau thời gian nhập 

vào, ví dụ 8:30 AM hoặc 4:15 PM, nếu không Excel tự hiểu là AM. Khi muốn nhập thời gian hiện 

tại vào ô hãy gõ <Ctrl+Shift+;>. Khi muốn dùng định dạng thời gian mặc định cho ô chứa thời 

gian thì chọn ô và gõ <Ctrl+Shift+@>. Muốn nhập cùng một nội dung cho nhiều ô, bạn hãy chọn 

các ô và nhập liệu vào sau đó nhấn <Ctrl+Enter>. Ngoài ra còn có thể sử dụng chức năng AutoFill 

(phần sau). Muốn nhập cùng nội dung trên các ô ở nhiều sheet, bạn hãy chọn các sheet đó, sau đó 

chọn các ô trên sheet hiện hành, tiếp theo nhập liệu (có thể mất dữ liệu do bị nhập đè lên các ô có 

dữ liệu). Để bỏ chọn các sheet thì nhấp phải chuột lên thanh sheet tab và chọn Ungroup Sheets. 

 

Ví dụ nhập các loại dữ liệu 

Nhập các ký tự đặc biệt 

B1. Muốn nhập ký tự đặc biệt vào, trước tiên chọn ô và đến nơi cần chèn trong ô. 

B2. Chọn Insert → nhóm Text → chọn Symbol 

B3. Trong hộp thoại Symbol hãy chọn ký tự cần, có thể đổi kiểu Font tại hộp Font. 

B4. Nhấn nút Insert để chèn. 
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Ví dụ chèn vào ô 

Hủy lệnh (Undo), phục hồi lệnh (Redo), lặp lại lệnh sau cùng 

 

Để hủy một lệnh vừa thực hiện bạn nhấn chuột lên nút  hay dùng phím <Ctrl+Z> 

Đang nhập liệu vào ô muốn hủy thì nhấn phím ESC 

Để phục hồi lệnh vừa hủy thì nhấn nút  hay dùng phím <Ctrl+Y> 

Để thực hiện lại lệnh sau cùng nhấn <Ctrl+Y> 

Hiệu chỉnh nội dung 

Xóa nội dung các ô B1. Chọn một hoặc nhiều ô cần xóa 

B2. Nhấn Delete trên bàn phím (xóa cách này thì chỉ xóa nội dung các định dạng của ô vẫn còn). 

Ngoài ra để xóa bạn có thể vào Home → nhóm Editing → Clear (  ) và chọn các lệnh: 

Clear All: Xóa tất cả nội dung và định dạng 

Clear Formats: Chỉ xóa phần định dạng của ô 

Clear Contents: Chỉ xóa nội dung, còn định dạng 
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Clear Comments: Chỉ xóa các chú thích của ô nếu có 

Lưu ý các lệnh trên không xóa được định dạng của bảng (table)  

Nhập đè lên ô có sẵn nội dung 

Muốn nhập đè lên các ô có sẵn nội dung, trước tiên bạn hãy chọn ô đó và nhập vào nội dung mới. 

Khi đó, nội dung cũ của ô sẽ mất đi và thay bằng nội dung vừa nhập đè. 

Hiệu chỉnh nội dung các ô 

Muốn hiệu chỉnh nội dung sẵn có của ô bạn làm các cách sau: 

1. Nhấp chuột hai lần lên ô cần hiệu chỉnh → dùng chuột hoặc các phím mũi tên di chuyển đến 

nơi cần hiệu chỉnh dùng phím Backspace hoặc Delete để xóa một số nội dung sau đó nhập vào 

nội dung mới. 

2. Chọn ô cần hiệu chỉnh và nhấn F2 để vào chế độ hiệu chỉnh và làm tương tự như trên 

3. Chọn ô cần hiệu chỉnh, sau đó nhấp chuột vào thanh công thức (Formula) 

Sử dụng các kỹ thuật khi nhập liệu 

Sử dụng chức năng AutoFill 

Sử dụng công cụ này Excel sẽ giúp bạn điền tự động dữ liệu theo các mẫu AutoFill có sẵn. Ngoài 

ra bạn còn có thể tạo thêm các mẫu phục vụ cho công việc của mình. 

Danh saùch một số AutoFill coù saün 

Các giá trị khởi đầu Chuỗi sau khi mở rộng 

1, 2, 3 4, 5, 6 

9:00 10:00, 11:00, 12:00 

Mon Tue, Wed, Thu 

Monday Tuesday, Wednesday, Thursday 

Jan Feb, Mar, Apr 

Jan, Apr  Jul, Oct, Jan 

Jan-99, Apr-99 Jul-99, Oct-99, Jan-00 
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15-Jan, 15-Apr 15-Jul, 15-Oct 

1999, 2000 2001, 2002, 2003 

1-Jan, 1-Mar 1-May, 1-Jul, 1-Sep,... 

Qtr3 (or Q3 or Quarter3) Qtr4, Qtr1, Qtr2,... 

Product 1, On backorder Product 2, On backorder, Product 3, On backorder,... 

Text1, textA text2, textA, text3, textA,... 

1st Period 2nd Period, 3rd Period,... 

Product 1 Product 2, Product 3,... 

 

Bạn muốn điền các số lẻ trong khoảng từ 1 đến 25 vào cột A bạn làm như sau: 

B1. Chọn ô đầu tiên A1 và nhập vào số 1 

B2. Chọn ô tiếp theo A2 nhập vào số 3 (bước nhảy bằng 3-1 = 2, Excel sẽ cộng số 2 vào ô chứa số 

lẻ trước đó để có được số lẻ kế tiếp). 

B3. Chọn hai ô A1:A2, di chuyển chuột xuống dấu vuông nhỏ màu đen (Fill handle) ở góc dưới 

bên phải vùng chọn cho chuột biến thành dấu cộng màu đen. 

B4. Giữ trái chuột kéo xuống phía dưới cho đến khi hiện số 25 thì dừng lại. 
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Khi bạn muốn điền tự động (sao chép) dữ liệu hay công thức của ô hiện hành cho các ô bên 

trái, bên phải, phía trên hay bên dưới nó thì bạn làm theo các cách sau: 

1. Chọn ô hiện hành đang chứa dữ liệu hay công thức cần sao chép, sau đó giữ Fill handle và kéo 

theo hướng bạn cần (lên, xuống, trái hay phải). Khi đó dữ liệu hay biểu thức sẽ được sao chép. 

2. Chọn ô chứa dữ liệu (hay công thức) cần sao chép và tất cả các ô cần sao dữ liệu đến, sau đó 

vào Home → nhóm Editing → Fill → chọn hướng phù hợp (Down, Right, Up, Left). 

Tự tạo danh sách AutoFill bạn vào nút Office → Excel Options → Popular → trong 

phần trong phần Top options for working with Excel → chọn Edit Custom Lists → hộp thoại 

Custom Lists hiện ra. Tại đây, bạn hãy nhập vào danh sách trong khung List entries, sau khi nhập 

xong nhấn nút Add để thêm vào Custom lists và kể từ lúc này bạn có thể sử dụng chức năng 

AutoFill với danh sách tự tạo của bạn. 

Muốn xóa một danh sách thì bạn chỉ cần chọn danh sách đó và nhấn nút Delete. 

Nếu muốn hiệu chỉnh danh sách thì chọn danh sách đó và hiệu chỉnh trong ô List entries, sau 

khi hiệu chỉnh xong nhấn nút Add. 

Sử dụng chức năng Automatic Completion 

Chức năng Automatic Completion giúp bạn nhập các chuỗi văn bản giống nhau ở các ô được 

nhanh chóng hơn. Tuy nhiên, chức năng này đôi khi cũng làm bạn khó chịu, để bật tắt bạn vào nút 

Office → Excel Options → chọn Tab Advance → tại Editing options → Enable 

AutoComplete for cell values. 
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Sử dụng chức năng AutoCorrect 

AutoCorrect giúp bạn sửa các lỗi chính tả nhập liệu khi nhập bằng tiếng Anh, ngoài ra nó còn giúp 

nhập nhanh các ký hiệu hay các đoạn văn bản lặp đi lặp lại. Chúng ta có thể thêm vào các cụm từ 

mà chúng ta thường hay dùng vào danh sách của AutoCorrect. Để thêm tử vào danh sách 

AutoCorrect làm theo các bước sau: 

B1. Chọn nút Office Excel Options → Proofing → AutoCorrect Options 

B2. Tại Tab AutoCorrect chọn Replace text as you type thì chức năng này mới có tác dụng 

B3. Trong hộp Replace gõ cụm từ thường hay gõ sai (hoặc gõ vào mã tốc ký) 

B4. Trong hộp With gõ cụm từ đúng vào (hoặc gõ vào nguyên bản của mã tốc ký) 

B5. Nhấn nút Add để thêm vào danh sách 

Ðể hiệu chỉnh một mục từ trong danh sách thì chọn mục từ đó và gõ nội dung mới vào hai hộp 

Replace và With, sau đó nhấn nút Replace. Muốn xóa một mục từ trong danh sách thì chọn mục 

từ đó và nhấn nút Delete. 
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Minh họa thêm mã tốc ký vn và nguyên văn 

2.2. Định dạng 

Định dạng chung 

Các nút định dạng thông dụng của Excel được bố trí rất thuận lợi truy cập trong nhóm Home của 

thanh Ribbon. Trong quá trình soạn thảo, tính toán trên Excel, mỗi khi cần định dạng bạn chỉ việc 

nhấn chuột lên nút lệnh phù hợp dưới đây. 

 

Định dạng văn bản và số 
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Khi cần các định dạng phức tạp hơn mà trên thanh Ribbon không có nút lệnh thì bạn truy cập vào 

hộp thoại Format Cells: Chọn Home → nhóm Cells → Format → Format Cells… 

 

Giải thích hộp thoại Format Cells 

 

Định dạng Mô tả 

Tab Number 

Category Danh sách các loại định dạng số, giá trị  

Sample Hiển thị định dạng của giá trị trong ô hiện hành theo các định dạng 

bạn chọn 

Decimal places  Tối đa có thể có 30 số sau dấu thập phân, chỉ áp dụng cho dạng 

Number, Currency, Accounting, Percentage, và Scientific.  

Use 1000 Separator (,)  Chọn ô này nếu muốn có dấu phân cách giữa hàng nghìn, triệu, 

tỷ…chỉ áp dụng cho dạng Number 
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Negative numbers Chọn loại định dạng thể hiện cho số âm, chỉ áp dụng cho dạng 

Number và Currency. 

Symbol Chọn loại ký hiệu tiền tệ, chỉ áp dụng cho dạng Currency và 

Accounting 

Type Chọn kiểu hiển thị phù hợp cho giá trị , chỉ áp dụng cho các dạng 

Date, Time, Fraction, Special, và Custom.  

Locale (location)  Chọn loại ngôn ngữ khác để áp dụng định dạng giá trị, chỉ áp dụng 

cho các dạng Date, Time, và Special.  

 Tab Alignment  

Text alignment 

Horizontal 

Có các lựa chọn dùng để canh chỉnh nội dung ô theo chiều ngang. 

Mặc định Excel canh lề trái cho văn bản, lề phải cho giá trị , các 

giá trị luận lý và các lỗi được canh giữa.  

Vertical Có các lựa chọn dùng để canh chình nội dung theo chiều dọc. Mặc 

định Excel canh lề dưới cho văn bản.  

Indent Thụt đầu các dòng nội dung của ô.  

Orientation Chọn các hướng của văn bản trong các ô.  

Degrees Đặt giá trị độ để xoay văn bản. Các giá trị từ -90 đến 90 độ  

Text control Wrap text Nội dung trong ô được xuống nhiều dòng tùy thuộc vào độ rộng 

cột và độ dài nội dung. (xem chi tiết phần dưới)  

Shrink to fit Giảm kích cở chữ để tất cả nội dung trong ô vừa với độ rộng cột  

Merge cells Nối các ô chọn thành một ô (đã trình bày phần trên) 

Right-to-left Text 

direction 

Xác định trình tự đọc và canh lề  

 Tab Font  

Font Chọn kiểu Font cho các ô, font mặc định là Calibri 
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Font style  Chọn kiểu thường, in nghiên, in đậm…của Font chữ, kiểu mặc 

định là Regular.  

Size Kích thước font chữ , từ cở 1 đến 1638 và mặc định là cở chữ 11 

point.  

Underline Chọn kiểu gạch chân cho văn bản trong danh sách, mặc định là 

None.  

Color Chọn màu cho văn bản, mặc định là Automatic (do Excel tự chọn 

màu)  

Normal font Nếu chọn sẽ loại bỏ các định dạng Font khác và trở về dạng bình 

thường  

Effects Strikethrough Có thêm đường gạch ngang văn bản  

Superscript Làm cho văn bản co lại và đẩy lên trên  

Subscript Làm cho văn bản co lại và đẩy xuống dưới  

Preview Xem trước kết quả định dạng bạn vừa chọn  

 Tab Border  

Line Chọn kiểu và kích cở các đường kẻ khung, sau đó chọn các nút bên 

hộp Border để kẻ  

Presets Chọn không kẻ khung, kẽ đường bao và kẽ các đường phân cách 

giữa các ô  

Color Chọn màu cho các đường kẽ  

Border Các nút bao quanh hình minh họa dùng để kẽ các đường bao các ô 

 Tab Fill  

Background Color  Chọn màu nền cho các ô. Fill Effects cung cấp các hiệu ứng tô màu 

nền (xem chi tiết phần dưới). 
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More Colors Bổ sung thêm các màu và công cụ pha chế màu.  

Pattern Color  Các mẫu màu nền  

Pattern Style các kiểu mẫu tô nền ô. Xem trước kết quả chọn màu và kiểu mẫu 

tại Sample  

 Tab Protection  

Locked Khóa việc thay đổi, di chuyển, xóa, … các ô, chỉ có tác dụng khi 

sheet được bảo vệ  

Hidden Ẩn công thức trong ô, chỉ co tác dụng khi sheet được bảo vệ (xem 

phần sau)  

General Excel mặc định dùng kiểu này để định dạng giá trị, khi số dài hơn 

12 số thì định dạng  

General chuyển sang dạng Scientific 

Number Dùng để định dạng các con số, bạn có thể chọn dấu phân cách thập 

phân và qui định số con số sau dấu thập phân, đồng thời có thể 

chọn kiểu hiển thị số âm.  

Currency Dùng để định dạng các đơn vị tiền tệ cho các giá trị, ta có thể chọn 

dấu phân cách thập phân và định số con số sau dấu thập phân, đồng 

thời có thể chọn kiểu hiển thị số âm.  

Accounting Dùng để định dạng các đơn vị tiền tệ trong kế toán, nó đặt ký hiệu 

tiền tệ và giá trị ở hai cột khác nhau.  

Date Dùng để định dạng các giá trị ngày và thời gian tùy theo chọn lựa 

tại phần Type và Locale (location). Các Type có dấu (*) là định 

dạng lấy từ hệ thống (Control Panel).  

Time Dùng để định dạng các giá trị ngày và thời gian tùy theo chọn lựa 

tại phần Type và Locale (location). Các Type có dấu (*) là định 

dạng lấy từ hệ thống (Control Panel).  
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Percentage Định dạng này lấy giá trị trong ô nhân với 100 và thêm dấu % vào 

sau kết quả, bạn có thể chọn dấu phân cách thập phân và qui định 

số con số sau dấu thập phân.  

Fraction Định dạng này hiển thị con số dưới dạng phân số tùy theo Type bạn 

chọn.  

Scientific Hiển thị con số dưới dạng khoa học <Con số E+n>. Ví dụ, số 

12345678901 định dạng theo Scientific là 1.23E+10, nghĩa là 1.23 

x 1010. Bạn có thể chọn dấu phân cách thập phân và qui định số 

con số sau dấu thập phân.  

Text Định dạng nội dung ô giống như những gì nhập vào kể cả các con 

số.  

Special Định dạng các con số dạng mã bưu chính (ZIP Code), số điện thoại, 

số bảo hiểm …  

Custom Dùng để hiệu chỉnh các mã định dạng đang áp dụng hay tạo mới 

các định dạng do bạn áp dụng. Ta có thể thêm vào từ 200 đến 250 

định dạng tự tạo tùy theo ngôn ngữ và phiên bản Excel. (xem phần 

sau)  

Sử dụng Wrap Text 

Khi bạn muốn đoạn văn bản dài trong ô có nhiều dòng thì bạn dùng chức năng wrap text hoặc 

dùng <Alt+Enter> để xuống dòng tại vị trí mong muốn. 

B1. Chọn ô cần định dạng Wrap text, ví dụ ô A1 

B2. Chọn Home → Alignment → chọn Wrap Text ( ). Nếu dòng không tự động mở rộng 

là do ô bị thiết lập chiều cao cố định, bạn vào Home → Cells → Format → tại Cells Size 

chọn AutoFit Row Height 

Xoay chữ (Orientation) 

B1. Chọn các ô cần xoay chữ A1:D1 

B2. Chọn Home → nhóm Alignment → Orientation → Angle Counterclockwise 
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Định dạng khung (border) 

Kẽ đường bao xung quanh vùng B2:E18 đậm, có đường phân cách giữa các ô bằng nét mãnh và 

màu tất cả đường kẽ là màu đỏ. 

B1. Chọn danh sách cần kẽ khung B2:E18 

B2. Chọn Home → nhóm Cells → Format → Chọn Format Cells 

B3. Vào Tab Border, chọn màu là Red ( ) tại Color 

B4. Chọn Style là nét đậm , sau đó chọn nút Outline tại Preset 

B5. Chọn Style là nét mảnh , sau đó chọn nút Inside tại Preset 

B6. Nhấn OK hoàn tất 
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Hiệu ứng tô nền ô (Fill effect) 

B1. Chọn vùng cần tô màu nền B2:E18 

B2. Chọn Home → nhóm Cells → Format → Chọn Format Cells 

B3. Vào Tab Fill → Chọn Fill Effects… 

B4. Chọn các màu cần phối hợp: Color 1 (ví dụ là màu vàng Yellow) và Color 2 (Blue) 

B5. Chọn Shading styles là Vertical và chọn kiểu thứ 3 

B6. Nhấn OK hai lần để hoàn tất. 

 

Tự động định dạng có điều kiện. 

Với Excel 2010 định dạng có điều kiện sẽ giúp bạn chỉ ra các mẫu trong dữ liệu và sử dụng rất 

đơn giản. Chỉ cần đánh dấu một nhóm các ô và kích vào Conditional Formatting trên ribbon 

Home. Khi đưa chuột trên những lựa chọn, bạn sẽ thấy preview của nó ngay lập tức. Có thể gán 

cho mỗi ô một màu để phán ảnh thứ hạng của nó trong toàn bộ dải các giá trị, thêm một thanh dữ 
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liệu trong suốt phản ánh giá trị của ô… Cách thức tiến hành này cho phép đơn giản hơn rất nhiều 

so với sự phức tạp trong hộp thoại Conditional Formatting của Excel 2003. 

 

Bảng và định dạng bảng (table) 

Excel thiết lập sẵn rất nhiều biểu mẫu định dạng bảng và còn hỗ trợ tạo thêm các biểu mẫu mới. 

Excel chỉ cho phép xóa các biểu mẫu tự tạo thêm và cho phép xóa định dạng bảng. Ngoài ra ta có 

thể hiệu chỉnh định dạng bảng khi cần thiết. 

Áp định dạng bảng cho danh sách và chuyển danh sách thành bảng 

B1. Chọn danh B2:E18 

B2. Chọn Home → nhóm Styles → chọn Format As Table 

B3. Cửa sổ Style liệt kê rất nhiều biểu mẫu định dạng bảng, chọn một trong các biểu mẫu. Ví dụ 

chọn mẫu Light số 9 

B4. Cửa sổ Format As Table hiện lên nhấn OK để xác nhận. 

Để tạo mẫu mới thì tại bước 3 chọn New Table Style…, sau đó đặt tên cho biểu mẫu mới và 

nhấn Format để chế biến biểu mẫu. 

Muốn xóa một mẫu tự tạo thì vào Home → Style Format As Table, tại phần Custom nhấp 

phải chuột lên biểu mẫu và chọn Delete. 

Các tùy chọn hiệu chỉnh bảng có ở Table Tools → Tab Design trên thanh Ribbon 
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Xóa kiểu định dạng bảng đang áp dụng và chuyển bảng về danh sách 

Để xóa một kiểu định dạng bảng đang áp dụng, trước tiên hãy chọn bảng, tại Tab Design vào 

nhóm Table Styles chọn More ( ) → chọn Clear. Đến lúc này vùng chọn vẫn còn là 

bảng do vậy nó có các tính năng của bảng. 

Để chuyển một bảng về thành danh sách thì chọn bảng, sau đó vào Tab Design, tại nhóm Tools 

chọn Convert to Range. 

Sử dụng mẫu định dạng tài liệu (Document Themes) 

Các mẫu tài liệu dựng sẵn giúp người sử dụng tạo nên các tài liệu có dáng vẽ chuyên nghiệp và rất 

dễ sử dụng. Các biểu mẫu tài liệu được thiết kế sẵn với nhiều màu, font chữ, hình ảnh, đồ thị,… 

với nhiều hiệu ứng đẹp mắt. Ngoài ra chúng ta còn có thể hiệu chỉnh và chế biến các mẫu này. 
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Để áp dụng biểu mẫu tài liệu bạn vào chọn nhóm Page Layout → Themes → Chọn một 

biểu mẫu từ danh sách. 

Có thể hiệu chỉnh biễu mẫu: vào Colors để chọn lại màu, vào Fonts để chọn lại kiểu Font và 

vào Effects để chọn lại hiệu ứng. 

Lưu ý bảng phải áp dụng Style thì mới có tác dụng. 

Tạo biểu mẫu mới Colors và Font bạn vào Page Layout → Themes → chọn Colors 

→ chọn Create New Themes Colors hay Page Layout → Themes → chọn Fonts → chọn 

Create New Themes Fonts. Nhớ lưu lại (Save) sau khi tạo. 

Khi đổi kiểu mẫu khác đồng loạt các đối tượng được áp dụng biểu mẫu thay đổi định dạng và 

không bị thay đổi nội dung. 

 

2.3 Tìm và thay thế dữ liệu  

Để tìm dữ liệu hoặc tìm và thay thế dữ liệu: 

• Kích nút Find & Select trên nhóm Editing của tab Home 
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• Chọn Find hoặc Replace 

 

• Hộp thoại Find and Replace xuất hiện, nhập từ muốn tìm trong mục Find What (nếu bạn chọn 

Find ở bước trên) hoặc nhập từ muốn tìm trong mục Find What và từ thay thế trong mục Replace 

with (nếu bạn chọn Replace ở bước trên).  

• Kích nút Options để tìm thêm các tùy chọn 

 

 

2.4 Sắp xếp và lọc dữ liệu 

Sort (sắp xếp) và Filter (lọc) là những tính năng cho phép bạn thao tác dữ liệu trong một bảng 

tính được thiết lập dựa trên các tiêu chuẩn. 

Sắp xếp 

Để thực hiện một sắp xếp theo chiều tăng dần hay giảm dần trên một cột: 
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• Đánh dấu các ô muốn được sắp xếp 

• Kích nút Sort & Filter trên tab Home 

• Kích nút Sort Ascending (A-Z) hay Sort Descending (Z-A) 

 

Tùy chỉnh sắp xếp  

Để sắp xếp nhiều hơn một cột: 

• Kích nút Sort & Filter trên tab Home 

• Chọn cột mà bạn muốn sắp xếp đầu tiên 

• Kích Add Level 

• Chọn cột tiếp theo bạn muốn sắp xếp 

• Kích OK 

 

Lọc dữ liệu  
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Bộ lọc cho phép bạn chỉ hiển thị dữ liệu mà đáp ứng các tiêu chuẩn nhất định. Để sử dụng bộ lọc: 

• Kích vào cột hoặc chọn các cột chứa dữ liệu mà bạn muốn lọc 

• Trên tab Home, kích Sort & Filter 

• Kích nút Filter 

• Kích vào mũi tên phía dưới ô đầu tiên 

• Kích Text Filter 

• Kích Words bạn muốn lọc 

 
Nhấn chuột vào đây để xem 

ảnh gốc 

 

• Để không áp dụng bộ lọc, kích nút Sort & Filter  

• Kích Clear 
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Chương 3: Giới Thiệu Và Sử Dụng Các Hàm 

3.1 Giới thiệu công thức và hàm: 

Giới thiệu công thức (Formula) 

Công thức giúp bảng tính hữu ích hơn rất nhiều, nếu không có các công thức thì bảng tính cũng 

giống như trình soạn thảo văn bản. Chúng ta dùng công thức để tính toán từ các dữ liệu lưu trữ 

trên bảng tính, khi dữ liệu thay đổi các công thức này sẽ tự động cập nhật các thay đổi và tính ra 

kết quả mới giúp chúng ta đỡ tốn công sức tính lại nhiều lần. Vậy công thức có các thành phần gì? 

Công thức trong Excel được nhận dạng là do nó bắt đầu là dấu = và sau đó là sự kết hợp của các 

toán tử, các trị số, các địa chỉ tham chiếu và các hàm. 

Ví dụ: 

 

Ví dụ về công thức 

Các toán tử trong công thức 

Toán tử  Chức năng  Ví dụ  Kết quả  

+  Cộng  =3+3  3 cộng 3 là 6  



58 

Trung tâm Công nghệ thông tin và Truyền thông Nghệ An 

-  Trừ  =45-4  45 trừ 4 còn 41  

*  Nhân  =150*.05  150 nhân 0.50 thành 7.5  

/  Chia  =3/3  3 chia 3 là 1  

^  Lũy thừa  =2^4 =16^(1/4)  2 lũy thừa 4 thành 16 Lấy căn 

bậc 4 của 16 thành 2  

&  Nối chuỗi  =”Lê” & “Thanh”  Nối chuỗi “Lê” và “Thanh” lại 

thành “Lê Thanh”  

=  Bằng  =A1=B1  Ví dụ ô A1=3, ô B1=6 Kết quả: 

FALSE  

>  Lớn hơn  =A1>B1  Ví dụ ô A1=3, ô B1=6 Kết quả: 

FALSE  

<  Nhỏ hơn  =A1<B1  Ví dụ ô A1=3, ô B1=6 Kết quả: 

TRUE  

>=  Lớn hơn hoặc bằng  =A1>=B1  Ví dụ ô A1=3, ô B1=6 Kết quả: 

FALSE  

<=  Nhỏ hơn hoặc bằng  =A1<=B1  Ví dụ ô A1=3, ô B1=6 Kết quả: 

TRUE  

<>  Khác  =A1<>B1  Ví dụ ô A1=3, ô B1=6 Kết quả: 

TRUE  

,  Dấu cách các tham 

chiếu  

=Sum(A1,B1)  Ví dụ ô A1=3, ô B1=6 Kết quả: 

9  

:  Tham chiếu mãng  =Sum(A1:B1)  Ví dụ ô A1=3, ô B1=6 Kết quả: 

9  

khoảng 

trắng  

Trả về các ô giao 

giữa 2 vùng  

=B1:B6 A3:D3  Trả về giá trị của ô  
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Thứ tự ưu tiên của các toán tử  

Toán tử  Mô tả  Ưu tiên  

: (hai chấm) (1 khoảng trắng) , (dấu phẩy)  Toán tử tham chiếu  1  

–  Số âm (ví dụ –1)  2  

%  Phần trăm  3  

^  Lũy thừa  4  

* và /  Nhân và chia  5  

+ và –  Cộng và trừ  6  

&  Nối chuỗi  7  

= < > <= >= <>  So sánh  8  

 

Giới thiệu hàm (Function)  

Hàm trong Excel được lập trình sẵn dùng tính toán hoặc thực hiện một chức năng nào đó. Việc sử 

dụng thành thạo các hàm sẽ giúp chúng ta tiết kiệm được rất nhiều thời gian so với tính toán thủ 

công không dùng hàm. Các hàm trong Excel rất đa dạng bao trùm nhiều lĩnh vực, có những hàm 

không yêu cầu đối số, có những hàm yêu cầu một hoặc nhiều đối số, và các đối số có thể là bắt 

buộc hoặc tự chọn. 

Ví dụ: 

=Rand(): hàm không có đối số 

=If(A1>=5,”Đạt”,”Rớt”): hàm 3 đối số 

=PMT(10%,4,1000,,1): hàm nhiều đối số và đối số tùy chọn 

Trong Excel 2010 có các hàm chính như sau: 

• Hàm ngoại: Call, Registed.ID,…  

• Hàm lấy dữ liệu từ SSAS: Cubeset, Cubevalue,…  

• Hàm dữ liệu: Dmin, Dmax, Dcount,…  

• Hàm ngày và thời gian: Time, Now, Date,….  
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• Hàm kỹ thuật: Dec2Bin, Dec2Hex, Dec2Oct,…  

• Hàm tài chính: Npv, Pv, Fv, Rate,…  

• Hàm thông tin: Cell, Thông tin, IsNa,…  

• Hàm luận lý: If, And, Or,…  

• Hàm tham chiếu và tìm kiếm: Choose, Vlookup, OffSet,…  

• Hàm toán và lượng giác: Log, Mmult, Round,…  

• Hàm thống kê: Stdev, Var, CountIf,…  

• Hàm văn bản: Asc, Find, Text,…  

Chúng ta sẽ cùng nghiên cứu cách sử dụng từng hàm trong các nhóm hàm trên ở các phần sau. 

Nhập công thức và hàm   

Nhập công thức trong Excel rất đơn giản, muốn nhập công thức vào ô nào bạn chỉ việc nhập dấu 

= và sau đó là sự kết hợp của các toán tử, các trị số, các địa chỉ tham chiếu và các hàm. Bạn có thể 

nhìn vào thanh Formula để thấy được trọn công thức. Một điều hết sức lưu ý khi làm việc trên 

bảng tính là tránh nhập trực tiếp các con số, giá trị vào công thức mà bạn nên dùng đến tham chiếu. 

Ví dụ: 

 

Minh họa dùng tham chiếu trong hàm 

Trong ví dụ trên, ở đối số thứ nhất của hàm NPV chúng ta không nhập trực suất chiết tính 10% 

vào hàm mà nên tham chiếu đến địa chỉ ô chứa nó là I2, vì nếu lãi suất có thay đổi thì ta chỉ cần 

nhập giá trị mới vào ô I2 thì chúng ta sẽ thu được kết quả NPV mới ngay không cần phải chỉnh 

sửa lại công thức. 

Giả sử các ô C2:G2 được đặt tên là DongTien, và ô I2 đặt tên là LaiSuat (Xem lại cách đặt tên 

vùng ở bài số 1) thì trong quá trình nhập công thức bạn có thể làm như sau: 

B1. Tại ô B4 nhập vào =NPV( 

B2. Nhấn F3, cửa sổ Paste Name hiện ra 

B3. Chọn LaiSuat và nhấn OK 

B4. Nhập dấu phẩy (,) và gõ F3 
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B5. Chọn DongTien và nhấn OK 

B6. Nhập dấu đóng ngoặc rồi nhập dấu + 

B7. Nhấp chuột vào ô B2 

B8. Nhấn phím Enter 

 

Chèn tên vùng vào công thức 

Một trong những cách dễ dàng nhất để sử dụng hàm trong Excel là sử dụng thư viện hàm. Khi bạn 

muốn sử dụng hàm nào chỉ việc vào thanh Ribbon  chọn nhóm Formulas  Function Library 

-> chọn nhóm hàm -> chọn hàm cần sử dụng. Ngoài ra bạn có thể nhấn vào nút  để gọi hộp 

thoại Insert Function một cách nhanh chóng và khi cần tìm hiểu về hàm này bạn chỉ cần nhấn vào 

Help on this function. 
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Hộp thoại Insert Function 

Tham chiếu trong công thức   

Các tham chiếu sử dụng trong công thức giúp cho chúng ta khỏi tốn công sửa chữa các công thức 

khi các giá trị tính toán có sự thay đổi. Có 3 loại tham chiếu sau: 

• Tham chiếu địa chỉ tương đối: Các dòng và cột tham chiếu sẽ thay đổi khi chúng ta sao 

chép hoặc di dời công thức đến vị trí khác một lượng tương ứng với số dòng và số cột mà 

ta di dời. Ví dụ A5:B7, C4  

• Tham chiếu địa chỉ tuyệt đối: Các dòng và cột tham chiếu không thay đổi khi ta di dời hay 

sao chép công thức. Ví dụ $A$5:$B$7, $C$4  

• Tham chiếu hỗn hợp: Phối hợp tham chiếu địa chỉ tương đối và tuyệt đối. Ví dụ A$5 nghĩa 

là cột A tương đối và dòng 5 tuyệt đối.  

Lưu ý: Dấu $ trước thứ tự cột là cố định cột và trước thứ tự dòng là cố định dòng. Nhấn phím F4 

nhiều lần để (tuyệt đối) cố định/ bỏ cố định  dòng hoặc cột. 

Nhấn phím F4 nhiều lần để (tuyệt đối) cố định/ bỏ cố định dòng hoặc cột. 

Ví dụ: Tính thành tiền bằng Số lượng nhân Giá. Đổi sang giá trị Thành tiền sang VND. Tính tổng 

các cột Thành tiền và cột VND. 
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Minh họa địa chỉ tương đối và tuyệt đối 

B1. Tại ô D2 nhập vào =B2*C2 và Enter. Sau đó quét chọn cả vùng D2:D14 và gõ <Ctrl+D>. 

Vào các ô D3, D4... D14 ta thấy công thức các dòng tự động được thay đổi tương ứng với khoảng 

cách so với ô D2. Trường hợp này chúng ta dùng địa chỉ tương đối của B2*C2 là vì chúng ta muốn 

khi sao chép công thức xuống phía dưới thì địa chỉ các ô tính toán sẽ tự động thay đổi theo. 

B2. Tại ô E2 nhập vào =D2*B$17 và Enter, sau đó chép công thức xuống các ô E3:E14. Chúng 

ta cần cố định dòng 17 trong địa chỉ tỷ giá B17 vì ta muốn khi sao công thức xuống thì các công 

thức sao chép vẫn tham chiếu đến ô B17 để tính toán. 

B3. Tại ô D15 nhập vào =Sum(D2:D14) và chép sang ô E15. 

Lưu ý: 

• Tham chiếu đến địa chỉ ở worksheet khác nhưng cùng workbook thì có dạng  

• Tên_sheet!Địa_chỉ_ô. Ví dụ:  

=A2*Sheet2!A2 

=A2*’Thong so’!B4 

Khi tên sheet có chứa khoảng trắng thì để trong cặp nháy đơn ‘ ’ 

• Tham chiếu đến địa chỉ trong workbook khác thì có dạng  

[Tên_Workbook]Tên_sheet!Địa_chỉ_ô.  

Ví dụ: 

=A2*[Bai2.xlsx]Sheet3!A4 
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=A2*’[Bai tap 2.xlsx]Sheet3’!A4               

Khi tên Sheet hay Workbook có chứa khoản trắng để trong cặp nháy đơn ‘ ’ 

=A2*’C:\Tai lieu\[Bai tap 2.xlsx]Sheet3’!A4 

Khi tham chiếu đến workbook khác mà workbook này không mở  

=A2*’\\DataServer\Excel\[Bai tap 2.xlsx]Sheet3’!A4 

Khi tham chiếu đến tài nguyên chia sẽ trên máy chủ trong mạng 

Các lỗi thông dụng (Formulas errors)   

Các lỗi thông dụng 

Lỗi Giải thích 

#DIV/0! Trong công thức có chứa phép chia cho 0 (zero) hoặc chia ô rỗng 

#NAME? Do dánh sai tên hàm hay tham chiếu hoặc đánh thiếu dấu nháy 

#N/A Công thức tham chiếu đến ô mà có dùng hàm NA để kiểm tra sự tồn tại của dữ 

liệu hoặc hàm không có kết quả 

#NULL! Hàm sử dụng dữ liệu giao nhau của 2 vùng mà 2 vùng này không có phần 

chung nên phần giao rỗng 

#NUM! Vấn đề đối với giá trị, ví dụ như dùng nhầm số âm trong khi đúng phải là số 

dương 

#REF! Tham chiếu bị lỗi, thường là do ô tham chiếu trong hàm bị xóa 

#VALUE! Công thức tính toán có chứa kiểu dữ liệu không đúng. 

   

3.2 Các hàm trong excel 

a. Nhóm hàm về thống kê 

AVEDEV (number1, number2, ...) : Tính trung bình độ lệch tuyệt đối các điểm dữ liệu theo trung 

bình của chúng. Thường dùng làm thước đo về sự biến đổi của tập số liệu 

AVERAGE (number1, number2, ...) : Tính trung bình cộng 
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AVERAGEA (number1, number2, ...) : Tính trung bình cộng của các giá trị, bao gồm cả những 

giá trị logic 

AVERAGEIF (range, criteria1) : Tính trung bình cộng của các giá trị trong một mảng theo một 

điều kiện 

AVERAGEIFS (range, criteria1, criteria2, ...) : Tính trung bình cộng của các giá trị trong một 

mảng theo nhiều điều kiện 

COUNT (value1, value2, ...) : Đếm số ô trong danh sách 

COUNTA (value1, value2, ...) : Đếm số ô có chứa giá trị (không rỗng) trong danh sách 

COUNTBLANK (range) : Đếm các ô rỗng trong một vùng 

COUNTIF (range, criteria) : Đếm số ô thỏa một điều kiện cho trước bên trong một dãy 

COUNTIFS (range1, criteria1, range2, criteria2, ...) : Đếm số ô thỏa nhiều điều kiện cho trước 

DEVSQ (number1, number2, ...) : Tính bình phương độ lệch các điểm dữ liệu từ trung bình mẫu 

của chúng, rồi cộng các bình phương đó lại. 

FREQUENCY (data_array, bins_array) : Tính xem có bao nhiêu giá trị thường xuyên xuất hiện 

bên trong một dãy giá trị, rồi trả về một mảng đứng các số. Luôn sử dụng hàm này ở dạng công 

thức mảng 

GEOMEAN (number1, number2, ...) : Trả về trung bình nhân của một dãy các số dương. Thường 

dùng để tính mức tăng trưởng trung bình, trong đó lãi kép có các lãi biến đổi được cho trước... 

HARMEAN (number1, number2, ...) : Trả về trung bình điều hòa (nghịch đảo của trung bình cộng) 

của các số 

KURT (number1, number2, ...) : Tính độ nhọn của tập số liệu, biểu thị mức nhọn hay mức phẳng 

tương đối của một phân bố so với phân bố chuẩn 

LARGE (array, k) : Trả về giá trị lớn nhất thứ k trong một tập số liệu 

MAX (number1, number2, ...) : Trả về giá trị lớn nhất của một tập giá trị 

MAXA (number1, number2, ...) : Trả về giá trị lớn nhất của một tập giá trị, bao gồm cả các giá trị 

logic và text 

MEDIAN (number1, number2, ...) : Tính trung bình vị của các số. 

MIN (number1, number2, ...) : Trả về giá trị nhỏ nhất của một tập giá trị 

MINA (number1, number2, ...) : Trả về giá trị nhỏ nhất của một tập giá trị, bao gồm cả các giá trị 

logic và text 
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MODE (number1, number2, ...) : Trả về giá trị xuất hiện nhiều nhất trong một mảng giá trị 

PERCENTILE (array, k) : Tìm phân vị thứ k của các giá trị trong một mảng dữ liệu 

PERCENTRANK (array, x, significance) : Trả về thứ hạng (vị trí tương đối) của một trị trong một 

mảng dữ liệu, là số phần trăm của mảng dữ liệu đó 

PERMUT (number, number_chosen) : Trả về hoán vị của các đối tượng. 

QUARTILE (array, quart) : Tính điểm tứ phân vị của tập dữ liệu. Thường được dùng trong khảo 

sát dữ liệu để chia các tập hợp thành nhiều nhóm... 

RANK (number, ref, order) : Tính thứ hạng của một số trong danh sách các số 

SKEW (number1, number2, ...) : Trả về độ lệch của phân phối, mô tả độ không đối xứng của phân 

phối quanh trị trung bình của nó 

SMALL (array, k) : Trả về giá trị nhỏ nhất thứ k trong một tập số 

STDEV (number1, number2, ...) : Ước lượng độ lệch chuẩn trên cơ sở mẫu 

STDEVA (value1, value2, ...) : Ước lượng độ lệch chuẩn trên cơ sở mẫu, bao gồm cả những giá 

trị logic 

STDEVP (number1, number2, ...) : Tính độ lệch chuẩn theo toàn thể tập hợp 

STDEVPA (value1, value2, ...) : Tính độ lệch chuẩn theo toàn thể tập hợp, kể cả chữ và các giá trị 

logic 

VAR (number1, number2, ...) : Trả về phương sai dựa trên mẫu 

VARA (value1, value2, ...) : Trả về phương sai dựa trên mẫu, bao gồm cả các trị logic và text 

VARP (number1, number2, ...) : Trả về phương sai dựa trên toàn thể tập hợp 

VARPA (value1, value2, ...) : Trả về phương sai dựa trên toàn thể tập hợp, bao gồm cả các trị logic 

và text. 

TRIMMEAN (array, percent) : Tính trung bình phần trong của một tập dữ liệu, bằng cách loại tỷ 

lệ phần trăm của các điểm dữ liệu ở đầu và ở cuối tập dữ liệu. 

b. Nhóm hàm về phân phối xác suất 

BETADIST (x, alpha, beta, A, B) : Trả về giá trị của hàm tính mật độ phân phối xác suất tích lũy 

beta. 

BETAINV (probability, alpha, beta, A, B) : Trả về nghịch đảo của hàm tính mật độ phân phối xác 

suất tích lũy beta. 
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BINOMDIST (number_s, trials, probability_s, cumulative) : Trả về xác suất của những lần thử 

thành công của phân phối nhị phân. 

CHIDIST (x, degrees_freedom) : Trả về xác xuất một phía của phân phối chi-squared. 

CHIINV (probability, degrees_freedom) : Trả về nghịch đảo của xác xuất một phía của phân phối 

chi-squared. 

CHITEST (actual_range, expected_range) : Trả về giá trị của xác xuất từ phân phối chi-squared 

và số bậc tự do tương ứng. 

CONFIDENCE (alpha, standard_dev, size) : Tính khoảng tin cậy cho một kỳ vọng lý thuyết 

CRITBINOM (trials, probability_s, alpha) : Trả về giá trị nhỏ nhất sao cho phân phối nhị thức tích 

lũy lớn hơn hay bằng giá trị tiêu chuẩn. Thường dùng để bảo đảm các ứng dụng đạt chất lượng... 

EXPONDIST (x, lambda, cumulative) : Tính phân phối mũ. Thường dùng để mô phỏng thời gian 

giữa các biến cố... 

FDIST (x, degrees_freedom1, degrees_freedom2) : Tính phân phối xác suất F. Thường dùng để 

tìm xem hai tập số liệu có nhiều mức độ khác nhau hay không... 

FINV (probability, degrees_freedom1, degrees_freedom2) : Tính nghịch đảo của phân phối xác 

suất F. Thường dùng để so sánh độ biến thiên trong hai tập số liệu 

FTEST (array1, array2) : Trả về kết quả của một phép thử F. Thường dùng để xác định xem hai 

mẫu có các phương sai khác nhau hay không... 

FISHER (x) : Trả về phép biến đổi Fisher tại x. Thường dùng để kiểm tra giả thuyết dựa trên hệ 

số tương quan... 

FISHERINV (y) : Tính nghịch đảo phép biến đổi Fisher. Thường dùng để phân tích mối tương 

quan giữa các mảng số liệu... 

GAMMADIST (x, alpha, beta, cumulative) : Trả về phân phối tích lũy gamma. Có thể dùng để 

nghiên cứu có phân bố lệch 

GAMMAINV (probability, alpha, beta) : Trả về nghịch đảo của phân phối tích lũy gamma. 

GAMMLN (x) : Tính logarit tự nhiên của hàm gamma 

HYPGEOMDIST (number1, number2, ...) : Trả về phân phối siêu bội (xác suất của một số lần 

thành công nào đó...) 

LOGINV (probability, mean, standard_dev) : Tính nghịch đảo của hàm phân phối tích lũy 

lognormal của x (LOGNORMDIST) 
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LOGNORMDIST (x, mean, standard_dev) : Trả về phân phối tích lũy lognormal của x, trong đó 

logarit tự nhiên của x thường được phân phối với các tham số mean và standard_dev. 

NEGBINOMDIST (number_f, number_s, probability_s) : Trả về phân phối nhị thức âm (trả về 

xác suất mà sẽ có number_f lần thất bại trước khi có number_s lần thành công, khi xác suất không 

đổi của một lần thành công là probability_s) 

NORMDIST (x, mean, standard_dev, cumulative) : Trả về phân phối chuẩn (normal distribution). 

Thường được sử dụng trong việc thống kê, gồm cả việc kiểm tra giả thuyết 

NORMINV (probability, mean, standard_dev) : Tính nghịch đảo phân phối tích lũy chuẩn 

NORMSDIST (z) : Trả về hàm phân phối tích lũy chuẩn tắc (standard normal cumulative 

distribution function), là phân phối có trị trung bình cộng là zero (0) và độ lệch chuẩn là 1 

NORMSINV (probability) : Tính nghịch đảo của hàm phân phối tích lũy chuẩn tắc 

POISSON (x, mean, cumulative) : Trả về phân phối poisson. Thường dùng để ước tính số lượng 

biến cố sẽ xảy ra trong một khoảng thời gian nhất định 

PROB (x_range, prob_range, lower_limit, upper_limit) : Tính xác suất của các trị trong dãy nằm 

giữa hai giới hạn 

STANDARDIZE (x, mean, standard_dev) : Trả về trị chuẩn hóa từ phân phối biểu thị bởi mean 

và standard_dev 

TDIST (x, degrees_freedom, tails) : Trả về xác suất của phân phối Student (phân phối t), trong đó 

x là giá trị tính từ t và được dùng để tính xác suất. 

TINV (probability, degrees_freedom) : Trả về giá trị t của phân phối Student. 

TTEST (array1, array2, tails, type) : Tính xác xuất kết hợp với phép thử Student. 

WEIBULL (x, alpha, beta, cumulative) : Trả về phân phối Weibull. Thường sử dụng trong phân 

tích độ tin cậy, như tính tuổi thọ trung bình của một thiết bị. 

ZTEST (array, x, sigma) : Trả về xác suất một phía của phép thử z.  

c. Nhóm hàm về tương quan và hồi quy tuyến tính 

CORREL (array1, array2) : Tính hệ số tương quan giữa hai mảng để xác định mối quan hệ của hai 

đặc tính 

COVAR (array1, array2) : Tính tích số các độ lệch của mỗi cặp điểm dữ liệu, rồi tính trung bình 

các tích số đó 
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FORECAST (x, known_y's, known_x's) : Tính toán hay dự đoán một giá trị tương lai bằng cách 

sử dụng các giá trị hiện có, bằng phương pháp hồi quy tuyến tính 

GROWTH (known_y's, known_x's, new_x's, const) : Tính toán sự tăng trưởng dự kiến theo hàm 

mũ, bằng cách sử dụng các dữ kiện hiện có. 

INTERCEPT (known_y's, known_x's) : Tìm điểm giao nhau của một đường thẳng với trục y bằng 

cách sử dụng các trị x và y cho trước 

LINEST (known_y's, known_x's, const, stats) : Tính thống kê cho một đường bằng cách dùng 

phương pháp bình phương tối thiểu (least squares) để tính đường thẳng thích hợp nhất với dữ liệu, 

rồi trả về mảng mô tả đường thẳng đó. Luôn dùng hàm này ở dạng công thức mảng. 

LOGEST (known_y's, known_x's, const, stats) : Dùng trong phân tích hồi quy. Hàm sẽ tính đường 

cong hàm mũ phù hợp với dữ liệu được cung cấp, rồi trả về mảng gía trị mô tả đường cong đó. 

Luôn dùng hàm này ở dạng công thức mảng 

PEARSON (array1, array2) : Tính hệ số tương quan momen tích pearson (r), một chỉ mục không 

thứ nguyên, trong khoảng từ -1 đến 1, phản ánh sự mở rộng quan hệ tuyến tính giữa hai tập số liệu 

RSQ (known_y's, known_x's) : Tính bình phương hệ số tương quan momen tích Pearson (r), thông 

qua các điểm dữ liệu trong known_y's và known_x's 

SLOPE (known_y's, known_x's) : Tính hệ số góc của đường hồi quy tuyến tính thông qua các 

điềm dữ liệu 

STEYX (known_y's, known_x's) : Trả về sai số chuẩn của trị dự đoán y đối với mỗi trị x trong hồi 

quy. 

TREND (known_y's, known_x's, new_x's, const) : Trả về các trị theo xu thế tuyến tính 

d. Các hàm tài chính - financian functions  

ACCRINT (issue, first_interest, settlement, rate, par, frequency, basis, calc_method) : Tính lãi tích 

lũy cho một chứng khoán trả lãi theo định kỳ 

ACCRINTM (issue, settlement, rate, par, basis) : Tính lãi tích lũy đối với chứng khoán trả lãi theo 

kỳ hạn 

AMORDEGRC (cost, date_purchased, first_period, salvage, period, rate, basis) : Tính khấu hao 

trong mỗi tài khóa kế toán tùy theo thời hạn sử dụng của tài sản (sử dụng trong các hệ thống kế 

toán theo kiểu Pháp) 

AMORLINC (cost, date_purchased, first_period, salvage, period, rate, basis) : Tính khấu hao trong 

mỗi tài khóa kế toán (sử dụng trong các hệ thống kế toán theo kiểu Pháp) 
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COUPDAYBS (settlement, maturity, frequency, basis) : Tính số ngày kể từ đầu kỳ lãi tới ngày kết 

toán 

COUPDAYS (settlement, maturity, frequency, basis) : Tính số ngày trong kỳ lãi bao gồm cả ngày 

kết toán 

COUPDAYSCN (settlement, maturity, frequency, basis) : Tính số ngày từ ngày kết toán tới ngày 

tính lãi kế tiếp 

COUPNCD (settlement, maturity, frequency, basis) : Trả về một con số thể hiện ngày tính lãi kế 

tiếp kể từ sau ngày kết toán 

COUPNUM (settlement, maturity, frequency, basis) : Tính số lần lãi suất phải trả trong khoảng từ 

ngày kết toán đến ngày đáo hạn 

COUPPCD (settlement, maturity, frequency, basis) : Trả về một con số thể hiện ngày thanh toán 

lãi lần trước, trước ngày kết toán 

CUMIPMT (rate, nper, pv, start_period, end_period, type) : Tính lợi tức tích lũy phải trả đối với 

khoản vay trong khoảng thời gian giữa start_period và end_period 

CUMPRINC (rate, nper, pv, start_period, end_period, type) : Trả về tiền vốn tích lũy phải trả đối 

với khoản vay trong khoảng thời gian giữa start_period và end_period 

DB (cost, salvage, life, period, month) : Tính khấu hao cho một tài sản sử dụng phương pháp số 

dư giảm dần theo một mức cố định (fixed-declining balance method) trong một khoảng thời gian 

xác định. 

DDB (cost, salvage, life, period, factor) : Tính khấu hao cho một tài sản sử dụng phương pháp số 

dư giảm dần kép (double-declining balance method), hay giảm dần theo một tỷ lệ nào đó, trong 

một khoảng thời gian xác định. 

DISC (settlement, maturity, pr, redemption, basis) : Tính tỷ lệ chiết khấu của một chứng khoán 

DOLLARDE (fractional_dollar, fraction) : Chuyển đổi giá dollar ở dạng phân số sang giá dollar 

ở dạng thập phân 

DOLLARFR (decimal_dollar, fraction) : Chuyển đổi giá dollar ở dạng thập phân số sang giá dollar 

ở dạng phân số 

DURATION (settlement, maturity, coupon, yld, frequency, basis) : Tính thời hạn hiệu lực 

Macauley dựa trên đồng mệnh giá $100 (thời hạn hiệu lực là trung bình trọng giá trị hiện tại của 

dòng luân chuyển tiền mặt và được dùng làm thước đo về sự phản hồi làm thay đổi lợi nhuận của 

giá trị trái phiếu) 
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EFFECT (nominal_rate, npery) : Tính lãi suất thực tế hằng năm, biết trước lãi suất danh nghĩa 

hằng năm và tổng số kỳ thanh toán lãi kép mỗi năm 

FV (rate, nper, pmt, pv, type) : Tính giá trị kỳ hạn của sự đầu tư dựa trên việc chi trả cố định theo 

kỳ và lãi suất cố định 

FVSCHEDULE (principal, schedule) : Tính giá trị kỳ hạn của một vốn ban đầu sau khi áp dụng 

một chuỗi các lãi suất kép (tính giá trị kỳ hạn cho một đầu tư có lãi suất thay đổi) 

INTRATE (settlement, maturity, investment, redemption, basis) : Tính lãi suất cho một chứng 

khoán đầu tư toàn bộ 

IPMT (rate, per, nper, pv, fv, type) : Trả về khoản thanh toán lãi cho một đầu tư dựa trên việc chi 

trả cố định theo kỳ và dựa trên lãi suất không đổi 

IRR (values, guess) : Tính lợi suất nội hàm cho một chuỗi các lưu động tiền mặt được thể hiện bởi 

các trị số 

ISPMT (rate, per, nper, pv) : Tính số tiền lãi đã trả tại một kỳ nào đó đối với một khoản vay có lãi 

suất không đổi, sau khi đã trừ số tiền gốc phải trả cho kỳ đó. 

MDURATION (settlement, maturity, coupon, yld, frequency, basis) : Tính thời hạn Macauley sửa 

đổi cho chứng khoán dựa trên đồng mệnh giá $100 

MIRR (values, finance_rate, reinvest_rate) : Tính tỷ suất doanh lợi nội tại trong một chuỗi luân 

chuyển tiền mặt theo chu kỳ 

NOMINAL (effect_rate, npery) : Tính lãi suất danh nghĩa hằng năm, biết trước lãi suất thực tế và 

các kỳ tính lãi kép mỗi năm 

NPER (rate, pmt, pv, fv, type) : Tính số kỳ hạn để trả khoản vay trong đầu tư dựa trên từng chu 

kỳ, số tiền trả và tỷ suất lợi tức cố định 

NPV (rate, value1, value2, ...) : Tính hiện giá ròng của một khoản đầu tư bằng cách sử dụng tỷ lệ 

chiếu khấu với các chi khoản trả kỳ hạn (trị âm) và thu nhập (trị dương) 

ODDFPRICE (settlement, maturity, issue, first_coupon, rate, yld, redemption, frequency, basis) : 

Tính giá trị trên mỗi đồng mệnh giá $100 của chứng khoán có kỳ đầu tiên lẻ (ngắn hạn hay dài 

hạn) 

ODDFYIELD (settlement, maturity, issue, first_coupon, rate, pr, redemption, frequency, basis) : 

Trả về lợi nhuận của một chứng khoán có kỳ tính lãi đầu tiên là lẻ (ngắn hạn hay dài hạn) 
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ODDLPRICE (settlement, maturity, last_interest, rate, yld, redemption, frequency, basis) : Tính 

giá trị trên mỗi đồng mệnh giá $100 của chứng khoán có kỳ tính lãi phiếu cuối cùng là lẻ (ngắn 

hạn hay dài hạn) 

ODDLYIELD (settlement, maturity, last_interest, rate, pr, redemption, frequency, basis) : Tính lợi 

nhuận của chứng khoán có kỳ cuối cùng là lẻ (ngắn hạn hay dài hạn) 

PMT (rate, nper, pv, fv, type) : Tính tiền phải trả đối với khoản vay có lãi suất không đổi và chi 

trả đều đặn 

PPMT (rate, per, nper, pv, fv, type) : Tính khoản vốn thanh toán trong một kỳ hạn đã cho đối với 

một khoản đầu tư, trong đó việc chi trả được thực hiện đều đặn theo định kỳ với một lãi suất không 

đổi 

PRICE (settlement, maturity, rate, yld, redemption, frequency, basis) : Tính giá trị chứng khoán 

trên đồng mệnh giá $100, thanh toán lợi tức theo chu kỳ 

PRICEDISC (settlement, maturity, discount, redemption, basis) : Tính giá trị trên đồng mệnh giá 

$100 của một chứng khoán đã chiết khấu 

PRICEMAT (settlement, maturity, issue, rate, yld, basis) : Tính giá trị trên đồng mệnh giá $100 

của một chứng khoán phải thanh toán lãi vào ngày đáo hạn 

PV (rate, nper, pmt, fv, type) : Tính giá trị hiện tại của một khoản đầu tư 

RATE (nper, pmt, pv, fv, type, guess) : Tính lãi suất mỗi kỳ trong một niên kim 

REVEICED (settlement, maturity, investment, discount, basis) : Tính số tiền nhận được vào kỳ 

hạn thanh toán cho một chứng khoán đầu tư toàn bộ 

SLN (cost, salvage, life) : Tính chi phí khấu hao (theo phương pháp đường thẳng) của một tài sản 

trong một kỳ 

SYD (cost, salvage, life, per) : Tính khấu hao theo giá trị còn lại của tài sản trong định kỳ xác định 

TBILLEQ (settlement, maturity, discount) : Tính lợi nhuận tương ứng với trái phiếu cho trái phiếu 

kho bạc 

TBILLPRICE (settlement, maturity, discount) : Tính giá trị đồng mệnh giá $100 cho trái phiếu 

kho bạc 

TBILLYIELD (settlement, maturity, pr) : Tính lợi nhuận cho trái phiếu kho bạc 

VDB (cost, salvage, life, start_period, end_period, factor, no_switch) : Tính khấu hao tài sản sử 

dụng trong nhiều kỳ 
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XIRR (values, dates, guess) : Tính lợi suất nội hàm cho một loạt lưu động tiền mặt không định kỳ 

XNPV (rate, values, dates) : Tính tỷ giá ròng cho một dãy lưu động tiền mặt không định kỳ 

YIELD (settlement, maturity, rate, pr, redemption, frequency, basis) : Tính lợi nhuận đối với chứng 

khoán trả lãi theo định kỳ 

YIELDDISC (settlement, maturity, pr, redemption, basis) : Tính lợi nhuận hằng năm cho chứng 

khoán đã chiết khấu 

YIELDMAT (settlement, maturity, issue, rate, pr, basis) : Tính lợi nhuận hằng năm của chứng 

khoán trả lãi vào ngày đáo hạn 

e. Danh mục các Các Hàm Quản lý Cơ sở dữ liệu và Danh sách 

DAVERAGE (database, field, criteria) : Tính trung bình các giá trị trong một cột của danh sách 

hay các trị của một cơ sở dữ liệu, theo một điều kiện được chỉ định. 

DCOUNT (database, field, criteria) : Đếm các ô chứa số liệu trong một cột của danh sách hay các 

trị của một cơ sở dữ liệu, theo một điều kiện được chỉ định. 

DCOUNTA (database, field, criteria) : Đếm các ô "không rỗng" trong một cột của danh sách hay 

các trị của một cơ sở dữ liệu, theo một điều kiện được chỉ định. 

DGET (database, field, criteria) : Trích một giá trị từ một cột của một danh sách hay cơ sở dữ liệu, 

khớp với điều kiện được chỉ định. 

DMAX (database, field, criteria) : Trả về trị lớn nhất trong một cột của một danh sách hay của một 

cơ sở dữ liệu, theo một điều kiện được chỉ định. 

DMIN (database, field, criteria) : Trả về trị nhỏ nhất trong một cột của một danh sách hay của một 

cơ sở dữ liệu, theo một điều kiện được chỉ định. 

DRODUCT (database, field, criteria) : Nhân các giá trị trong một cột của một danh sách hay của 

một cơ sở dữ liệu, theo một điều kiện được chỉ định. 

DSTDEV (database, field, criteria) : Ước lượng độ lệch chuẩn của một tập hợp theo mẫu, bằng 

cách sử dụng các số liệu trong một cột của một danh sách hay của một cơ sở dữ liệu, theo một điều 

kiện được chỉ định. 

DSTDEVP (database, field, criteria) : Tính độ lệch chuẩn của một tập hợp theo toàn thể các tập 

hợp, bằng cách sử dụng các số liệu trong một cột của một danh sách hay của một cơ sở dữ liệu, 

theo một điều kiện được chỉ định. 

DSUM (database, field, criteria) : Cộng các số trong một cột của một danh sách hay của một cơ 

sở dữ liệu, theo một điều kiện được chỉ định. 
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DVAR (database, field, criteria) : Ước lượng sự biến thiên của một tập hợp dựa trên một mẫu, 

bằng cách sử dụng các số liệu trong một cột của một danh sách hay của một cơ sở dữ liệu, theo 

một điều kiện được chỉ định. 

DVARP (database, field, criteria) : Tính toán sự biến thiên của một tập hợp dựa trên toàn thể tập 

hợp, bằng cách sử dụng các số liệu trong một cột của một danh sách hay của một cơ sở dữ liệu, 

theo một điều kiện được chỉ định. 

GETPIVOTDATA (data_field, pivot_table, field1, item1, field2, item2,...) : Trả về dữ liệu được 

lưu giữ trong báo cáo PivotTable. Có thể dùng GETPIVOTDATA để lấy dữ liệu tổng kết từ một 

báo cáo PivotTable, với điều kiện là phải thấy được dữ liệu tổng kết từ trong báo cáo đó. 

Nói chung về Các Hàm Quản lý Cơ sở dữ liệu và Danh sách 

Microsoft Excel cung cấp nhiều hàm dùng cho việc phân tích dữ liệu trong danh sách hay cơ sở 

dữ liệu. Những hàm này bắt đầu bằng chữ D. 

Mỗi hàm đều sử dụng 3 đối số là database, field và criteria; những đối số này là các tham chiếu 

đến các mảng trong bảng tính. 

* database : Là một dãy các ô tạo nên danh sách hay cơ sở dữ liệu. Một cơ sở dữ liệu là một danh 

sách dữ liệu gồm những mẩu tin, và có cột dữ liệu là các trường (field). Dòng đầu tiên trong danh 

sách luôn chứa tên trường. 

* field : Cho biết cột nào được sử dụng trong hàm. field có thể được cho ở dạng text với tên cột 

được để trong cặp dấu ngoặc kép (như "Age", "Yield"...) hay là số đại diện cho vị trí của cột (1, 2, 

...) 

* criteria : Là một dãy các ô chứa điều kiện. Có thể dùng bất cứ dãy nào cho phần điều kiện này, 

miễn là dãy đó có ít nhất một tên cột và một ô bên dưới tên cột để làm điều kiện cho hàm (xem 

thêm bài Một số ví dụ về cách dùng Criteria để nhập điều kiện ở sau đây). 

HÀM NGÀY THÁNG VÀ THỜI GIAN 

Một số lưu ý khi sử dụng ngày tháng và thời gian trong Excel:  

Excel hỗ trợ tính toán ngày tháng cho Windows và Macintosh. Windows dùng hệ ngày bắt đầu từ 

1900. Macitosh dùng hệ ngày bắt đầu từ 1904. Tài liệu này được diễn giải theo hệ ngày 1900 dành 

cho Windows.  

Hệ thống ngày giờ Excel phụ thuộc vào thiết lập trong Regional Options của Control Panel. Mặc 

định là hệ thống của Mỹ "Tháng/Ngày/Năm" (M/d/yyyy). Bạn có thể sửa lại thành hệ thống ngày 

của VN "Ngày/Tháng/Năm" (dd/MM/yyyy).  
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Khi bạn nhập một giá trị ngày tháng không hợp lệ nó sẽ trở thành một chuỗi văn bản. Công thức 

tham chiếu tới giá trị đó sẽ trả về lỗi.  

=NOW() Cho hiện ngày giờ của hệ thống 

=TODAY() Cho ngày của hệ thống 

=DAY(D) Cho giá trị ngày của D (Trả về thứ tự của ngày trong tháng từ một giá trị kiểu ngày 

tháng) 

=MONTH(D) Cho giá trị tháng của D 

=YEAR(D) Cho giá trị năm của D 

=DAYS360(BTNT1, BTNT2) Tính số ngày giữa 2 mốc ngày tháng dựa trên cơ sở một năm có 

360 ngày.  

=EDATE Trả về mốc thời gian xảy ra trước hoặc sau mốc chỉ định  

=EOMONTH Trả về ngày cuối cùng của tháng xảy ra trước hoặc sau mốc chỉ định  

Hàm HOUR() 

Cho biết số chỉ giờ trong một giá trị thời gian 

Cú pháp: = HOUR(serial_number) 

serial_number: Biểu thức thời gian hoặc là một con số chỉ giá trị thời gian 

Ví dụ: HOUR(0.5) = 12 (giờ) 

Hàm MINUTE() 

Cho biết số chỉ phút trong một giá trị thời gian 

Cú pháp: = MINUTE(serial_number) 

serial_number: Biểu thức thời gian hoặc là một con số chỉ giá trị thời gian 

Ví dụ: Bây giờ là 10:20 PM, MINUTE(NOW()) = 20 (phút) 

=MONTH Trả về số tháng của một giá trị kiểu ngày tháng.  

=NETWORKDAYS Trả về số ngày làm việc trong mốc thời gian đưa ra sau khi trừ đi ngày nghĩ 

và ngày lễ.  

=NOW Trả về ngày giờ hiện tại trong hệ thống của bạn.  

Hàm SECOND() 

Cho biết số chỉ giây trong một giá trị thời gian 
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Cú pháp: = SECOND(serial_number) 

serial_number: Biểu thức thời gian hoặc là một con số chỉ giá trị thời gian 

Ví dụ: SECOND("2:45:30 PM") = 30 (giây) 

Hàm TIME() 

Trả về một giá trị thời gian nào đó 

Cú pháp: = TIME(hour, minute, second) 

hour: Số chỉ giờ, là một con số từ 0 đến 23. Nếu lớn hơn 23, Excel sẽ tự trừ đi một bội số của 24. 

minute: Số chỉ phút, là một con số từ 0 đến 59. Nếu lớn hơn 59, Excel sẽ tính lại và tăng số giờ 

lên tương ứng. 

second: Số chỉ giây, là một con số từ 0 đến 59. Nếu lớn hơn 59, Excel sẽ tính lại và tăng số phút, 

số giờ lên tương ứng. 

Ví dụ: 

TIME(14, 45, 30) = 2:45:30 PM 

TIME(14, 65, 30) = 3:05:30 PM 

TIME(25, 85, 75) = 2:26:15 AM 

* Cũng như DATE(), hàm TIME() rất hữu dụng khi hour, minute, second là những công thức mà 

không phải là một con số, nó sẽ giúp chúng ta tính toán chính xác hơn 

Hàm TIMEVALUE() 

Chuyển đổi một chuỗi văn bản có dạng thời gian thành một giá trị thời gian để có thể tính toán 

được 

Cú pháp: = TIMEVALUE(time_text) 

time_text: Chuỗi văn bản cần chuyển đổi 

Ví dụ: 

TIMEVALUE("26:15") = 0.09375 (= 2:15:00 AM) 

=WEEKDAY Trả về số thứ tự của ngày trong tuần từ giá trị ngày tháng.  

=WEEKNUM Trả về số thứ tự của tuần trong năm từ giá trị ngày tháng.  

=WORKDAY Trả về ngày làm việc xảy ra trước hoặc sau mốc thời gian đưa ra.  
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Trong công việc hằng ngày, chắc hẳn chúng ta hay nghĩ đến chuyện việc làm này của mình mất 

hết mấy phần trăm của một năm, ví dụ, một ngày ngủ hết 6 tiếng, là 1/4 ngày, vậy một năm chúng 

ta ngủ hết 25% (hic) thời gian... 

Hoặc một nhân viên của công ty xin nghỉ việc vào tháng 5, lương tính theo năm, vậy công ty phải 

trả cho người đó bao nhiêu phần trăm lương khi cho nghỉ việc? 

Excel có một hàm để tính tỷ lệ của một khoảng thời gian trong một năm, và cho phép tính theo 

nhiều kiểu (năm 365 ngày, hay năm 360 ngày, tính theo kiểu Mỹ hay theo kiểu châu Âu...): 

Hàm YEARFRAC() 

(Dịch từ chữ Year: năm, và Frac = Fraction: tỷ lệ) 

Cú pháp: = YEARFRAC(start_date, end_date [, basis]) 

start_date, end_date: Ngày tháng đại diện cho ngày bắt đầu và ngày kết thúc của khoảng thời gian 

cần tính toán. Nên nhập bằng hàm DATE(), hoặc dùng một kết quả trả về của một công thức khác, 

vì có thể sẽ xảy ra lỗi nếu bạn nhập trực tiếp ngày tháng dưới dạng text. 

basis: Một con số, quy định kiểu tính: 

* 0 : (hoặc không nhập) Tính toán theo kiểu Bắc Mỹ, một năm có 360 ngày chia cho 12 tháng, một 

tháng có 30 ngày. 

* 1 : Tính toán theo số ngày thực tế của năm và số ngày thực tế của từng tháng 

* 2 : Tính toán theo một năm có 360 ngày, nhưng số ngày là số ngày thực tế của từng tháng 

* 3 : Tính toán theo một năm có 365 ngày, và số ngày là số ngày thực tế của từng tháng 

* 4 : Tính toán theo kiểu Châu Âu,mỗi tháng có 30 ngày (nếu start_date hoặc end_date mà rơi vào 

ngày 31 của một tháng thì chúng sẽ được đổi thành ngày 30 của tháng đó) 

Ví dụ: Tính tỷ lệ giữa ngày 15/3/2010 và ngày 30/7/2010 so với 1 năm: 

YEARFRAC("15/3/2010", "30/7/2010") = 37% 

Tính số ngày chênh lệch theo kiểu một năm có 360 ngày 

Hiện nay, vẫn còn một số hệ thống kế toán dùng kiểu tính thời gian là một tháng coi như có 30 

ngày và một năm coi như có 360 ngày! 

Gặp trường hợp này, việc tính toán thời gian sẽ không đơn giản, vì thực tế thì số ngày trong mỗi 

tháng đâu có giống nhau. 

Có lẽ vì nghĩ đến chuyện đó, nên Excel có một hàm dành riêng cho các hệ thống kế toán dựa trên 

cơ sở một năm có 360 ngày, đó là hàm DAYS360. 
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Hàm DAYS360() 

Cú pháp: = DAYS360(start_date, end_date [, method]) 

start_date, end_date: Ngày tháng đại diện cho ngày bắt đầu và ngày kết thúc của khoảng thời gian 

cần tính toán. Nên nhập bằng hàm DATE(), hoặc dùng một kết quả trả về của một công thức khác, 

vì có thể sẽ xảy ra lỗi nếu bạn nhập trực tiếp ngày tháng dưới dạng text. 

method: Một giá trị logic (TRUE, FALSE) để chỉ cách tính toán, theo kiểu châu Âu hay theo kiểu 

Mỹ. 

* FALSE: (hoặc không nhập) Tính toán theo kiểu Mỹ: Nếu start_date là ngày 31 của tháng, thì nó 

được đổi thành ngày 30 của tháng đó. Nếu end_date là ngày 31 của tháng và start_date nhỏ hơn 

30, thì end_date được đổi thành ngày 1 của tháng kế tiếp. 

* TRUE: Tính toán theo kiểu châu Âu: Hễ start_date hoặc end_date mà rơi vào ngày 31 của một 

tháng thì chúng sẽ được đổi thành ngày 30 của tháng đó. 

Ví dụ: So sánh số ngày chênh lệch giữa 01/01/2008 và 31/5/2008 theo kiểu một năm có 360 ngày 

và theo kiểu thường (dùng hàm DATEDIF) 

DAYS360("01/01/2008", "31/5/2008") = 150 

DAYS360("01/01/2008", "31/5/2008", TRUE) = 149 

DATEDIF("01/01/2008", "31/5/2008", "d") = 151 

Tính số ngày làm việc giữa hai khoảng thời gian 

Bình thường, nếu lấy ngày tháng trừ ngày tháng, kết quả sẽ bao gồm luôn những ngày lễ, ngày 

nghỉ, v.v... Còn nếu tính số ngày làm việc trong một khoảng thời gian, thì phải trừ bớt đi những 

ngày không làm việc. 

Trong Excel có một hàm chuyên để tính toán những ngày làm việc giữa hai khoảng thời gian mà 

không bao gồm các ngày thứ Bảy, Chủ Nhật và những ngày nghỉ khác được chỉ định: Hàm 

NETWORKDAYS (đúng nguyên nghĩa của nó: net workdays). 

Dĩ nhiên hàm này chỉ thích hợp với những cơ quan làm việc 5 ngày một tuần, chứ như chúng ta, 

làm tuốt, có khi là 365 ngày một năm (hic) thì hàm này vô tác dụng! 

Hàm NETWORKDAYS() 

Cú pháp: = NETWORKDAYS(start_date, end_date [, holidays]) 
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start_date, end_date: Ngày tháng đại diện cho ngày bắt đầu và ngày kết thúc công việc. Nên nhập 

bằng hàm DATE(), hoặc dùng một kết quả trả về của một công thức khác, vì có thể sẽ xảy ra lỗi 

nếu bạn nhập trực tiếp ngày tháng dưới dạng text. 

holidays: Danh sách những ngày nghỉ ngoài những ngày thứ Bảy và Chủ Nhật. Danh sách này có 

thể là một vùng đã được đặt tên. Nếu nhập trực tiếp thì phải bỏ trong cặp dấu móc {}. 

Ví dụ: Công thức tính số ngày làm việc giữa ngày 1/12/2010 và ngày 10/1/2011, trong đó có nghỉ 

ngày Noel (25/12) và ngày Tết Tây (1/1): 

= NETWORKDAYS("01/12/2010", "10/01/2011", {"12/25/2007", "1/1/2011"}) 

Hàm DATEDIF() 

Có lẽ cách dễ nhất khi muốn tính toán ngày tháng năm là dùng hàm DATEDIF(). 

Cú pháp: = DATEDIF(start_day, end_day, unit) 

start_day: Ngày đầu 

end_day: Ngày cuối (phải lớn hơn ngày đầu) 

unit: Chọn loại kết quả trả về (khi dùng trong hàm phải gõ trong dấu ngoặc kép) 

y : số năm chênh lệch giữa ngày đầu và ngày cuối 

m : số tháng chênh lệch giữa ngày đầu và ngày cuối 

d : số ngày chênh lệch giữa ngày đầu và ngày cuối 

md : số ngày chênh lệch giữa ngày đầu và tháng ngày cuối, mà không phụ thuộc vào số năm và số 

tháng 

ym : số tháng chênh lệch giữa ngày đầu và ngày cuối, mà không phụ thuộc vào số năm và số ngày 

yd : số ngày chênh lệch giữa ngày đầu và ngày cuối, mà không phụ thuộc vào số năm 

Ví dụ: 

DATEDIF("01/01/2000", "31/12/2100", "y") = 100 (năm) 

DATEDIF("01/01/2000", "31/12/2100", "m") = 1211 (tháng) 

DATEDIF("01/01/2000", "31/12/2100", "d") = 36889 (ngày) 

DATEDIF("01/01/2000", "31/12/2100", "md") = 30 (= ngày 31 - ngày 1) 

DATEDIF("01/01/2000", "31/12/2100", "ym") = 11 (= tháng 12 - tháng 1) 

DATEDIF("01/01/2000", "31/12/2100", "yd") = 365 (= ngày 31/12 - ngày 1/1) 
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*Tính tuổi (2): 

Ở bài trước, tôi đã đưa ra một cái công thức để tính tuổi dài thoòng như vầy: 

= YEAR(NOW() - YEAR(Birthdate) - (DATE(YEAR(NOW()), MONTH(Birthdate), 

DAY(Birthdate)) > TODAY()) 

Đó là khi chưa biết đến hàm DATEDIF(). 

Bây giờ, với DATEDIF(), công thức trên chỉ ngắn như vầy thôi, mà ra kết quả vẫn chính xác: 

= DATEDIF(Birthdate, TODAY(), "y") 

Ví dụ, hôm nay là ngày 09/01/2007: 

* Với ngày sinh là 05/01/1969 (đã tổ chức sinh nhật rồi), DATEDIF("05/01/1969", TODAY(), 

"y") = 39 

* Nhưng với ngày sinh là 11/1/1969 (chưa tổ chức sinh nhật), DATEDIF("11/01/1969", 

TODAY(), "y") = 38 

*Tìm một giờ, phút, giây nào đó tính từ lúc này 

Như tôi đã nói ở trên, hàm TIME() sẽ tự động điều chỉnh kết quả của một giá trị thời gian khi 

những thông số trong hàm không hợp lý (giờ > 24, phút và giây > 60). Và do đó, khi cần tính toán 

hoặc tìm một giá trị thời gian nào đó kể từ lúc này (hoặc bất kỳ lúc nào), người ta thường sử dụng 

hàm TIME(). 

Ví dụ, công thức sau đây sẽ cho ra kết quả là thời gian vào 12 tiếng nữa kể từ lúc này: 

= TIME(HOUR(NOW()) + 12, MINUTE(NOW()), SECOND(NOW())) 

Không giống như hàm DATE(), bạn không thể đơn giản cộng thêm giờ, phút, hay giây trong hàm 

TIME(). Ví dụ công thức sau đây chỉ làm mỗi chuyện là tăng thêm 1 ngày vào ngày tháng năm và 

thời gian hiện tại: 

= NOW() + 1 

Nếu bạn muốn cộng thêm giờ, phút, hay giây vào một giá trị thời gian, bạn phải tính thời gian cộng 

thêm đó theo một tỷ lệ của một ngày. Ví dụ, bởi vì một ngày thì có 24 giờ, nên một giờ được tính 

như là 1/24. Cũng vậy, bởi vì một giờ thì có 60 phút, nên một phút sẽ được tính như là 1/24/60 

(của một ngày). Và cuối cùng, bởi vì có 60 giây trong một phút, nên 1 giây trong một ngày sẽ được 

tính bằng 1/24/60/60. 

*Tính tổng thời gian 

Khi tính tổng thời gian, bạn nên phân biết hai trường hợp sau đây: 
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* Cộng thêm giờ, phút, giây: Ví dụ, bây giờ là 8 giờ, cộng thêm 2 tiếng nữa, là 10 giờ... Hoặc bây 

giờ là 23 giờ, cộng thêm 3 tiếng nữa là 2 giờ sáng (chớ không phải 26 giờ)... Nếu cộng kiểu này 

thì bạn cứ cộng bình thường, dùng hàm TIME() và nếu cần thì theo bảng hướng dẫn ở trên. 

* Cộng tổng thời gian làm việc: Mỗi ngày tôi làm việc 18 tiếng, vậy hai ngày tôi làm mấy tiếng? 

là 36 tiếng. Nhưng nếu bạn dùng format bình thường dạng thời gian thì Excel nó sẽ tự quy ra (36-

24) = 12:00... Để được kết quả là 36:00, bạn phải định dạng thời gian cho ô theo kiểu: 

[h]:mm:ss (giờ nằm trong một cặp dấu ngoặc vuông) 

Lấy lại định dạng ngày tháng 

Đôi khi, bạn nhận được một cái database mà không hiểu vì một lý do gì đó, cell chứa ngày tháng 

năm nó như sau: 20070823, 

nghĩa là nó được định dạng theo kiểu YYYYMMDD. 

Trường hợp này, không thể dùng Format Cell của Excel để định dạng lại, mà bạn phải dùng đến 

hàm DATE(year, month, day) 

và các hàm xử lý text, ví dụ hàm LEFT(), MID() và RIGHT() để lấy các trị số ngày, tháng, năm 

cho hàm DATE(): 

Tôi giả sử con số 20070823 này đang nằm ở cell A1, thì công thức LEFT(A1, 4) sẽ cho ta trị số 

của năm, MID(A1, 3, 2) sẽ cho trị số của tháng 

và RIGHT(A1, 2) sẽ cho trị số của ngày. 

Giả sử trong Control Panel của bạn định dạng ngày tháng năm theo kiểu dd/mm/yyyy, và cell nhận 

kết quả của bạn đã được định dạng theo kiểu ngày tháng năm, 

bạn dùng hàm DATE(year, month, day) với 3 tham số là 3 công thức vừa làm ở trên, ta sẽ có: 

=DATE(LEFT(A1, 4), MID(A1, 5, 2), RIGHT(A1, 2))→ 23/8/2007 

HÀM TÌM KIẾM VÀ THAM CHIẾU 

Bao gồm các hàm tìm kiếm và tham chiếu rất hữu ích khi bạn làm việc với CSDL lớn trong EXCEL 

như kế toán, tính lương, thuế... 

=ADDRESS(row_num, column_num [, abs_num] [, a1] [, sheet_text]) Dùng để tạo địa chỉ dạng 

chuỗi ký tự, theo chỉ số dòng và chỉ số cột được cung cấp. 

row_num: Số thứ tự dòng của địa chỉ 

column_num: Số thứ tự cột của địa chỉ 

abs_num: Kiểu địa chỉ (tuyệt đối hay tương đối) - mặc định là tuyệt đối 
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a1: Dạng địa chỉ (=TRUE: dạng A1; =FALSE: dạng R1C1) - mặc định là TRUE 

sheet_text: Tên của sheet chứa địa chỉ - mặc định là không có 

=AREAS(reference) Trả về số vùng tham chiếu trong một tham chiếu. Mỗi vùng tham chiếu có 

thể là một ô rời rạc hoặc là một dãy ô liên tục trong bảng tính. 

reference: Là một hoặc nhiều vùng tham chiếu mà bạn cần đếm. Nếu muốn đưa nhiều vùng rời rạc 

nhau vào công thức thì bạn phân cách chúng bằng dấu phẩy, nếu không ngăn bằng dấu phẩy, Excel 

sẽ không đếm (xem ví dụ 3 dưới đây) 

=CHOOSE Trả về giá trị trong mảng giá trị tại vị trí được chỉ định.  

=COLUMN(reference) Trả về số thứ tự cột của ô đầu tiên ở góc trên bên trái của vùng tham chiếu. 

reference: Là ô hoặc một vùng nhiều ô. Nếu reference bỏ trống thì COLUMN() trả về số thứ tự 

cột của ô chứa công thức. 

=COLUMNS(array) Trả về số cột của vùng tham chiếu.  

array: Là ô hoặc một vùng nhiều ô, mảng tham chiếu 

=HYPERLINK(link_location, friendly_name) Tạo một siêu liên kết, một liên kết để mở một tài 

liệu... 

link_location: Đường dẫn đến tài liệu cần mở, nhập ở dạng chuỗi ký tự. Link_location có thể chỉ 

đến một ô đặc biệt, tên của một dãy ô trong một trang bảng tính hoặc một bảng tính, hoặc chỉ đến 

một đánh dấu (bookmark) trong Microsoft Excel. Link_location cũng có thể chỉ đến một tập tin 

lưu trên ổ cứng, hoặc một đường dẫn truy xuất nội bộ trên một máy chủ hoặc một đường dẫn tài 

nguyên URL trên mạng intranet, internet. 

- Link_location có thể là một chuỗi ký tự đặt trong dấu nháy kép, hoặc một ô nào đó chứa đường 

dẫn dưới dạng chuỗi ký tự. 

- Nếu link_location liên kết đến một tài nguyên không tồn tại, sẽ xuất hiện lỗi khi bạn kích vào ô 

chứa hàm HYPERLINK() này. 

firendly_name: Là nội dung hiển thị trong ô chứa hàm HYPERLINK(), có thể là một số, hoặc 

chuỗi ký tự. Nội dung này sẽ hiển thị bằng màu xanh và có gạch chân, nếu không có firendly_name 

thì chính link_location sẽ hiển thị. 

- Firendly_name có thể là một giá trị, một chuỗi ký tự, một tên mảng, hoặc một ô liên kết đến một 

giá trị hoặc một chuỗi văn bản. 

- Nếu firendly_name liên kết đến một giá trị bị lỗi, thì chính tên cái lỗi đó sẽ được hiển thị để thay 

thế cho nội dung bạn cần. 
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Ví dụ: 

=HYPERLINK("http://example.microsoft.com/report/bu dget report.xls", "Click for report") 

sẽ hiển thị: Click for report, và khi bạn click vào ô này, Excel sẽ mở bảng tính budget report.xls 

của trang web http://example.microsoft.com/report 

=HYPERLINK("F:\GPE\book2.xls",F10) 

sẽ hiển thị nội dung của ô F10 và khi bạn click vào ô này, Excel sẽ mở bảng tính book2.xls ở thư 

mục GPE của ổ F 

=HYPERLINK("F:\GPE\book2.xls",F10) 

sẽ hiển thị nội dung của ô F10 và khi bạn click vào ô này, Excel sẽ mở bảng tính book2.xls ở thư 

mục GPE của ổ F 

=MATCH Trả về vị trí của một giá trị trong bảng dữ liệu  

=INDEX Trả về một giá trị trong bảng dữ liệu tương ứng với chỉ mục của nó.  

Tìm kiếm trong nhiều cột 

Đôi khi, các dữ liệu dùng để tìm kiếm không nằm ở một cột mà trong nhiều cột. 

Ví dụ, bạn có một danh sách đã được tách sẵn họ và tên riêng ra hai cột. 

Người ta yêu cầu dựa vào họ và tên để xác định chức vụ. 

Chúng ta có thể dùng một cột phụ để nối họ và tên lại rồi tìm theo cột phụ... Nhưng có lẽ không 

cần, vì tôi sẽ dùng hàm INDEX() và MATCH() với công thức mảng. 

Hàm MATCH() có một cú pháp ít người biết đến, đó là: 

=MATCH(value1 & value2, array1 & array2, match_type) 

value1 & value2 là các dữ liệu để tìm (ví dụ họ và tên) 

array1 & array2 là các cột (hoặc hàng) chứa các dữ liệu dùng để tìm kiếm đó 

Và đây là cú pháp dùng INDEX() ghép với MATCH() trong công thức mảng: 

{=INDEX(reference, MATCH(value1 & value2, array1 & array2, match_type))} 

=INDIRECT(ref_text [, a1])  

ref_text là tham chiếu tới một ô (có thể là dạng A1 hoặc dạng R1C1), là tên định nghĩa của một 

tham chiếu, hoặc là một tham chiếu dạng chuỗi. 

-Nếu ref_text không hợp lệ, INDIRECT() sẽ báo lỗi #REF! 
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-Nếu ref_text chứa tham chiếu đến một bảng tính khác thì bảng tính này phải đang mở, nếu không, 

INDIRECT() cũng báo lỗi #REF! 

a1 là giá trị logic xác định dạng tham chiếu bên trong ref_text. 

a1 = TRUE (hoặc là 1, hoặc không nhập) là kiểu tham chiếu A1 

a1 = FALSE (hoặc là 2) là kiểu tham chiếu R1C1 

Trả về giá trị của một tham chiếu từ chuỗi ký tự. Tham chiếu được trả về ngay tức thời để hiển thị 

nội dung của chúng. Cũng có thể dùng hàm INDIRECT khi muốn thay đổi tham chiếu tới một ô 

bên trong một công thức mà không cần thay đổi công thức đó. 

=LOOKUP Dò tìm một giá trị  

Hàm LOOKUP 

Dùng để dò tìm một giá trị từ một dòng hoặc một cột trong một dãy ô hoặc một mảng giá trị. 

Hàm LOOKUP() có hai dạng: Vec-tơ (vector form) và Mảng (array form) 

* Dạng Vec-tơ: LOOKUP() tìm kiếm trên một dòng hoặc một cột, nếu tìm thấy sẽ trả về giá trị 

của ô cùng vị trí trên dòng (hoặc cột) được chỉ định. 

* Dạng Mảng: LOOKUP() tìm kiếm trên dòng (hoặc cột) đầu tiên của một mảng giá trị, nếu tìm 

thấy sẽ trả về giá trị của ô cùng vị trí trên dòng (hoặc cột) cuối cùng trong mảng đó. 

Vector form (dạng vec-tơ) 

Cú pháp: LOOKUP(lookup_value, lookup_vector, result_vector) 

lookup_value: Là giá trị LOOKUP() sẽ tìm kiếm trong lookup_vector. Nó có thể là một số, một 

ký tự, một giá trị logic, một tên đã được định nghĩa của một vùng ô hoặc một tham chiếu đến một 

giá trị. 

lookup_vector: Là một vùng mà chỉ gồm một dòng (hoặc một cột) có chứa lookup_value. Những 

giá trị chứa trong vùng này có thể là một số, một ký tự hoặc một giá trị logic. 

- lookup_vector phải được sắp xếp theo thứ tự tăng dần, nếu không, LOOKUP() có thể cho kết 

quả không chính xác. 

- Nếu không tìm thấy lookup_value trong lookup_vector thì LOOKUP() sẽ lấy giá trị lớn nhất mà 

nhỏ hơn hoặc bằng lookup_value. 

- Nếu lookup_value nhỏ hơn giá trị nhỏ nhất trong lookup_vector thì LOOKUP() sẽ báo lỗi #NA! 

result_vector: Là một vùng mà chỉ gồm một dòng (hoặc một cột) chứa giá trị trả về. Kích thước 

của result_vector bắt buộc phải bằng kích thước của lookup_vector. 
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^^ Array form (dạng mảng) 

Cú pháp: LOOKUP(lookup_value, array) 

lookup_value: Là giá trị LOOKUP() sẽ tìm kiếm trong array. Nó có thể là một số, một ký tự, một 

giá trị logic, một tên đã được định nghĩa của một vùng ô hoặc một tham chiếu đến một giá trị. 

- Nếu không tìm thấy lookup_value trong array thì LOOKUP() sẽ lấy giá trị lớn nhất mà nhỏ hơn 

hoặc bằng lookup_value. 

- Nếu lookup_value nhỏ hơn giá trị nhỏ nhất trong cột hoặc hàng đầu tiên trong array thì 

LOOKUP() sẽ báo lỗi #NA! 

array: Là một vùng chứa lookup_value, có thế là số, ký tự, hoặc giá trị logic. 

Dạng mảng của LOOKUP() gần tương đương như hàm VLOOKUP() hoặc HLOOKUP(). 

Khác biệt ở chỗ VLOOKUP() và HLOOKUP() tìm kiếm trên cột (hoặc dòng) đầu tiên, còn 

LOOKUP() tìm kiếm trên cột hoặc trên dòng tùy thuộc vào dạng mảng được khai báo: 

- Nếu array là mảng có số cột nhiều hơn số dòng thì LOOKUP() sẽ tìm trên dòng đầu tiên. 

- Nếu array là mảng có số dòng nhiều hơn số cột thì LOOKUP() sẽ tìm trên cột đầu tiên. 

- Trường hợp array là mảng có số dòng bằng số cột thì LOOKUP() sẽ tìm trên cột đầu tiên. 

- VLOOKUP() và HLOOKUP() lấy kết quả trên cột (hoặc) dòng được chỉ định, còn LOOKUP() 

luôn luôn lấy kết quả trên dòng (hoặc cột) cuối cùng. 

- Các giá trị trên dòng (hoặc cột) đầu tiên của array phải được sắp xếp theo thứ tự tăng dần, nếu 

không, LOOKUP() có thể cho kết quả không chính xác. 

Hàm GETPIVOTDATA() 

Trả về dữ liệu được lưu giữ trong báo cáo PivotTable. Có thể dùng GETPIVOTDATA() để lấy dữ 

liệu tổng kết từ một báo cáo PivotTable, với điều kiện là phải thấy được dữ liệu tổng kết từ trong 

báo cáo đó. 

Để nhanh chóng nhập công thức GETPIVOTDATA(), bạn có thể gõ dấu = vào ô muốn nhận dữ 

liệu tổng kết, rồi nhấp vào ô chứa số liệu tổng kết của báo cáo PivotTable. 

Cú pháp: = GETPIVOTDATA(data_field, pivot_table, field1, item1, field2, item2,...) 

data_field : Tên trường chứa dữ liệu tổng kết của báo cáo PivotTable. Tên này phải được đặt trong 

một cặp dấu nháy kép. 

pivot_data : Tham chiếu đến một ô, dãy ô, hoặc tên dãy ô bên trong một báo cáo PivotTable. Thông 

tin này được dùng để xác định báo cáo PivotTable nào chứa dữ liệu trả về.  
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field1, item1, field2, item2,... : Có thể có từ 1 đến 126 (với Excel 2003 trở về trước thì con số này 

chỉ là 14) cặp tên field và item mô tả dữ liệu muốn trả về. Những cặp này có thể thuộc bất cứ loại 

nào. Nếu tên field và item không là ngày tháng hoặc số liệu, cần phải đặt chúng trong cặp dấu nháy 

kép. Đối với loại báo cáo OLAP PivotTable, items có thể bao gồm đầy đủ đường dẫn lẫn tên của 

item. Một cặp field và item của OLAP PivotTable có thể như sau: 

"[Product]","[Product].[All Products].[Foods].[Baked Goods]" 

Lưu ý: 

* Các field hay item tính toán và các phép tính tự tạo có thể được đặt trong phép tính 

GETPIVOTDATA. 

* Nếu pivot_table là một dãy có chứa nhiều hơn 1 báo cáo PivotTable, dữ liệu trả về sẽ là từ báo 

cáo được tạo ra sau cùng. 

* Nếu đối số field và các đối số của item mô tả chỉ mỗi một ô, giá trị của ô đó sẽ được trả về mà 

không cần biết giá trị đó là chuỗi, là số, là lỗi, hay là một thứ gì đó... 

* Nếu item chứa ngày tháng, giá trị phải được biểu diễn dưới dạng một chuỗi số hoặc được thiết 

lập bằng cách dùng hàm DATE() để giá trị đó sẽ không biến đối khi bảng tính được mở ở một máy 

khác, có hệ thống định dạng ngày tháng khác với nơi tạo ra nó. Ví dụ, một item tham chiếu tới 

ngày 5 tháng 3 năm 1999 có thể được nhập là 36224 hay DATE(1999, 3, 5). Thời gian có thể được 

nhập như một giá trị thập phân hoặc bằng cách dùng hàm TIME(). 

* Nếu pivot_table không phải là một dãy có chứa báo cáo PivotTable, GETPIVOTDATA() sẽ trả 

về lỗi #REF! 

* Nếu các đối số miêu tả một field không thể thấy được, hoặc nếu chúng gồm một trường không 

hiển thị, GETPIVOTDATA() cũng sẽ trả về lỗi #REF! 

Hàm DGET() 

Trích một giá trị từ một cột của một danh sách hay cơ sở dữ liệu, khớp với điều kiện được chỉ 

định. 

Cú pháp: = DGET(database, field, criteria) 

=OFFSET(reference, rows, cols [, height] [, width]) Trả về một vùng tham chiếu từ một vùng xuất 

phát.  

Đây là một trong những hàm rất hay của Excel, và được ứng dụng rất nhiều. 

Nó dùng để tham chiếu đến một vùng nào đó, bắt đầu từ một ô, hoặc một dãy ô, với một khoảng 

cách được chỉ định. 
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reference: Là vùng mà bạn muốn làm điểm xuất phát để tham chiếu đến vùng khác. Reference phải 

chỉ đến một ô hoặc một dãy ô liên tục, nếu không, hàm sẽ báo lỗi #VALUE! 

rows: Số dòng dời lên (hoặc xuống) tính từ reference, nhập số dương nếu muốn dời xuống, hoặc 

số âm nếu muốn dời lên. 

cols: Số cột dời sang phải trái (hoặc phải) tính từ reference, nhập số dương nếu muốn dời sang 

phải, hoặc số âm nếu muốn dời sang trái. 

height: Là số dòng (độ cao) của vùng tham chiếu cần trả về. 

width: Là số cột (độ rộng) của vùng tham chiếu cần trả về. 

Ghi chú: 

* Nếu số dòng (rows) hoặc cột (cols) vượt ra ngoài phạm vi bảng tính, hàm sẽ báo lỗi #REF! 

* Độ cao (height) và độ rộng (width) nếu không nhập, thì xem như nó bằng với độ cao và độ rộng 

của vùng xuất phát (reference) 

=ROW(reference) Trả về số thứ tự dòng của ô đầu tiên trong dãy ô. Trả về số thứ tự dòng của ô 

đầu tiên ở góc trên bên trái của vùng tham chiếu. 

reference: Là ô hoặc một vùng nhiều ô. Nếu reference bỏ trống thì ROW() trả về số thứ tự cột của 

ô chứa công thức. 

=ROWS(array) Trả về số dòng của vùng tham chiếu. 

array: Là ô hoặc một vùng nhiều ô, mảng tham chiếu  

=TRANSPOSE(array) Chuyển một vùng dữ liệu ngang thành dọc và ngược lại. 

Hàm TRANSPOSE() luôn luôn được nhập ở dạng công thức mảng (nhấn Ctrl-Shift-Enter sau khi 

nhập) 

array: Là mảng dữ liệu cần hoán chuyển 

Nếu số cột trong vùng nhập công thức nhiều hơn số hàng của array, hoặc số hàng trong vùng nhập 

công thức nhiều hơn số cột của array, hàm sẽ báo lỗi #NA tại những ô bị dư ra.  

=VLOOKUP(giá trị tìm, vùng cần tìm, cột cần lấy, cách tìm) Dò tìm một giá trị trên cột đầu tiên 

và trả về ... 

Hàm tìm kiếm và tham chiếu theo cột. 

Vùng cần tìm: thường để ở chế độ giá trị tuyệt đối: $ 

Cột cần lấy: ở vùng cần tìm. 
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Cách tìm: Tìm theo 2 giá trị: 

0: Cột bên trái của vùng cần tìm không sắp xếp (ngầm định) 

1: Sắp xếp tăng dần. 

=HLOOKUP(giá trị tìm, vùng cần tìm, hàng cần lấy, cách tìm) Dò tìm một giá trị trên hàng đầu 

tiên và trả về ... - giống hàm VLOOKUP 

f. HÀM TOÁN HỌC VÀ LƯỢNG GIÁC 

Bao gồm các hàm về toán học và lượng giác giúp bạn có thể giải một bài toán đại số, giải tích, 

hoặc lượng giác từ tiểu học đến đại học...  

Lưu ý đến quy cách hiển thị số của VN và của US. Để luôn nhập đúp một giá trị kiểu số bạn hãy 

sử dụng bàn phím số.  

=ABS Tính trị tuyệt đối của một số  

=ACOS Tính nghịch đảo cosin  

=ACOSH Tính nghịch đảo cosin hyperbol  

=ASIN Tính nghịch đảo sin  

=ASINH Tính nghịch đảo sin hyperbol  

=ATAN Tính nghịch đảo tang  

=ATAN2 Tính nghịch đảo tang với tọa độ  

=ATANH Tính nghịch đảo tang hyperbol  

=CEILING Là tròn đến bội số gần nhất  

=COMBIN Tính tổ hợp từ số phần tử chọn  

=COS Tính cosin của một góc  

=COSH Tính cosin hyperbol  

=DEGREES Đổi radians sang độ  

=EVEN Làm tròn một số đến số nguyên chẵn gần nhất.  

=EXP Tính lũy thừa cơ số e  

=FACT Tính giai thừa của một số  

=FACTDOUBLE Tính lũy thừa cấp 2  

=FLOOR Làm tròn xuống đến bội số gần nhất do bạn chỉ.  
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=GCD Tìm ước số chung lớn nhất  

=INT(X) Làm tròn xuống số nguyên gần nhất (Hàm lấy giá trị là phần nguyên-Hàm cho giá trị là 

phần nguyên của X) 

=LCM Tìm bội số chung nhỏ nhất  

=LN Tính logarit cơ số tự nhiên của một số  

=LOG Tính logarit  

=LOG10 Tính logarit cơ số 10 

=MDETERM Tính định thức của ma trận  

=MINVERSE Tìm ma trận nghịch đảo  

=MMULT Tính tích 2 ma trận  

=MOD(a,b) Hàm cho giá trị là phần dư của phép chia a:b 

=MROUND Làm tròn một số đến bội số của số khác.  

=MULTINOMIAL Tỷ lệ giai thừa tổng với tích các giai thừa của các số.  

=ODD Làm tròn đến một số nguyên lẽ gần nhất.  

=PI Trả về giá trị pi  

=POWER Tính lũy thừa của một số  

=PRODUCT Tính tích các số  

=QUOTIENT Lấy phần nguyên của phép chia  

=RADIANS Đổi độ sang radians.  

=RAND Trả về một số ngẫu nhiên trong khoảng 0 và 1  

=RANDBETWEEN Trả về một số ngẫu nhiên trong khoảng do bạn chỉ định  

Hàm ROMAN() 

Dùng để chuyển đổi một số dạng Ả-rập sang dạng số La-mã 

Cú pháp: = ROMAN(number, form) 

number: Số cần chuyển đổi 

form: dạng chuyển đổi 

0 (hoặc TRUE, hoặc không nhập): Dạng cổ điển 
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1 cho đến 3: Dạng cổ điển nhưng được rút gọn, số càng lớn rút gọn càng nhiều (xem thêm ở ví dụ) 

4 (hoặc FALSE): Dạng hiện đại 

Chú ý: 

* number phải là số dương, nếu number < 0 hàm sẽ báo lỗi #VALUE! 

* Nếu number là số thập phân, ROMAN() chỉ chuyển đổi phần nguyên của nó 

* Hàm ROMAN() chỉ xử lý được tới số lớn nhất là 3999, nếu number > 3999 hàm sẽ báo lỗi 

#VALUE! 

* Sau khi đã chuyển đổi, kết quả sẽ là một dữ liệu dạng text, và không thể tính toán với nó được 

nữa 

Ví dụ: 

ROMAN(499, 0) = CDXCIX = ROMAN(499) = ROMAN(499, TRUE) 

ROMAN(499, 1) = LDVLIV 

ROMAN(499, 2) = XDIX 

ROMAN(499, 3) = VDIV 

ROMAN(499, 4) = ID = ROMAN(499, FALSE) 

ROMAN(2008) = MMVIII 

=ROUND(X,n) Hàm làm tròn n số của X 

Nếu n dương (n>0) sẽ làm tròn số bên phải kể từ vị trí dấu chấm thập phân. 

Nếu n âm (n<0) sẽ làm tròn số bên trái kể từ vị trí dấu chấm thập phân.  

=ROUNDDOWN Làm tròn một số hướng xuống zero  

=ROUNDUP Làm tròn một số hướng ra xa zero.  

=SIN Tính sin của một góc  

=SINH Tính sin hyperbol của một số  

=SUM Tính tổng của các số  

=DSUM (vùng dữ liệu, cột giá trị, vùng tiêu chuẩn) Hàm tính tổng trong cột giá trị thoả mãn điều 

kiện của vùng tiêu chuẩn trong vùng dữ liệu. 

VD: Tính tổng tiền lương những người 26 tuổi. 

Hàm SUMIF() 
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Tính tổng các ô trong một vùng thỏa một điều kiện cho trước. 

Cú pháp: = SUMIF(range, criteria, sum_range) 

Range : Dãy các ô để tính tổng, có thể là ô chứa số, tên, mảng, hay tham chiếu đến các ô chứa số. 

Ô rỗng và ô chứa giá trị text sẽ được bỏ qua. 

Criteria : Điều kiện để tính tổng. Có thể ở dạng số, biểu thức, hoặc text. Ví dụ, criteria có thể là 

32, "32", "> 32", hoặc "apple", v.v... 

Sum_range : Là vùng thực sự để tính tổng. Nếu bỏ qua, Excel sẽ coi như sum_range = range. 

Lưu ý: 

* Sum_range không nhất thiết phải cùng kích thước với range. Vùng thực sự để tính tổng được 

xác định bằng ô đầu tiên phía trên bên trái của sum_range, và bao gồm thêm những ô tương ứng 

với kích thước của range. Ví dụ: 

- Nếu Range là A1:A5, Sum_range là B1:B5, thì vùng thực sự để tính tổng là B1:B5 

- Nếu Range là A1:A5, Sum_range là B1:B3, thì vùng thực sự để tính tổng là B1:B5 

- Nếu Range là A1:B4, Sum_range là C1:D4, thì vùng thực sự để tính tổng là C1:D4 

- Nếu Range là A1:B4, Sum_range là C1:D2, thì vùng thực sự để tính tổng là C1:D4 

* Có thể dùng các ký tự đại diện trong điều kiện: dấu ? đại diện cho một ký tự, dấu * đại diện cho 

nhiều ký tự (nếu như điều kiện là tìm những dấu ? hoặc *, thì gõ thêm dấu ~ ở trước dấu ? hay *). 

* Khi điều kiện để tính tổng là những ký tự, SUMIF() không phân biệt chữ thường hay chữ hoa. 

Hàm SUMIFS() 

Tính tổng các ô trong một vùng thỏa nhiều điều kiện cho trước. 

Cú pháp: = SUMIFS(sum_range, criteria_range1, criteria1, criteria_range2, criteria2, ...) 

Sum_range : Dãy các ô để tính tổng, có thể là ô chứa số, tên, mảng, hay tham chiếu đến các ô chứa 

số. Ô rỗng và ô chứa giá trị text sẽ được bỏ qua. 

Criteria_range1, criteria_range2... : Có thể có từ 1 đến 127 vùng dùng để liên kết với các điều kiện 

cho vùng. 

Criteria1, criteria2... : Có thể có từ 1 đến 127 điều kiện để tính tổng. Chúng có thể ở dạng số, biểu 

thức, hoặc text. Ví dụ, criteria có thể là 32, "32", "> 32", hoặc "apple", v.v...  

Lưu ý: 
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* Mỗi ô trong sum_range chỉ được tính tổng nếu tất cả các điều kiên tương ứng với ô đó đều đúng. 

Nếu thỏa các điều kiện, nó sẽ bằng 1, còn không, thì nó bằng 0. 

* Không giống như những đối số range và criteria của hàm SUMIF, trong hàm SUMIFS, mỗi vùng 

criteria_range phải có cùng kích thước và hình dạng giống như sum_range. 

* Có thể dùng các ký tự đại diện trong các điều kiện: dấu ? đại diện cho một ký tự, dấu * đại diện 

cho nhiều ký tự (nếu như điều kiện là tìm những dấu ? hoặc *, thì gõ thêm dấu ~ ở trước dấu ? hay 

*) 

* Khi điều kiện để đếm là những ký tự, SUMIFS() không phân biệt chữ thường hay chữ hoa. 

Hàm SUMSQ() 

Dùng để tính tổng các bình phương của các số 

Cú pháp: = SUMSQ(number1, number2, ...) 

number1, number2, ... : Có thể dùng đến 255 tham số (với Excel 2003 trở về trước, con số này chỉ 

là 30) 

Các tham số (number) có thể là một số, là một mảng, một tên, hay là một tham chiếu đến một ô 

chứa số, v.v... 

Ví dụ: SUMSQ(3, 4) = (3^2) + (4^2) = 9 + 16 = 25 

Ba hàm sau đây có cách dùng và cú pháp tương tự nhau: 

Hàm SUMX2MY2(), Hàm SUMXPY2() và Hàm SUMXMY2() 

Để dễ nhớ tên của ba hàm này, bạn đọc chúng từ trái sang phải với các quy ước sau: 

SUM = Tổng, M (Minus) = Trừ (hiệu số), P (Plus) = Cộng (tổng số), 2 = Bình phương, X và Y là 

hai mảng gì đó, có chứa nhiều phần tử x và y  

Vậy, định nghĩa và cách tính toán của 3 hàm này là: 

= SUMX2MY2: Tổng của hiệu hai bình phương của các phần tử tương ứng trong 2 mảng dữ liệu 

= SUMX2PY2: Tổng của tổng hai bình phương của các phần tử tương ứng trong 2 mảng dữ liệu 

= SUMXMY2: Tổng của bình phương của hiệu các phần tử tương ứng trong 2 mảng dữ liệu 

Cú pháp: 

= SUMX2MY2(array_x, array_y) 

= SUMX2PY2(array_x, array_y) 

= SUMXMY2(array_x, array_y) 
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array_x và array_y là các dãy ô hoặc giá trị kiểu mảng 

Lưu ý: 

* array_x và array_y bắt buộc phải có cùng kích thước, nếu không, hàm sẽ báo lỗi #NA! 

* Nếu trong array_x hoặc array_y có những giá trị kiểu text, kiểu logic hoặc rỗng, thì sẽ được bỏ 

qua (không tính), tuy nhiên các giá trị = 0 vẫn được tính. 

=TAN Tính tang của một góc  

=TANH Tính tang hyperbol của một số  

=TRUNC Cắt bớt phần thập phân của số  

Hàm SUMPRODUCT() Tính tổng các tích các phần tử tương ứng trong các mảng giá trị  

Sum = Tổng-Product = Tích 

SUMPRODUCT = Tổng của tích (các mảng dữ liệu)  

Cú pháp: = SUMPRODUCT(array1, array2, ...) 

array1, array2, ... : Có thể dùng từ 2 tới 255 mảng (với Excel 2003 trở về trước thì con số này chỉ 

là 30) và các mảng này phải cùng kích thước với nhau 

Lưu ý: 

* Nếu các mảng không cùng kích thước, SUMPRODUCT sẽ báo lỗi #VALUE! 

* Bất kỳ một phần tử nào trong mảng không phải là dữ liệu kiểu số, sẽ được SUMPRODUCT coi 

như bằng 0 (zero) 

Hàm SUBTOTAL là một hàm rất linh hoạt nhưng cũng là một trong các hàm hơi khó sử dụng của 

Excel. Điều khó hiểu thứ nhất chính là cái tên của nó, vì nó thực sự làm được nhiều thứ hơn ý 

nghĩa của tên hàm. Đối số thứ nhất của hàm bắt buộc bạn phải nhớ con số đại diện cho phép tính 

cần thực hiện trên tập số liệu (trong Excel 2010 có tính năng AutoComplete giúp chúng ta khỏi 

nhớ các con số này). Hàm SUBTOTAL được Microsoft nâng cấp kể từ phiên bản Excel 2003 với 

sự gia tăng các tuỳ chọn cho đối số thứ nhất của hàm, tuy nhiên điều này dẫn đến sự không tương 

thích với các phiên bản cũ nếu chúng ta sử dụng các tính năng mới bổ sung này. 

Đối số đầu tiên của của hàm SUBTOTAL xác định hàm thực sự nào sẽ được sử dụng khi tính toán 

(xem trong danh sách bên dưới). Ví dụ nếu đối số là 1 thì hàm SUBTOTAL hoạt động giống nhưng 

hàm AVERAGE, nếu đối số thứ nhất là 9 thì hàm hàm SUBTOTAL hoạt động giống nhưng hàm 

SUM. 



94 

Trung tâm Công nghệ thông tin và Truyền thông Nghệ An 

SUBTOTAL là hàm tính toán cho một nhóm con trong một danh sách hoặc bảng dữ liệu tuỳ theo 

phép tính mà bạn chọn lựa trong đối số thứ nhất. 

Cú pháp: = SUBTOTAL(function_num, ref1, ref2,...) 

Function_num: Các con số từ 1 đến 11 (hay 101 đến 111) qui định hàm nào sẽ được dùng để tính 

toán trong SUBTOTAL 

Ref1, ref2: Các vùng địa chỉ tham chiếu mà bạn muốn thực hiện phép tính trên đó. 

Trong Excel 2010, bạn có thể dùng đến 254 ref (với Excel 2003 trở vế trước thì con số này chỉ là 

29)  

Ghi chú: 

* Nếu có hàm SUBTOTAL khác đặt lồng trong các đối số ref1, ref2,... thì các hàm lồng này sẽ bị 

bỏ qua không được tính, nhằm tránh trường hợp tính toán 2 lần. 

* Đối số function_num nếu từ 1 đến 11 thì hàm SUBTOTAL tính toán bao gồm cả các giá trị ẩn 

trong tập số liệu (hàng ẩn). Đối số function_num nếu từ 101 đến 111 thì hàm SUBTOTAL chỉ tính 

toán cho các giá trị không ẩn trong tập số liệu (bỏ qua các giá trị ẩn). 

* Hàm SUBTOTAL sẽ bỏ qua không tính toán tất cả các hàng bị ẩn bởi lệnh Filter (Auto Filter) 

mà không phụ thuộc vào đối số function_num được dùng (1 giống 101...). 

* Hàm SUBTOTAL được thiết kế để tính toán cho các cột số liệu theo chiều dọc, nó không được 

thiết kế để tính theo chiều ngang. 

* Hàm này chỉ tính toán cho dữ liệu 2-D, do vậy nếu dữ liệu tham chiếu dạng 3-D (Ví dụ về tham 

chiếu 3-D: =SUM(Sheet2:Sheet13!B5) thì hàm SUBTOTAL báo lỗi #VALUE! 

Hàm SQRT() 

Dùng để tính căn bậc hai của một số 

Cú pháp: = SQRT(number) 

number: Số thực, dương (nếu number < 0 hàm sẽ báo lỗi #NUM!) 

Ví dụ: Giả sử ở ô A2, có con số -16 

SQRT(16) = 4 

SQRT(A2) = #NUM! 

SQRT(ABS(A2)) = 4 

Hàm SQRTPI() 
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Dùng để tính căn bậc hai của một số nhân với Pi (= 3.14159265358979) 

Cú pháp: = SQRTPI(number) 

number: Số thực, dương nhân với Pi (nếu number < 0 hàm sẽ báo lỗi #NUM!) 

Ví dụ: Giả sử ở ô A2, có con số -16 

SQRT(1) = 1.772454 (căn bậc hai của Pi) 

SQRT(2) = 2.506628 (căn bậc hai của 2*Pi) 

Hàm SIGN() 

Trả về dấu của số: 1 nếu là số dương, 0 (zero) nếu là số 0 và -1 nếu là số âm. 

Cú pháp: = SIGN(number) 

Ví dụ: 

SIGN(10) = 1 

SIGN(4-4) = 0 

SIGN(-0.057) = -1 

Hàm SERIESSUM() 

Dùng để tính tổng lũy thừa của một chuỗi số, theo công thức sau đây: 

series (x, n, m, a) = a1*x^n + a2*x^(n+m) + a3*x^(n+2m) + ... + ai*x^(n+(i-1)m) 

Cú pháp: = SERIESSUM(x, n, m, coefficients) 

x : giá trị nhập vào cho chuỗi lũy thừa 

n : lũy thừa khởi tạo để tăng tới x 

m : bước tăng cho mỗi phần tử trong chuỗi 

coefficients : tập hợp hệ số sẽ được nhân với mỗi lũy thừa của x 

Các thông số này phải là các dữ liệu kiểu số, nếu không, hàm sẽ báo lỗi #VALUE! 

Ví dụ: 

SERIESSUM(5, 0, 2, {1, 2, 3, 4}) = 64,426 

Diễn giải chi tiết: (x = 5, n = 0, m = 2, coefficients = 1, 2, 3, 4) 

=1*5^0 + 2*5^(0+2) + 3*5^(0+2*2) + 4*5^(0+3*2) = 64426 

HÀM THỐNG KÊ 
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Bao gồm các hàm số giúp bạn giải quyết các bài toán thống kê từ đơn giản đến phức tạp.  

=AVEDEV Tính bình quân độ phân cực  

=AVERAGE(vùng) Tính trung bình cộng các số.  

=AVERAGEA Tính trung bình cộng các giá trị  

=DAVERAGE (vùng dữ liệu, cột cần tính, vùng tiêu chuẩn) Hàm tính trung bình các giá trị trong 

cột thoả mãn điều kiện của vùng tiêu chuẩn trong vùng dữ liệu. 

Hàm AVERAGEIF() 

Trả về trung bình cộng (số học) của tất cả các ô được chọn thỏa mãn một điều kiện cho trước. 

Cú pháp: = AVERAGEIF(range, criteria, average_range) 

range : Là một hoặc nhiều ô cần tính trung bình, có thể bao gồm các con số, các tên vùng, các 

mảng hoặc các tham chiếu đến các giá trị... 

criteria : Là điều kiện dưới dạng một số, một biểu thức, địa chỉ ô hoặc chuỗi, để qui định việc tính 

trung bình cho những ô nào...  

average_range : Là tập hợp các ô thật sự được tính trung bình. Nếu bỏ trống thì Excel dùng range 

để tính.  

Lưu ý: 

* Các ô trong range nếu có chứa những giá trị luận lý (TRUE hoặc FALSE) thì sẽ được bỏ qua. 

* Những ô rỗng trong average_range cũng sẽ được bỏ qua. 

* Nếu range rỗng hoặc có chứa dữ liệu text, AVERAGEIF sẽ báo lỗi #DIV/0! 

* Nếu có một ô nào trong criteria rỗng, AVERAGEIF sẽ xem như nó bằng 0. 

* Nếu không có ô nào trong range thỏa mãn điều kiệu của criteria, AVERAGEIF sẽ báo lỗi 

#DIV/0! 

* Bạn có thể các ký tự đại diện như ?, * trong criteria (dấu ? thay cho một ký tự nào đó, và dấu * 

thay cho một chuỗi nào đó). Khi điều kiện trong criteria là chính các dấu ? hoặc *, thì bạn gõ thêm 

dấu ~ trước nó. 

* average_range không nhất thiết phải có cùng kích thước với range, mà các ô thực sự được tính 

trung bình sẽ dùng ô trên cùng bên trái của average_range làm ô bắt đầu, và bao gồm thêm những 

ô tương ứng với kích thước của range. 

Hàm AVERAGEIFS() 
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Trả về trung bình cộng (số học) của tất cả các ô được chọn thỏa mãn nhiều điều kiện cho trước. 

Cú pháp: = AVERAGEIFS(average_range, criteria_range1, criteria1, criteria_range2, criteria2, ...) 

average_range : Vùng cần tính trung bình, có thể bao gồm các con số, các tên vùng, các mảng hoặc 

các tham chiếu đến các giá trị... 

criteria_range1, criteria_range2, ... : Vùng chứa những điều kiện để tính trung bình. Có thể khai 

báo từ 1 đến 127 vùng. 

criteria1, criteria2, ... : Là các điều kiện để tính trung bình. Có thể khai báo từ 1 đến 127 điều kiện, 

dưới dạng số, biểu thức, tham chiếu hoặc chuỗi...  

Lưu ý: 

* Nếu average_range rỗng hoặc có chứa dữ liệu text, AVERAGEIFS sẽ báo lỗi #DIV/0! 

* Nếu có một ô nào trong những vùng criteria_range rỗng, AVERAGEIFS sẽ xem như nó bằng 0. 

* Những giá trị logic: TRUE sẽ được xem là 1, và FALSE sẽ được xem là 0. 

* Mỗi ô trong average_range chỉ được tính trung bình nếu thỏa tất cả điều kiện quy định cho ô đó 

* Không giống như AVERAGEIF(), mỗi vùng criteria_range phải có cùng kích thước với 

average_range 

* Nếu có một ô nào trong average_range không thể chuyển đổi sang dạng số, hoặc nếu không có 

ô nào thỏa tất cả các điều kiện, AVERAGEIFS sẽ báo lỗi #DIV/0! 

* Có thể các ký tự đại diện như ?, * cho các điều kiện (dấu ? thay cho một ký tự nào đó, và dấu * 

thay cho một chuỗi nào đó). Khi điều kiện trong criteria là chính các dấu ? hoặc *, thì bạn gõ thêm 

dấu ~ trước nó. 

Hàm COUNT() Đếm ô dữ liệu chứa số (đếm số ô không trống) - đếm số ô có trong vùng. Nhưng 

chỉ đếm những ô có kiểu dữ liệu là kiểu số. 

Cú pháp=COUNT(vùng)  

=COUNTA Đếm số ô chứa dữ liệu  

=COUNTIF(Vùng cần đếm, ô điều kiện) Hàm đếm có điều kiện - đếm số ô có trong vùng với điều 

kiện đã chỉ ra ở ô điều kiện. 

Hàm COUNTIF đếm ô có kiểu dữ liệu là kiểu số và cả kiểu ký tự. 

=DCOUNT(vùng dữ liệu, cột cần đếm, vùng tiêu chuẩn) Đếm số ô chứa lượng giá trị số trong cột 

thoả mãn đk trong vùng tiêu chuẩn tìm kiếm trong vùng dữ liệu. 

VD: Đếm xem có bao nhiêu người có mức lương là 500000. 
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=MAX(vùng) Tìm số lớn nhất trong vùng 

=MAXA Tìm giá trị lớn nhất  

Hàm DMAX() 

Cú pháp: = DMAX(database, field, criteria)=DMAX (vùng dữ liệu, cột giá trị, vùng tiêu chuẩn)  

Hàm tính giá trị cao nhất trong cột giá trị thoả mãn điều kiện của vùng tiêu chuẩn trong vùng dữ 

liệu. 

VD: Tìm xem những người 26 tuổi ai cao lương nhất. 

=MIN(vùng) Tìm số nhỏ nhất trong vùng 

=MINA Tìm giá trị nhỏ nhất  

Hàm DMIN() 

Cú pháp: =DMIN(database, field, criteria)=DMIN (vùng dữ liệu, cột giá trị, vùng tiêu chuẩn) 

Hàm tính giá trị nhỏ nhất trong cột giá trị thoả mãn điều kiện của vùng tiêu chuẩn trong vùng dữ 

liệu. 

VD: Tìm xem những người 26 tuổi ai thấp lương nhất. 

=RANK(ô cần xếp thứ, vùng cần so sánh) Tìm vị thứ của một số trong dãy số.  

Vùng cần so sánh: Thường để ở chế độ giá trị tuyệt đối: $ 

Hàm DVARP() 

Cú pháp: = DVARP(database, [field,] criteria) 

Tính toán sự biến thiên của một tập hợp dựa trên toàn thể tập hợp, bằng cách sử dụng các số liệu 

trong một cột của một danh sách hay của một cơ sở dữ liệu, theo một điều kiện được chỉ định. 

Hàm DVAR() 

Cú pháp: = DVAR(database, [field,] criteria) 

Ước lượng sự biến thiên của một tập hợp dựa trên một mẫu, bằng cách sử dụng các số liệu trong 

một cột của một danh sách hay của một cơ sở dữ liệu, theo một điều kiện được chỉ định. 

Hàm DSUM() 

Cú pháp: = DSUM(database, field, criteria) 

Cộng các số trong một cột của một danh sách hay của một cơ sở dữ liệu, theo một điều kiện được 

chỉ định. 
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Hàm DSTDEVP() 

Cú pháp: = DSTDEVP(database, field, criteria) 

Tính độ lệch chuẩn của một tập hợp theo toàn thể các tập hợp, bằng cách sử dụng các số liệu trong 

một cột của một danh sách hay của một cơ sở dữ liệu, theo một điều kiện được chỉ định. 

Hàm DSTDEV() 

Cú pháp: = DSTDEV(database, field, criteria) 

Ước lượng độ lệch chuẩn của một tập hợp theo mẫu, bằng cách sử dụng các số liệu trong một cột 

của một danh sách hay của một cơ sở dữ liệu, theo một điều kiện được chỉ định. 

Hàm DPRODUCT() 

Cú pháp: = DPRODUCT(database, field, criteria) 

Nhân các giá trị trong một cột của một danh sách hay của một cơ sở dữ liệu, theo một điều kiện 

được chỉ định. 

Đếm số ô rỗng trong bảng tính 

Dùng công thức mảng: {=SUM(IF(ISBLANK(range), 1, 0))} với range là vùng dữ liệu cần kiểm 

tra. 

Đếm số ô chứa những giá trị không phải là kiểu số 

Dùng công thức mảng: {=SUM(IF(ISNUMBER(range), 0, 1))} với range là vùng dữ liệu cần kiểm 

tra. 

Đếm số ô bị lỗi 

Dùng công thức mảng: {=SUM(IF(ISERROR(range), 1, 0))} với range là vùng dữ liệu cần kiểm 

tra. 

g. HÀM XỬ LÝ VĂN BẢN VÀ DỮ LIỆU 

Bao gồm các hàm xử lý chuỗi văn bản như trích lọc, tìm kiếm, thay thế, chuyển đổi chuỗi văn bản 

trong Excel. 

Hàm ASC() 

Dùng để đổi các ký tự double-byte sang các ký tự single-byte cho những ngôn ngữ sử dụng bộ ký 

tự double-byte. 

Cú pháp: = ASC(text) 
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text : Là chữ hoặc tham chiếu đến một ô có chứa chữ. Nếu text không chứa bất kỳ mẫu tự nào 

thuộc loại double-byte, thì text sẽ không được chuyển đổi.  

Ví dụ: = ASC("Excel") = Excel 

=CHAR Chuyển số thành ký tự  

=CLEAN Xóa ký tự không phù hợp  

=CODE Trả về mã số của ký tự đầu tiên  

Hàm CONCATENATE 

Công dụng: Dùng nối nhiều chuỗi lại với nhau 

Công thức: =CONCATENATE(text1,text2,...) 

Ví dụ: =CONCATENATE("Giải pháp", "Excel", " - ", "Công cụ tuyệt vời của bạn) → Giải pháp 

Excel - Công cụ tuyệt vời của bạn 

=DOLLAR Chuyển định dạng số thành tiền tệ 

Hàm EXACT 

Công dụng: Dùng để so sánh hai chuỗi với nhau. 

Công thức: =EXACT(text1,text2) 

Hàm EXACT phân biệt chữ thường và chữ hoa. 

Nếu 2 chuỗi text1, text2 giống nhau hoàn toàn, hàm sẽ trả về TRUE; nếu không, sẽ trả về trị 

FALSE 

Ví dụ: 

=EXACT("Giải pháp", "Giải pháp") → TRUE 

=EXACT("Giải pháp", "Giải Pháp") → FALSE 

=FIXED Chuyển một số sang định dạng văn bản  

=LEFT(X,n) Hàm LEFT lấy n ký tự từ bên trái sang của văn bản X  

=LEN Tính độ dài một chuỗi  

=LOWER Chuyển thành chữ thường.  

=PROPER Chuyển ký tự đầu mỗi từ thành chữ hoa 

Hàm MID Dùng để trích xuất một chuỗi con (substring) từ một chuỗi 

Công thức: =MID(text, start_num, num_chars])=MID(X, m, n)  
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Hàm MID lấy n ký tự trong chuỗi X bắt đầu từ vị trí m. 

text: chuỗi văn bản cần trích xuất 

start_num: vị trí bắt đầu trích ra chuỗi con, tính từ bên trái sang 

num_chars: số ký tự của chuỗi con cần trích ra 

- num_chars phải là số nguyên dương 

- start_num phải là số nguyên dương 

- Nếu start_num lớn hơn độ dài của chuỗi thì kết quả trả về sẽ là chuỗi rỗng 

Ví dụ: =MID("Karen Elizabeth Hammond", 7, 9) → Elizabeth 

Hàm REPLACE 

Công dụng: Dùng để thay thế một phần của chuỗi bằng một chuỗi khác, dựa vào số ký tự được chỉ 

định 

Công thức: =REPLACE(old_text, start_num, num_chars, new_text) 

old_text: chuỗi văn bản cần được xử lý 

start_num: vị trí bắt đầu tìm cái sẽ thay thế, tính từ bên trái sang 

num_chars: số ký tự của chuỗi cần được thay thế 

new_text: chuỗi văn bản sẽ thay thế cho số ký tự đã chọn bởi start_num và num_chars 

Cái khó của hàm này là xác định được bởi start_num và num_chars. Làm sao biết được bắt đầu từ 

đâu và thay thế bao nhiêu chữ? Tôi gợi ý nhé: 

- Bạn dùng hàm FIND() hoặc SEARCH() để xác định vị trí bắt đầu (start_num) 

- Dùng hàm LEN() để xác định số ký tự của chuỗi sẽ được thay thế (num_chars) 

Ví dụ: đế thay số 2007 bằng 2008 trong câu Expense Budget for 2007 

Dùng công thức như sau: 

=REPLACE(A1, FIND("2007", A1), LEN("2007"), "2008")→ Expense Budget for 2008 

Với A1 = Expense Budget for 2007 

Hàm RIGHT Dùng để trích xuất phần bên phải của một chuỗi một hoặc nhiều ký tự tùy theo sự 

chỉ định của bạn 

Công thức: =RIGHT(text [,num_chars])=RIGHT(X,n)  

Hàm RIGHT lấy n ký tự từ bên phải sang của văn bản X 
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text: chuỗi văn bản cần trích xuất ký tự 

num_chars: số ký tự cần trích ra phía bên phải của chuỗi text, mặc định là 1 

- num_chars phải là số nguyên dương 

- Nếu num_chars lớn hơn độ dài của chuỗi thì kết quả trả về sẽ là toàn bộ chuỗi text 

Ví dụ: =RIGHT("Karen Elizabeth Hammond", 7) → Hammond 

=REPT Lặp lại một chuỗi  

=SUBSTITUTE Thay thế một chuỗi xác định  

Hàm FIND và Hàm SEARCH 

Công dụng: Dùng để tìm vị trí bắt đầu của một chuỗi con (substring) trong một chuỗi 

Công thức: 

=FIND(find_text, within_text [, start_num]) 

=SEARCH(find_text, within_text [, start_num]) 

find_text: chuỗi văn bản cần tìm (chuỗi con) 

within_text: chuỗi văn bản chứa chuỗi cần tìm (chuỗi mẹ) 

start_num: vị trí bắt đầu tìm trong chuỗi within_text (mặc định là 1) 

Một số lưu ý: 

- Kết quả của hai hàm này là một con số, chỉ vị trí bắt đầu (tính từ start_num) của find_text trong 

within_text 

- Dùng SEARCH() khi muốn tìm một chuỗi bất kỳ. Ví dụ: SEARCH("e", "Expenses") sẽ cho kết 

quả là 1. 

- Dùng FIND() khi muốn tìm chính xác một chuỗi có phân biệt chữ hoa, chữ thường. Ví dụ: 

FIND("e", "Expenses") sẽ cho kết quả là 4. 

- Nếu không tìm thấy find_text, hàm sẽ báo lỗi #VALUE 

- Có thể dùng những ký tự đại diện như *, ? trong find_text của hàm SEARCH() 

- Với hàm SEARCH(), nếu muốn tìm chính ký tự * hoặc ? thì gõ dấu ~ trước ký tự đó ( ~* hoặc 

là ~?) 

=TEXT Chuyển một số sang text.  

Hàm T 
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Công dụng: Trả về một chuỗi nếu trị tham chiếu là chuỗi, ngược lại, sẽ trả về chuỗi rỗng - Kiểm 

tra dữ liệu kiểu text 

Công thức: =T(value) 

Hàm này ít khi được dùng. 

Hàm SUBSTITUTE 

Công dụng: Dùng để thay thế một chuỗi này bằng một chuỗi khác. Hàm này cũng tương tự hàm 

REPLACE(), nhưng dễ sử dụng hơn. 

Công thức: =SUBSTITUTE(text, old_text, new_text [,instance_num]) 

text: chuỗi văn bản gốc, cần được xử lý 

old_text: chuỗi văn bản cần được thay thế 

new_text: chuỗi văn bản sẽ thay thế vào 

instance_num: số lần thay thế old_text bằng new_text, nếu bỏ qua thì tất cả old_text tìm được sẽ 

được thay thế bằng new_text 

Ví dụ: đế thay số 2007 bằng 2008 trong câu Expense Budget for 2007 

Dùng công thức như sau: 

=SUBSTITUTE("Expense Budget for 2007", "2007", "2008") → Expense Budget for 2008 

HÀM THAY THẾ CHUỖI NÀY BẰNG CHUỖI KHÁC (Substituting One Substring for Another) 

Có nhiều chương trình có khả năng tìm kiếm một số đoạn văn và thay thế nó bằng đoạn văn khác. 

Excel cũng có khả năng làm chuyện đó bằng cách dùng hàm. Đó là hàm REPLACE và hàm 

SUBSTITUTE. 

=TRIM Xóa những ký tự trắng bên trong chuỗi.  

=UPPER Chuyển ký tự thường thành hoa.  

Hàm VALUE 

Công dụng: Dùng để đổi một chuỗi đại diện cho một số thành kiểu số 

Công thức: =VALUE(text) 

text phải là định dạng số, ngày tháng hoặc bất kỳ một thời gian nào miễn là được Excel công nhận. 

Nếu 2 chuỗi text1, text2 giống nhau hoàn toàn, hàm sẽ trả về TRUE; nếu không, sẽ trả về trị 

FALSE 
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Ví dụ: 

Để trích ra số 6500 trong SQA6500, bạn có thể dùng hàm RIGHT() 

=RIGHT("SQA6500", 4) → 6500 

Tuy nhiên kết quả do hàm RIGHT() có được sẽ ở dạng text, bạn không thể nhân chia cộng trừ gì 

với cái "6500" này được. 

Để có thể tính toán với "6500", bạn phải đổi nó sang dạng số: 

=VALUE(RIGHT("SQA6500",4)) → 6500 

Cũng là 6500, nhưng bây giờ bạn có thể cộng trừ nhân chia với nó. 

*Trích xuất họ và tên (ví dụ dùng để trích cho tên tiếng Anh, bỏ qua tên đệm) 

Cách làm là dùng hàm FIND() để tìm những khoảng trắng phân cách giữa họ và tên, sau đó dùng 

hàm LEFT() để tách phần tên, và hàm RIGHT() để tách phần họ. 

Để lấy phần tên (First Name), chúng ta dùng công thức sau (giả sử họ tên nằm ở cell A2): 

=LEFT(A2, FIND(" ", A2) - 1) 

Nghĩa là dùng hàm FIND() để tìm vị trí của ký tự trắng đầu tiên kể từ bên trái, ví dụ nó là vị trí 

thứ 5, 

khi đó hàm LEFT() sẽ xác định được cái tên này gồm có 4 chữ (= 5-1). 

Để lấy phần họ (Last Name), chúng ta dùng công thức: 

=RIGHT(A2, LEN(A2) - FIND(" ", A2)) 

Bạn tự dịch câu này nhé! 

*Trích xuất họ, tên đệm và tên (ví dụ với tên tiếng Anh, phần tên đệm được viết tắt) 

Cách làm giống như bài Trích xuất họ và tên ở trên, tuy nhiên có khác một chút, để trích thêm 

phần tên đệm. 

Giả sử Họ và Tên (full name) nằm ở cell A2, và đang có giá trị là Karen E. Hammond 

Đầu tiên, như bài trên, dùng công thức sau để tách phần Tên (first name): 

=LEFT(A2, FIND(" ", A2) - 1) → Karen  

Công thức FIND(" ", A2) sẽ cho kết quả là 6, là vị trí của khoảng trắng đầu tiên (sau chữ Karen). 

Để tìm vị trí của khoảng trắng thứ hai, thì bạn phải gán vị trí bắt đầu tìm (start_num) là 7, hoặc là 

bằng kết quả của FIND(" ", A2) cộng thêm 1: 
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=FIND(" ", A2, FIND(" ",A2) + 1) 

Rồi dùng kết quả của công thức này làm tham số cho hàm RIGHT() để trích ra phần Họ (last 

name): 

=RIGHT(A2, LEN(A2) - FIND(" ", A2, FIND(" ", A2) +1)) → Hammond  

Để trích phần tên đệm, dùng hàm FIND() để tìm vị trí của dấu chấm (.) rồi đưa vào trong công 

thức của hàm MID() để tìm ký tự đứng trước dấu chấm: 

=MID(A2, FIND(".", A2) - 1, 1) → E  

HÀM LOGIC 

Hàm AND 

Có lẽ khỏi giải thích nhỉ. AND có nghĩa là VÀ. Vậy thôi. Dùng hàm này khi muốn nói đến cái này 

và cái này và cái này...... 

Cú pháp: AND(logical1 [, logical2] [, logical3]...) 

logical: Những biểu thức sẽ được xét xem đúng (TRUE) hay sai (FALSE) 

Nếu tất cả các biểu thức đều đúng, hàm AND() sẽ trả về giá trị TRUE, và chỉ cần 1 trong các biểu 

thức sai, hàm AND() sẽ trả về giá trị FALSE. 

Bạn có thể dùng hàm AND() bất cứ chỗ nào bạn muốn, nhưng thường thì hàm AND() hay được 

dùng chung với hàm IF(). 

Ví dụ: 

=IF(AND(B2 > 0, C2 > 0), "1000", "No bonus") 

Nếu giá trị ở B2 và ở C2 lớn hơn 0, thì (thưởng) 1.000, còn nếu chỉ cần một trong 2 ô B2 hoặc C2 

nhỏ hơn 0, thì không thưởng chi cả. 

=FALSE(): Có thể nhập trực tiếp FALSE vào trong công thức, Excel sẽ hiểu đó là một biểu thức 

có giá trị FALSE mà không cần dùng đến cú pháp của hàm này 

Hàm IF 

=IF (logical_test, value_if_true, value_if_false) : Dùng để kiểm tra điều kiện theo giá trị và công 

thức 

Cú pháp: IF (điều kiện, giá trị 1, giá trị 2) Nếu điều kiện đúng thì hàm trả về giá trị 1, ngược lại 

hàm nhận giá trị 2 

Cái lập luận: "Nếu tôi đúng thì làm cho tôi cái này, nếu tôi sai thì làm cho tôi cái kia".. Có lẽ trong 

chúng ta ai cũng hiểu. 
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Một tình huống đơn giản nhất 

Cú pháp: IF(logical_test, value_is_true) 

logical_test: Một biểu thức sẽ được xét xem đúng (TRUE) hay sai (FALSE) 

value_is_true: giá trị trả về khi biểu thức logical_test được kiểm tra là đúng (TRUE) 

Ví dụ: 

=IF(A1 >= 1000, "It's big!") 

Nghĩa là, nếu giá trị ở A1 lớn hơn hoặc bằng 1000, thì kết quả nhận được sẽ là "It's big!", còn 

không, nếu A1 nhỏ hơn 1000, kết quả sẽ là FALSE. 

Một ví dụ khác, giả sử bạn có một bảng đánh giá mức độ bán ra, mua vào của một danh mục hàng 

hóa dài, và bạn muốn theo dõi những mặt hàng có doanh số bán ra không đạt yêu cầu để điều chỉnh 

chiến lược kinh doanh của mình, bằng cách gán những dấu "<" bên cạnh nó, hễ phần trăm doanh 

số càng thấp thì những dấu hiệu "<" càng nhiều... 

Bạn có thể dùng hàm IF(), theo mẫu: 

=IF(cell<0, flag) 

Với cell là giá trị doanh số mà bạn muốn theo dõi, và flag là dấu hiệu để mô tả, ví dụ, cell chứa 

giá trị doanh số là B2: 

=IF(B2<0, "<<<<<") 

Để những dấu "<" tỷ lệ thuận với mức sụt giảm doanh số bán hàng, bạn có thể dùng hàm REPT(), 

với công thức: 

REPT("<" , B2 * -100) 

Ở đây, phải nhân giá trị của B2 với -100, bởi vì chúng ta chỉ xét những trường hợp B2<0 

Và công thức hoàn chỉnh để thể hiện mức độ sụt giảm doanh số của từng mặt hàng sẽ là: 

=IF(B2<0, REPT("<" , B2 * -100)) 

Những hàm IF lồng nhau 

Trong cuộc sống đời thường, có mấy ai dễ dàng chấp nhận chuyện "một cái nếu", phải không các 

bạn. 

Chúng ta thường sẽ dùng kiểu, nếu... rồi nhưng mà nếu... nhiều khi kéo dài đến vô tận! 

Trong Excel cũng vậy. Giả sử, chúng ta xếp loại học tập, nếu điểm trung bình (ĐTB) lớn hơn 9 thì 

giỏi, vậy ĐTB nhỏ hơn 9 thì dở? Chưa, ĐTB nhỏ hơn 9 nhưng lớn hơn 7 thì khá cái đã, rồi ĐTB 
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nhỏ hơn 7 nhưng chưa bị điểm 5 thì trung bình, chỉ khi nào ĐTB nhỏ hơn 4 thì mới gọi là dở (cái 

này tôi chỉ ví dụ thôi, các bạn đừng sử dụng để xếp loại nhé). 

Khi đó, chúng ta sẽ dùng những hàm IF() lồng nhau, IF() này nằm trong IF() kia. Sau này chúng 

ta sẽ học cách ghép thêm nhiều điều kiện khác vào nữa. 

Ví dụ, tôi lấy lại ví dụ đã nói ở bài trước: 

=IF(A1 >= 1000, "Big!", "Not big") 

Bi giờ thêm chút, A1 lớn hơn 1000 là "big" rồi, nhưng chẳng lẽ 10000 thì cũng chỉ là "big" ? Có 

lẽ nên tặng thêm một danh hiệu cao hơn: 

=IF(A1 >= 1000, IF(A1 >= 10000, "Really big!!", Big!"), "Not big") 

Hoặc là, đồng ý rằng <1000 là "Not big", nhưng nó khác "Small" chứ (tui không lớn, chưa chắc 

tui nhỏ), vậy chúng ta thêm một định nghĩa "Small" thử xem: 

=IF(A1 >= 1000, "Big!", IF(A1 < 100, "Small", "Not big")) 

Bạn để ý nhé, ở đây tôi đặt cái IF "con" không giống như ở trên, sao cũng, miễn là đừng sai cú 

pháp của IF(). 

Và nếu thích, bạn có thể ghép tất cả lại: 

=IF(A1 >= 1000, IF(A1 >= 10000, "Really big!!", Big!"), IF(A1 < 100, "Small", "Not big")) 

Chĩ cần một lưu ý, là những dấu đóng mở ngoặc đơn. Nếu bạn đóng và mở không đúng lúc hoặc 

không đủ, Excel sẽ không hiểu, hoặc là cho các bạn kết quả sai đấy. 

Hàm IFERROR 

Trong quá trình thao tác với bảng tính, không ít lần chúng ta gặp lỗi, và cũng khó mà tránh được 

lỗi. Ví dụ, một công thức đơn giản thôi =A/B có thể gây lỗi #DIV/0! nếu như B bằng 0, hoặc gây 

lỗi #NAME? nếu A hoặc B không tồn tại, gây lỗi #REF! nếu có ô nào đó liên kết với A hoặc B bị 

xóa đi... 

Tuy nhiên, đôi lúc chúng ta lại cần phải lợi dụng chính những cái lỗi này, ví dụ sẽ đặt ra một tình 

huống: nếu có lỗi thì làm gì đó... Gọi nôm na là BẪY LỖI. 

Có lẽ vì vậy mà hàm này có hai chữ đầu là IF; IFERROR = nếu xảy ra lỗi (thì)... 

MS Excel 2003 trở về trước có hàm ISERROR(value), với value là một biểu thức. Nếu biểu thức 

này gặp lỗi, ISERROR() sẽ trả về giá trị TRUE, còn nếu biểu thức không có lỗi, ISERROR() trả 

về giá trị FALSE. 

Và chúng ta thường dùng ISERROR() kèm với IF: 
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=IF(ISERROR(expression), ErrorResult, expression) 

Nếu như biểu thức (expression) có lỗi, công thức trên sẽ lấy giá trị ErrorResult (một ô rỗng, hoặc 

một thông báo lỗi, v.v..), ngược lại, sẽ lấy chính giá trị biểu thức đó. 

Ví dụ: =IF(ISERROR(A/B), "", A/B) 

Cái bất tiện khi phải dùng vừa IF() vửa ISERROR() là chúng ta phải nhập cái biểu thức hai lần: 

một lần trong hàm ISERROR() và một lần ở tham số value_is_False của IF() 

Có thể cái bất tiện vừa nói trên không đáng kể, tuy nhiên cách sử dụng này làm cho công thức của 

chúng ta trở nên khó dùng hơn, 

bởi vì nếu thay cái biểu thức(expression), thì chúng ta phải thay đổi nguyên cả công thức. 

Excel 2010 dường như hiểu được sự bất tiện đó, nên đã gộp hai hàm IF() và ISERROR lại thành 

một, đó là IFERROR() 

Cú pháp: IFERROR(value, value_if_error) 

_____value: Biểu thức có thể sẽ gây ra lỗi 

_____value_if_error: kết quả trả về nếu value gây ra lỗi 

Nếu biểu thức value không gây lỗi, IFERROR() sẽ lấy biểu thức đó, còn nếu nó có lỗi thì lấy cái 

biểu thức value_if_error. 

Ví dụ, công thức =IF(ISERROR(A/B), "", A/B) nếu dùng IFERROR() thì sẽ là 

=IFERROR(A/B, "") 

Bạn thấy đấy, IFERROR() ngắn gọn và dễ hiểu hơn nhiều. 

=NOT (logical) : Đảo ngược giá trị của các đối số 

Hàm OR 

OR có nghĩa là HOẶC. Dùng hàm này khi muốn nói đến cái này hoặc cái này hay cái kia... cái 

nào cũng được, miễn là phải có ít nhất 1 cái! 

Cú pháp: OR(logical1 [, logical2] [, logical3]...) 

logical: Những biểu thức sẽ được xét xem đúng (TRUE) hay sai (FALSE) 

Nếu tất cả các biểu thức đều sai, hàm OR() sẽ trả về giá trị FALSE, và chỉ cần 1 trong các biểu 

thức đúng, hàm OR() sẽ trả về giá trị TRUE. 

Giống như hàm AND(), bạn có thể dùng hàm OR() bất cứ chỗ nào bạn muốn, nhưng thường thì 

hàm OR() hay được dùng chung với hàm IF(). 
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Ví dụ: 

=IF(OR(B2 > 0, C2 > 0), "1000", "No bonus") 

Nếu giá trị ở B2 hoặc ở C2 lớn hơn 0 (tức là chỉ cần 1 trong 2 ô lớn hơn 0), thì (thưởng) 1.000, 

còn nếu cả 2 ô B2 hoặc C2 đều nhỏ hơn 0, thì không thưởng chi cả. 

=TRUE(): Có thể nhập trực tiếp TRUE vào trong công thức, Excel sẽ hiểu đó là một biểu thức có 

giá trị TRUE mà không cần dùng đến cú pháp của hàm này 

Bỏ qua những ô bị lỗi khi chạy công thức 

Ví dụ: Cột Gross Margin (cột D) của bảng tính dưới đây có chứa một số ô gặp lỗi chia cho 0 

(#DIV/0!), do bên cột C có những ô trống. 

Để tính trung bình cộng của cột D, kể những ô có lỗi #DIV/0!, phải dùng công thức mảng như sau: 

{=AVERAGE(IF(ISERROR(D3:D12), "", D3:D12))} 

(nghĩa là nếu gặp những ô có lỗi thì coi như nó bằng rỗng) 

Xác định tên của cột (Determining the Column Letter) 

Trong Excel có hàm COLUMN(), cho ra kết quả là số của cột (ví dụ, gõ hàm này trong cột B thì 

kết quả sẽ là 2). 

Nhưng đôi khi bạn muốn kết quả là tên của cột chứ không muốn đó là con số (B chứ không phải 

là 2), thì làm sao? 

Đây là một vấn đề đòi hỏi sự khôn khéo một chút, vì tên cột trong bảng tính chạy từ A đến Z, từ 

AA đến AZ... và cho tới tận cùng là XFD (!) 

Có một hàm giúp chúng ta tìm địa chỉ tuyệt đối của một cell, đó là hàm CELL("address"), ví dụ 

$A$2, hoặc $B$10... 

Hàm CELL(info_type [,reference]) 

Với info_type là một tham số đã được định nghĩa (sẽ nói kỹ hơn trong những bài sau) 

Và reference là cell mà bạn chỉ định, nếu bỏ trống thì Excel sẽ lấy ngay cái cell có chứa công thức 

CELL(). 

Trong bài này, để tìm địa chỉ tuyệt đối của một cell, chúng ta sẽ dùng công thức CELL() với 

info_type là "address" 

Tinh ý một chút, ta thấy tên của cột chính là những chữ cái nằm giữa hai dấu dollar ($) trong cái 

địa chỉ tuyệt đối này. 

Bắt đầu làm nhé: dùng hàm MID() trích ra chữ cái từ vị trí thứ 2 trong địa chỉ tuyệt đối của cell: 
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=MID(CELL("Address"), 2, num_chars) 

Cái khó là cái num_chars này đây, vì tên cột thì có thể là 1, 2, hoặc 3 ký tự (ví dụ: A, AA hoặc 

AAA). Vận dụng hàm FIND thôi: 

FIND("$", CELL("address"",A2), 3) - 2 

Giải thích chút nhé: Dùng hàm FIND(), tìm vị trí của dấu $ trong cái địa chỉ tuyệt đối của cell, và 

bắt đầu tìm từ vị trí thứ 3 trong cái địa chỉ này. 

Tại sao phải trừ đi 2? Công thức trên sẽ chỉ ra vị trí (là một con số) của dấu $ thứ hai trong địa chỉ 

tuyệt đối của cell, tức là cái dấu $ phía sau tên cột, 

phải trừ đi 2 tức là trừ bớt đi 2 cái $, lúc này kết quả sẽ chính là số ký tự của tên cột (1 chữ, 2 chữ 

hoặc 3 chữ) 

Bây giờ, công thức hoàn chỉnh sẽ như sau: 

=MID(CELL("Address"), 2, FIND("$", CELL("address"), 3) - 2) 

Công thức này áp dụng cho chính cell chứa công thức. 

Nếu muốn tìm tên cột tại một cell nào đó, bạn chỉ việc thêm địa chỉ (hoặc một cái gì đó tham chiếu 

đến địa chỉ này) của cell muốn tìm vào phía sau cái "address" 

Ví dụ, muốn tìm tên của cell AGH68, bạn gõ: 

=MID(CELL("Address", AGH68), 2, FIND("$", CELL("address", AGH68), 3) - 2) → AGH 

Lập mã số tự động 

Có nhiều danh mục khách hàng hoặc danh mục hàng hóa được lập mã số bằng cách dùng vài ký 

tự đầu của tên khách hàng (hoặc tên hàng hóa) kết hợp với một con số. 

Cách đặt mã số tự động như vậy rất dễ làm trong Excel, bằng cách sử dụng những hàm xử lý văn 

bản và chuỗi. 

Giả sử danh mục của chúng ta nằm ở cột A và bắt đầu tại cell A2. 

Trước tiên, chúng ta hãy tách 3 ký tự đầu tiên của danh mục và định dạng cho nó thành những chữ 

in hoa, bằng công thức: 

UPPER(LEFT(A2, 3)) 

Tiếp theo, tận dụng chính số của những hàng trong bảng tính để lập mã số tự động: ROW(A2), 

và định dạng sao cho những con số này luôn có 4 chữ số, bằng công thức: 

TEXT(ROW(A2),"0000") 
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Và đây là công thức hoàn chỉnh: 

=UPPER(LEFT(A2, 3)) & TEXT(ROW(A2), "0000") 

Hàm BETADIST() 

Trả về giá trị của hàm tính mật độ phân phối xác suất tích lũy beta. 

Thông thường hàm này được dùng để nghiên cứu sự biến thiên về phần trăm các mẫu, ví dụ như 

khoảng thời gian mà người ta dùng để xem TV trong một ngày chẳng hạn. 

Cú pháp: = BETADIST(x, alpha, beta, A, B) 

x : Giá trị giữa A và B, dùng để tính mật độ hàm. 

alpha & beta : Tham số của phân phối. 

A : Cận dưới của khoảng x, mặc định là 0. 

B : Cận trên của khoảng x, mặc định là 1. 

Lưu ý: 

* Nếu có bất kỳ đối số nào không phải là số, BETADIST() trả về giá trị lỗi #VALUE! 

* Nếu alpha ≤ 0 hay beta ≤ 0, BETADIST() trả về giá trị lỗi #NUM! 

* Nếu x < A, x > B hay A = B, BETADIST() trả về giá trị lỗi #NUM! 

* Nếu bỏ qua A và B, nghĩa là mặc định A = 0 và B = 1, BETADIST() sẽ sử dụng phân phối tích 

lũy beta chuẩn hóa. 

Hàm BETAINV() 

Trả về nghịch đảo của hàm tính mật độ phân phối xác suất tích lũy beta. 

Nghĩa là nếu xác suất = BETADIST(x, ...) thì x = BETAINV(xác suất, ...) 

Thường dùng trong việc lên kế hoạch dự án, để mô phỏng số lần mở rộng xác suất, biết trước thời 

gian bổ sung kỳ vọng và độ biến đổi. 

Cú pháp: = BETAINV(probability, alpha, beta, A, B) 

Probability : Xác suất của biến cố x trong phân phối xác suất tích lũy beta. 

alpha & beta : Tham số của phân phối. 

A : Cận dưới của khoảng x, mặc định là 0. 

B : Cận trên của khoảng x, mặc định là 1. 

Lưu ý: 
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* Nếu có bất kỳ đối số nào không phải là số, BETAINV() trả về giá trị lỗi #VALUE! 

* Nếu alpha ≤ 0 hay beta ≤ 0, BETAINV() trả về giá trị lỗi #NUM! 

* Nếu probability ≤ 0 hay probability > 1, BETAINV() trả về giá trị lỗi #NUM! 

* Nếu bỏ qua A và B, nghĩa là mặc định A = 0 và B = 1, BETAINV() sẽ sử dụng phân phối tích 

lũy beta chuẩn hóa. 

* BETAINV() sử dụng phương pháp lặp khi tính mật độ phân phối. Với probability cho trước, 

BETAINV() lặp cho tới khi kết quả chính xác trong khoảng ±0.0000003. Nếu BETAINV() không 

hội tụ sau 100 lần lặp, nó sẽ trả về giá trị lỗi #NA! 

Ví dụ: 

BETAINV(0.6854706, 8, 10, 1, 3) = 2 

Hàm BINOMDIST() 

Trả về xác suất của những lần thử thành công của phân phối nhị phân. 

BINOMDIST() thường được dùng trong các bài toán có số lượng cố định các phép thử, khi kết 

quả của các phép thử chỉ là thành công hay thất bại, khi các phép thử là độc lập, và khi xác xuất 

thành công là không đổi qua các cuộc thử nghiệm. 

Ví dụ, có thể dùng BINOMDIST() để tính xác suất khoảng hai phần ba đứa trẻ được sinh ra là bé 

trai. 

Cú pháp: = BINOMDIST(number_s, trials, probability_s, cumulative) 

Number_s : Số lần thử thành công trong các phép thử. 

Trials : Số lần thử. 

Probability_s : Xác suất thành công của mỗi phép thử. 

Cumulative : Một giá trị logic để xác định hàm tính xác suất. 

= 1 (TRUE) : BINOMDIST() trả về hàm tính xác suất tích lũy, là xác suất có số lần thành công 

number_s lớn nhất. 

= 0 (FALSE) : BINOMDIST() trả về hàm tính xác suất điểm (hay là hàm khối lượng xác suất), là 

xác suất mà số lần thành công là number_s. 

Lưu ý: 

* Nếu number_s và trials là số thập phân, chúng sẽ được cắt bỏ phần lẻ để trở thành số nguyên. 
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* Nếu number_s, trials hay probability_s không phải là số, BINOMDIST() trả về giá trị lỗi 

#VALUE! 

* Nếu number_s < 0 hay number_s > trials, BINOMDIST() trả về giá trị lỗi #NUM! 

* Nếu probability_s < 0 hay probability_s > 1, BINOMDIST() trả về giá trị lỗi #NUM! 

Ví dụ: 

BINOMDIST(6, 10, 0.5, 0) = 0.2050781 

BINOMDIST(6, 10, 0.5, 1) = 0.828125 

Hàm CHIDIST() 

Trả về xác xuất một phía của phân phối chi-squared. 

Phân phối chi-squared kết hợp với phép thử chi-squared dùng để so sánh các giá trị quan sát với 

các giá trị kỳ vọng. 

Ví dụ, một thí nghiệm về di truyền có thể giả thiết rằng thế hệ kế tiếp của các cây trồng sẽ thừa 

hưởng một tập hợp các màu sắc nào đó; bằng cách so sánh các giá trị quan sát được với các giá trị 

kỳ vọng, có thể thấy được giả thiết ban đầu là đúng hay sai. 

Cú pháp: = CHIDIST(x, degrees_freedom) 

x : Giá trị dùng để tính phân phối. 

degrees_freedom : Số bậc tự do. 

Lưu ý: 

* Nếu các đối số không phải là số, CHIDIST() trả về giá trị lỗi #VALUE! 

* Nếu x < 0, CHIDIST() trả về giá trị lỗi #NUM! 

* Nếu degrees_freedom không phải là số nguyên, phần thập phân của nó sẽ bị cắt bỏ để trở thành 

số nguyên. 

* Nếu degrees_freedom < 1 hay degrees_freedom > 10^10, CHIDIST() trả về giá trị lỗi #NUM! 

* CHIDIST() được tính toán theo công thức: CHIDIST = P(X > x), với X là biến ngẫu nhiên chi-

squared. 

Ví dụ: 

CHIDIST(18.307, 10) = 0.050001 

Hàm NORMINV() 

Trả về nghịch đảo của phân phối tích lũy chuẩn. 



114 

Trung tâm Công nghệ thông tin và Truyền thông Nghệ An 

Cú pháp: = NORMINV(probability, mean, standard_dev) 

probability : Xác suất ứng với phân phối chuẩn 

mean : Giá trị trung bình cộng của phân phối 

standard_dev : Độ lệch chuẩn của phân phối 

Lưu ý: 

* Nếu có bất kỳ đối số nào không phải là số, NORMINV() sẽ báo lỗi #VALUE! 

* Nếu probability nhỏ hơn 0 hoặc lớn hơn 1, NORMINV() sẽ báo lỗi #NUM! 

* Nếu standard_dev nhỏ hơn hoặc bằng 0, NORMDINV() sẽ báo lỗi #NUM! 

* Nếu mean = 0 và standard_dev = 1, NORMINV() sẽ dùng phân bố chuẩn. 

* NORMINV() sử dụng phương pháp lặp đi lặp lại để tính hàm. Nếu NORMINV() không hội tụ 

sau 100 lần lặp, hàm sẽ báo lỗi #NA! 

Chương 4: Khai Thác Cơ Sở Dữ Liệu 

4.1. Sort (sắp xếp) và Filter (lọc) 

Sort (sắp xếp) và Filter (lọc) là những tính năng cho phép bạn thao tác dữ liệu trong một bảng 

tính được thiết lập dựa trên các tiêu chuẩn. 

Sắp xếp 

Để thực hiện một sắp xếp theo chiều tăng dần hay giảm dần trên một cột: 

• Đánh dấu các ô muốn được sắp xếp 

• Kích nút Sort & Filter trên tab Home 

• Kích nút Sort Ascending (A-Z) hay Sort Descending (Z-A) 
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Tùy chỉnh sắp xếp  

Để sắp xếp nhiều hơn một cột: 

• Kích nút Sort & Filter trên tab Home 

• Chọn cột mà bạn muốn sắp xếp đầu tiên 

• Kích Add Level 

• Chọn cột tiếp theo bạn muốn sắp xếp 

• Kích OK 

 

Lọc dữ liệu  

Bộ lọc cho phép bạn chỉ hiển thị dữ liệu mà đáp ứng các tiêu chuẩn nhất định. Để sử dụng bộ lọc: 

• Kích vào cột hoặc chọn các cột chứa dữ liệu mà bạn muốn lọc 

• Trên tab Home, kích Sort & Filter 

• Kích nút Filter 

• Kích vào mũi tên phía dưới ô đầu tiên 

• Kích Text Filter 

• Kích Words bạn muốn lọc 
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• Để ko áp dụng bộ lọc, kích nút Sort & Filter  

• Kích Clear 

 

 

4.2 PivotTable và PivotChart 

PivotTable và PivotChart là những công cụ phân tích dữ liệu rất mạnh trong Excel. Chúng có thể 

biến những con số dường như vô nghĩa trong một khối dữ liệu khổng lồ thành những con số có 

nghĩa. PivotTable và PivotChart rất dễ sử dụng, nhưng chúng cũng có một số vấn đề phức tạp 

không thể tránh khỏi.  
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4.2.1 Giới thiệu PivotTable và PivotChart 

- Tạo một báo cáo PivotTable đơn giản 

Giả sử chúng ta có bảng tính sau đây:  

 

Đây là một trong những loại bảng tính mà bạn có thể dùng để tạo ra một PivotTable. Dữ liệu thông 

kê doanh thu của 3 cửa hàng (store) bán dụng cụ thể thao, đại diện cho 3 miền (region) trong một 

tuần (từ ngày 06 đến ngày 12/6/2005). Cột D là số khách hàng của từng loại dụng cụ thể thao, cột 

E là tổng doanh thu, và các cột còn lại là doanh thu chi tiết của từng mặt hàng. 

Đây là một số câu hỏi mà bạn có thể phải trả lời dựa vào bảng tính đó: 

• Doanh thu của dụng cụ cắm trại (Camping) tại mỗi miền ? 

• Tại mỗi cửa hàng, ngày nào trong tuần là ngày đông khách nhất? 

• Tại mỗi cửa hàng, mặt hàng nào bán được nhiều nhất? 

• Ngày nào trong tuần (nói chung) là ngày bán ế nhất? 

Tôi sẽ giúp bạn trả lời câu hỏi đầu tiên. Tôi sẽ hướng dẫn bạn tạo ra một PivotTable để thấy được 

tổng doanh thu mặt hàng Camping của mỗi miền. 

Để bắt đầu, bạn cần bảo đảm rằng bạn đang chọn môt ô (bất kỳ ô nào) nằm ở trong vùng chứa dữ 

liệu mà bạn muốn tạo PivotTable. Rồi, bạn nhấn nút PivotTable nằm trong nhóm Insert của thanh 

Ribbon: 
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Excel sẽ hiển thị hộp thoại Create PivotTable như hình sau đây: 

 

Trong hộp thoại này, bạn thấy rằng địa chỉ của dãy ô chứa dữ liệu (A2:K44) đã được nhập sẵn 

trong hộp Table/Range. Nếu như các nút tùy chọn được chọn giống hệt trong hình: Select a table 

or range và New Worksheet, bạn hãy nhấn OK để đóng hộp thoại này.  

Excel sẽ tạo một Sheet mới, và nó sẽ trông giống như hình sau đây: 
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Người ta gọi đây là cái vỏ của một PivotTable. Trong cái vỏ này, bạn sẽ thấy: Ở bên trái là vùng 

báo cáo PivotTable, là vùng sẽ hiển thị các yêu cầu của bạn sau khi bạn đã hoàn tất một PivotTable. 

Ở bên phải là cửa sổ PivotTable Field List, là nơi mà bạn sẽ quyết định những dữ liệu nào sẽ 

được hiển thị trên PivotTable, và cách sắp xếp của chúng. Tôi sẽ trình bày với bạn chi tiết về cái 

PivotTable Field List này trong một bài khác. Còn bây giờ bạn cứ tiếp tục đã. 

Trong hộp thoại PivotTable Field List, bạn hãy nhấn vào mục Region để chọn nó (hoặc bạn nhấn 

vào hộp kiểm ngay bên cạnh nó cũng được). Bạn sẽ thấy mục Region này tự động xuất hiện trong 

vùng Row Labels của PivotTable Field List, đồng thời PivotTable cũng tự động hiển thị tên của 

3 miền: Midwest, Northeast và South trong côt A: 
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Tiếp tục, bạn nhấn vào Camping để chọn nó. Ngay lập tức, Sum of Caming xuất hiện trong vùng 

Values ở phía cuối PivotTable Field List, đồng thời, ở cột B hiển thị tổng doanh thu mặt hàng 

Camping ứng với mỗi miền. 

Cuối cùng, bạn nhấn vào cái mũi tên bé tí nằm ngay bên cạnh mục Sum of Camping trong khung 

Values, chọn Value Field Settings trong danh sách mở ra.  
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Hộp thoại Value Field Settings xuất hiện. Nhấn vào cái nút Number Format. Hộp thoại Format 

Cells quen thuộc sẽ mở ra, chọn Currency. Xong nhấn OK hai lần để đóng tất cả các hộp thoại. 

PivotTable của bạn sẽ giống như sau hình say. Nếu thích, và cũng dễ xem hơn, bạn nhấn vào ô 

A3, nơi đang có chữ Row Labels, sửa nó lại thành Region: 

  

Hy vọng rằng bạn sẽ thấy việc tạo ra một PivotTable dễ như thế nào. Vâng, nó rất đơn giản, và 

nếu có những yêu cầu phức tạp hơn, thì cũng vậy thôi. Xin nói thêm một vài khía cạnh khác của 

PivotTable: 

Khi môt PivotTable được kích hoạt, hộp thoại PivotTable Field List sẽ xuất hiện. Những Field 

được chọn vào trong báo cáo PivotTable sẽ được in đậm và có một dấu kiểm ở ngay bên cạnh, 
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đồng thời chúng cũng xuất hiện ở những vùng bên dưới của PivotTable Field List, cho chúng ta 

biết vai trò của chúng trong PivotTable. Để kích hoạt một PivotTable, bạn nhấn vào một ô bất kỳ 

trong vùng báo cáo PivotTable. Còn nếu không muốn kích hoạt nó, thì bạn chỉ việc nhấn ra ngoài, 

bất kỳ chỗ nào trong bảng tính. 

Bạn sẽ thấy ở bên phải của tiêu đề Region trong vùng báo cáo (ô A3) có một nút mũi tên xổ xuống 

(drop-down arrow). Nút này có chức năng tương tự chức năng AutoFilter. Nhấn vào đó, bạn có 

thể lựa chọn những mục muốn xem thuộc danh sách Region, mà mặc định của nó là Select All 

(xem tất cả). Ví dụ, bạn chỉ muốn xem doanh thu dụng cụ cắm trại của riêng miền Midwest mà 

thôi, bạn nhấn vào nút này, nhấn vào mục (Select All) để tắt nó đi, rồi nhấn vào mục Midwest, bạn 

sẽ có kết quả như hình sau: 

  

- Tạo một báo cáo PivotTable với nhiều cột 

Ví dụ ở bài trước chỉ là một trong những báo cáo PivotTable đơn giản nhất. Trong bài này, bạn sẽ 

học cách tạo một báo cáo PivotTable phức tạp hơn, có nhiều cột cũng như nhiều hàng hơn. 

Bạn xem dữ liệu sau đây. Nó là dữ liệu của những cửa hàng cho thuê băng video: 
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Các hàng dữ liệu trong bài này được thiết kế khác với bài trước. Mỗi hàng trong bảng đại diện cho 

một thể loại video của một cửa hàng (được ghi ở cột B). Con số ở cột Title là số lượng đầu phim 

thuộc thể loại đó. Mục đích của chúng ta là tạo một PivotTable để trình bày những thông tin ở một 

dạng dễ xem hơn. 

Các bước để tạo ra một cái vỏ của PivotTable, tôi đã trình bày ở bài 1. Nếu bạn làm đúng, hộp 

thoại PivotTable Field List của bạn sẽ giống như sau: 
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Trong danh sách các Field sẽ có Store, Category và Titles. Hãy nhấn chọn cả ba. Excel sẽ làm giúp 

bạn các việc sau: 

• Đem Store và Category vào trong hộp Row Labels 

• Đem Tiltes vào trong hộp Values, với cái tên là Sum of Titles 

• Trình bày các thông tin vào vùng báo cáo PivotTable 

Kết quả được minh họa ở hình sau đây: 
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Có thể những gì hiển thị trên máy của bạn không giống cái hình này. Nếu như bạn muốn nó giống 

hệt hình này, hãy nhấn nút phải chuột vào tên của một cửa hàng nào đó trong cột A (Clarkville 

chẳng hạn), chọn lệnh Field Setting, rồi bạn đánh dấu vào các tùy chọn của tab Layout & Print 

giống như tôi đã làm trong hình sau đây; và nếu như cái tên trong ô A3 đang là RowLabels, hãy 

đổi nó thành Store. Bạn sẽ có một PivotTable y hệt như hình ở trên. 
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Cho dù đây là một báo cáo PivotTable rất chính xác, nhưng nó không phải là cái tôi muốn. Trong 

trường hợp này, Store và Category đang nằm chung trong một hàng, đều là Row Labels; còn tôi 

thì muốn Category phải là một cột riêng, là Column Labels. 

Làm thế nào để chuyển một mục ở Row Labels thành Column Lables? Có hai cách:  

1. Trong hộp thoại PivotTable Field List, trong vùng Row Labels, bạn hãy nhấn vào nút 

mũi tên bên cạnh mục Category, và chọn lệnh Move To Column Labels. 

2. Nếu như bạn khéo sử dụng chuột, bạn có thể "nắm" và "kéo" cái mục Category ra khỏi 

vùng Row Labels rồi "thả" nó vào vùng Column Labels. 

Sau khi làm xong một trong 2 cách trên, bạn sẽ thấy PivotTable giống như sau: 
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So sánh với bảng dữ liệu ban đầu, PivotTable dễ đọc hơn nhiều. Nhìn vào bảng báo cáo này, chúng 

ta có thể so sánh số lượng đầu phim của từng thể loại video giữa các cửa hàng với nhau (xem theo 

cột), hoặc so sánh số đầu phim giữa các thể loại video của một cửa hàng với nhau (xem theo hàng). 

Nhìn vào PivotTable, bạn có thể trả lời ngay cửa hàng nào có nhiều phim hành động nhất, phải 

không? 

Bạn có thấy rằng: việc di chuyển một Field từ Row Labels sang Column Labels, làm cho 

PivotTable dường như là xoay bảng dữ liệu từ dọc thành ngang. Chữ "xoay", trong tiếng Anh, là 

"pivot". Vậy bạn hiểu PivotTable là gì rồi chứ? 

Nếu như từ nãy giờ, bạn vừa đọc bài này, vừa tự thực hành, thì bạn hãy lưu lại bảng tính. Chúng 

ta sẽ sử dụng PivotTable vừa tạo ra này cho bài sau: Tạo một biểu đồ xoay (PivotChart). Hẹn gặp 

lại. 

1.3. Tạo một PivotChart 

Một PivotChart chẳng có gì khác hơn là một biểu đồ Excel, được tạo ra từ dữ liệu của một 

PivotTable. Thật ra thì cũng có một vài tính năng mà bạn không tìm thấy ở những biểu đồ bình 

thường. Tuy nhiên, phần lớn thì một PivotChart cũng giống như bất kỳ một biểu đồ nào trong 

Excel, những thao tác với các biểu đồ, hoặc việc định dạng cho nó, chẳng có gì khác.  
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Nếu bạn biết chắc rằng bạn sẽ cần đến một PivotChart, bạn có thể tạo ra PivotTable và PivotChart 

cùng một lần. Thay vì nhấn vào nút PivotTable trong nhóm Insert trên thanh Ribbon (như tôi đã 

trình bày ở bài 1), bạn hãy nhấn vào cái mũi tên nhỏ ở dưới cái nút đó, và chọn lệnh PivotChart. 

Rồi thì bạn cũng sẽ gặp hộp thoại tạo một PivotTable như ở những bài trên, nhưng khi tạo xong 

PivotTable, thì Excel cũng sẽ tự động tạo luôn một PivotChart đi kèm theo. 

Bây giờ chúng ta sẽ học cách tạo ra một PivotChart từ PivotTable mà bạn đã thực hành ở bài số 2, 

bài toán về các cửa hàng bán video. Bạn lần lượt theo các bước sau: 

1. Chắc chắn rằng bạn đang kích hoạt PivotTable. Nếu như không muốn thấy cái hộp thoại 

PivotTable Field List, bạn có thể tắt nó đi. Hộp thoại này có thể bật tắt bất cứ lúc nào 

bằng cái nút này (trong nhóm PivotTable|Options trên thanh Ribbon): 

 

2. Nhấn nút PivotChart trong nhóm PivotTable|Options trên thanh Ribbon. Excel sẽ hiển 

thị hộp thoại Insert Chart, như hình sau: 
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3. Chọn Column trong danh sách Templates ở bên trái, rồi nhấn vào biểu tượng thứ hai 

(stacked column) ở hàng đầu tiên trong khung bên tay phải. 

4. Nhấn OK để tạo biểu đồ. 

Bạn sẽ có một biểu đồ như hình sau. Mỗi cửa hàng (Store) được đại diện bởi một "bar" trong biểu 

đồ, và trong mỗi "bar" này chứa số lượng thể loại phim (Category) có trong cửa hàng đó, được 

phân biệt bởi các màu khác nhau. 
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Khi bạn nhấn vào biểu đồ, tức là bạn kích hoạt PivotTable, Excel sẽ hiển thị hộp thoại PivotChart 

Filter Pane như bạn thấy ở hình trên. Bạn có thể dùng Axis Fields và Legend Fields trong hộp 

thoại này để lọc các dữ liệu, điều chỉnh PivotChart hiển thị hay không hiển thị biểu đồ của một 

loại dữ liệu nào đó. Bất kỳ việc lọc dữ liệu nào bạn thực hiện trong hộp thoại này, cũng sẽ được 

áp dụng trong PivotTable, và biểu đồ sẽ tự động vẽ lại theo những thay đổi trong PivotTable. 

Ví dụ, tôi nhấn vào Axis Fields, và chỉ chọn hai cửa hàng: Clarkville, WestEnd. Biểu đồ sẽ tự 

động vẽ lại như sau: 
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4.2.2 Tìm hiểu dữ liệu nguồn của PivotTable 

Chúng ta có thể sử dụng nhiều loại dữ liệu để làm nguồn cho một PivotTable: 

• Sử dụng dữ liệu từ một bảng tính Excel trong cùng một Workbook 

• Sử dụng dữ liệu từ một bảng tính Excel trong một Workbook khác 

• Sử dụng dữ liệu kết hợp từ nhiều nguồn khác nhau nhưng có cấu trúc giống nhau 

(consolidate ranges) 

• Sử dụng dữ liệu từ một báo cáo PivotTable khác 

Những bài sau đây sẽ lần lượt điểm qua từng loại dữ liệu này. 

- Sử dụng dữ liệu của cùng một bảng tính Excel 

Có lẽ cách dễ nhất và cũng được nhiều người sử dụng nhất là sử dụng dữ liệu của một bảng tính 

Excel để làm nguồn cho PivotTable. Dữ liệu này có thể nằm trong cùng một bảng tính, như đã 

được trình bày ở bài 1. 

Mọi việc sẽ trở nên rất đơn giản khi bạn tạo một PivotTable trong cùng bảng tính chứa dữ liệu 

nguồn. Dữ liệu này phải được thiết kế theo dạng một List (trong Excel 2003), một Table (Excel 

2010), với những yêu cầu sau:  
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• Hàng đầu tiên chứa tên các Field (hoặc tên của các cột) 

• Hàng thứ hai và những hàng tiếp theo chứa dữ liệu 

• Không có hàng bỏ trống, nhưng có thể có những ô trống 

Để tìm hiểu kỹ hơn về cấu trúc của một Table, bạn có thể tham khảo ở bài "Phân tích dữ liệu với 

các Table". 

Nếu có một ô nằm ở đâu đó trong vùng dữ liệu nguồn này được chọn khi bạn mở hộp thoại Create 

PivotTable, Excel sẽ tự động xác định địa chỉ của toàn bộ vùng dữ liệu và nhập nó vào trong mục 

Table/Range của hộp thoại. Nếu bạn muốn xác định chính xác địa chỉ của vùng dữ liệu nguồn, 

bạn có thể chọn một trong 3 cách sau: 

1. Chọn một ô trong vùng dữ liệu trước khi mở hộp thoại. Địa chỉ của vùng dữ liệu sẽ được 

nhập vào tự động 

2. Nhập trực tiếp địa chỉ của vùng dữ liệu trong mục Table/Range của hộp thoại 

3. Sử dụng nút Select trong hộp thoại để chọn vùng dữ liệu 

 

Có một cách rất hay và rất nên làm để chỉ cho Excel biết vùng dữ liệu nằm ở đâu, là tạo một cái 

tên (Name) cho vùng dữ liệu. Sử dụng Name thì tiện lợi hơn việc nhập địa chỉ hoặc chọn vùng dữ 

liệu mỗi khi bạn muốn tham chiếu đến chúng. Để tìm hiểu thêm về Name cho vùng dữ liệu, xin 

đọc bài: "Sử dụng tên cho dãy". 

Tuy nhiên, nếu bạn sử dụng một Table của Excel 2010 để làm dữ liệu nguồn cho PivotTable, thì 

bạn khỏi cần quan tâm đến Name, bới chính bản thân Table đã có sẵn một cái tên, khi bạn tạo nó. 

Và khi đã có Name của dữ liệu nguồn, bạn chỉ việc nhập trực tiếp cái tên này vào trong mục 

Table/Range của hộp thoại Create PivotTable. Ví dụ, ở hình sau đây, dữ liệu nguồn của 

PivotTable là một dãy có tên là SalesData: 

http://www.giaiphapexcel.com/forum/showthread.php?t=11863
http://www.giaiphapexcel.com/forum/showthread.php?t=11863
http://www.giaiphapexcel.com/forum/showthread.php?t=9403


133 

Trung tâm Công nghệ thông tin và Truyền thông Nghệ An 

 

- Sử dụng dữ liệu nguồn từ một bảng tính Excel khác 

Nếu dữ liệu mà bạn sẽ dùng trong PivotTable nằm tron một bảng tính khác, các bước thể tạo 

PivotTable hơi khác một tí. Bạn sẽ phải xác định dãy ô (địa chỉ) chứa dữ liệu nguồn, và tên của 

workbook chứa dữ liệu nguồn. 

Cách dễ nhất để thực hiện việc này, là mở đồng thời hai bảng tính. Môt cái sẽ chứa PivotTable, 

một cái chứa dữ liệu nguồn. Rồi làm theo các bước sau: 

1. Chọn (kích hoạt) workbook sẽ tạo PivotTable. 

2. Nhấn nút PivotTable trong tab Insert của Ribbon để mở hộp thoại Create PivotTable. 

3. Hãy chắc chắn rằng tùy chọn Select a Table or Range đang được chọn. 

4. Nhấn nút Select nằm ở phía bên phải của khung Table/Range, một hộp thoại Create 

PivotTable "nhỏ" như sau đây sẽ xuất hiện: 

 

5. Nhấn Alt+Tab hoặc nhấn vào workbook chứa dữ liệu nguồn để kích hoạt nó. Bạn sẽ vẫn 

thấy cái hộp thoại Create PivotTable "nhỏ". 

6. Chọn dãy chứa dữ liệu nguồn cho PivotTable. Địa chỉ của nó, bao gồm cả tên của 

workbook, sẽ tự động nhập vào trong hộp thoại Create PivotTable "nhỏ": 
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7. Nhấn vào nút Select trên cửa sổ Create PivotTable "nhỏ" để chấp nhận vùng chọn và 

đóng nó lại, quay về hộp thoại Create PivotTable "lớn". 

8. Nhấn OK để quay về bảng tính với PivotTable vừa tạo. 

Khi một PivotTable được "link" tới một bảng tính bên ngoài, bạn chỉ có thể cập nhật (update) 

PivotTable nếu đường link này tới bảng tính nguồn còn tồn tại. Khi bảng tính chứa dữ liệu nguồn 

bị đổi tên, bị dời đi chỗ khác, hoặc bị xóa, bạn sẽ không thể cập nhật PivotTable. Excel sẽ hiển thị 

một thông báo lỗi nếu bạn cố làm việc đó. 

Có thể bạn thắc mắc là tại sao có nhiều người không làm một PivotTable trong cùng một bảng 

tính, mà lại làm PivotTable trong một bảng tính khác? Việc này, thật ra rất hữu ích, nhất là đối với 

những dữ liệu khổng lồ, cồng kềnh. Có lẽ bạn đã biết những bảng tính chứa một bảng dữ liệu lớn 

thì chạy chậm như thế nào. Khi đặt PivotTable trong một bảng tính khác, bạn vẫn có thể có được 

những thống kê, mà không cần thiết phải mở dữ liệu nguồn ra. Hoặc khi bạn muốn thống kê dữ 

liệu từ nhiều nguồn khác nhau, bạn có thể tạo một workbook trung gian, chứa nhiều PivotTable, 

mà mỗi PivotTable thì "link" đến một dữ liệu nguồn riêng. 

Có một điều bạn cần nên biết, là bản thân PivotTalbe không bao giờ tự "refresh" dữ liệu, nghĩa là 

nó không thể tự động cập nhật khi dữ liệu nguồn thay đổi, bất kể dữ liệu nguồn nằm trong cùng 

một workbook với PivotTable hay nằm trong một worbook khác. Việc tính toán lại bảng tính 

(recalculated) cũng không cập nhật lại dữ liệu cho PivotTable.  

Bạn phải thực hiện chuyện "refresh" bằng tay. Bằng hai cách: 

• Nhấn chuột phải vào PivotTable và chọn lệnh Refresh Data 

• Nhấn vào nút Refresh nằm trong tab PivotTable|Option trên Ribbon (bạn chỉ thấy tab này 

khi bạn kích hoạt PivotTable). 

 

- Sử dụng nhiều dãy dữ liệu có cùng cấu trúc (Multiple Consolidation Ranges) 

Thuật ngữ "Multiple Consolidation Ranges" (nhiều dãy dữ liệu có cùng cấu trúc), thật ra không 

phức tạp như cái tên của nó. Tất cả chỉ đơn giản là tạo một PivotTable dựa trên hai hoặc nhiều 

bảng dữ liệu (là Table, hay là List trong các version trước). Những nguồn dữ liệu này có thể nằm 

trong cùng một bảng tính, hoặc nằm trong những bảng tính khác nhau. Nhưng, chức năng Create 

PivotTable của Excel 2010 mà chúng ta đã làm quen từ đầu đến giờ, lại không hỗ trợ Multiple 
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Consolidate Ranges, và không có tùy chọn này. Để sử dụng được Multiple Consolidation Ranges, 

chúng ta phải cầu viện đến chức năng PivotTable and PivotChart Wizard, một chức năng có 

trong những version trước của Excel. Trong Excel 2010, chức năng này vẫn còn, nhưng bị ẩn đi. 

Để gọi nó ra, bạn phải sử dụng những phím tắt dùng để gọi PivotTable and PivotChart Wizard 

trong Excel 2003, đó là: Alt+D+P.  

Nếu như bạn thuộc tất cả các phím tắt để gọi lệnh trên menu của Excel 2003, thì bạn có thể sử 

dụng chúng trong Excel 2010, cho dù Ribbon của Excel 2010 thì chẳng giống gì Menu Bar của 

Excel 2003. 

Để sử dụng được Multiple Consolidation Ranges, bắt buộc mỗi danh sách mà bạn muốn dùng làm 

dữ liệu nguồn cho PivotTable phải có cùng cấu trúc, có nghĩa là tất cả những tiêu đề cột (nằm trên 

hàng đầu tiên) và tiêu đề dòng (nằm trong cột đầu tiên bên trái) phải giống hệt nhau. Nếu như có 

một hàng nào, hoặc cột nào nằm riêng lẻ, thì chúng sẽ không được tích hợp vào trong báo cáo 

PivotTable. 

Đây là một ví dụ về các nguồn dữ liệu có thể sử dụng với chức năng Multiple Consolidation 

Ranges: 

 

Để khởi động "Wizard", bạn hãy nhấn Alt+D rồi nhấn thêm phím P. Và tại Step 1, nhấn vào tùy 

chọn Multiple Consolidation Ranges: 
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Sau khi nhấn Next để sang Step 2a, bạn sẽ có 2 tùy chọn: 

• Create a single page field for me — Để Excel tự động tạo ra một Page Field đơn, với mỗi 

vùng dữ liệu nguồn là môt mục (item) trong Page Field đó. Page Field có thể tạm hiểu như 

là chức năng lọc "cấp 1" của PivotTable. Trong cửa sổ PivotTable Field Lists, Page Field 

chính là những mục nằm trong khung Report Filter. Nếu không có, xem như Page Field 

= All (xem tất cả các dữ liệu). 

• I will create the page fields — Dùng tùy chọn này để tự tạo các Page Field của riêng bạn. 

Bạn có thể tạo tối đa là 4 Page Field, mỗi Page Field lọc ra một thành phần nào đó của các 

dữ liệu. 

- Tạo một trang tổng hợp duy nhất với chức năng Create a single page field for me 

Bạn xem lại bảng tính EmployeeData mà tôi vừa trình bày ở bài trước. Bạn sẽ thấy có 3 danh sách, 

mỗi danh sách là một phương án tuyển dụng nhân viên cụ thể cho các bộ phận. Và cả 3 danh sách 

đều có cùng cấu trúc, cũng như tiêu đề của các hàng, cột này là giống nhau. Để tạo một PivotTable 

dựa vào 3 danh sách này, bạn hãy sử dụng PivotTable and PivotChart Wizard theo các bước tôi 

đã trình bày ở bài trước, và khi đang ở trong Step 2a, hãy đánh dấu vào tùy chọn Create a Single-

Page Field, rồi nhấn Next để sang Step 2b, rồi theo các bước sau: 

1. Nhấn vào nút Select ở bên phải hộp Range  

2. Chọn dãy A3:B9 trong bảng tính.  

3. Nhấn lại vào nút Select để đưa dãy vừa chọn vào trong khung Range. 
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Ghi chú: Nếu bạn bỏ qua bước 1, mà chỉ cần dùng chuột chọn trực tiếp dãy A3:B9 

trong bảng tính, Excel sẽ tự hiểu là bạn đã nhấn nút Select rồi, nên cũng sẽ bỏ qua luôn 

bước 3 này. Khi bạn kết thúc việc chọn dãy bằng chuột, Excel sẽ đưa bạn vào thẳng 

bước 4 sau đây. 

4. Nhấn nút Add để thêm dãy vừa chọn vào trong danh sách All Ranges. 

5. Lập lại bước 1 đến bước 4 để chọn và thêm vào danh sách All Ranges hai dãy D3:D9 và 

G3:G9. Tới đây, màn hình của bạn sẽ giống như sau: 

 

6. Nhấn Next để sang Step 3. 

7. Tại đây, bạn có thể chọn New Worksheet để tạo PivotTable trong một Sheet mới, hoặc 

chọn Existing worksheet và nhấn chuột vào nơi bạn muốn tạo PivotTable ngay trong bảng 

tính này.  

8. Click Finish. 

Bạn sẽ có một PivotTable như sau: 
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Trong PivotTable này, nhãn Column Labels có một mũi tên xổ xuống, bạn có thể dùng nó để lọc 

ra cột muốn xem. Trong trường hợp này, do các dữ liệu nguồn chỉ có một cột (Employees), nên 

nút này không cần dùng đến, nhưng nếu các dữ liệu nguồn của bạn có nhiều cột, bạn sẽ cần dùng 

đến nó. Nhãn Row Labels cũng có một mũi tên xổ xuống, dùng để lọc ra những hàng muốn xem. 

Những nút xổ xuống này là điểm đặc trưng mà bạn có thể thấy trong tất cả các PivotTable. 

Còn nút xổ xuống của nhãn Page1 thì có gì đặc biệt? Nó cho phép bạn lọc ra dữ liệu nguồn nào 

muốn xem, như bạn thấy ở hình sau đây, khi nhấn vào nó. Các mục Item1, Item2 và Item3 tham 

chiếu đến 3 dữ liệu nguồn mà bạn đã dùng làm dữ liệu nguồn cho PivotTable. Bạn có thể chọn 

tổng hợp dữ liệu theo tất cả các nguồn (All), hoặc chỉ 1 nguồn nào đó. Nếu muốn tổng hợp nhiều 

hơn 1 nguồn dữ liệu, bạn phải nhấn vào tùy chọn Select Multiple Items. 
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Bạn hãy thử sử dụng các nút xổ xuống bên cạnh các nhãn, để xem chúng làm việc như thế nào. 

Lọc là một trong chức năng quan trọng nhất của một PivotTable, bạn cần hiểu rõ cách lọc của một 

PivotTable, để có thể dễ dàng tiếp cận với những chức năng cao cấp hơn. 

Trong PivotTable mà chúng ta đã thực hành trong bài này, có cột Grand Total, là một mặc định 

của PivotTable. Tuy nhiên, bởi vì các dữ liệu nguồn của chúng ta chỉ có 1 cột, nên không cần thiết 

đến cột Grand Total, tôi sẽ nói về cách bỏ cái cột này đi trong bài sau. 

- Tạo một PivotTable có nhiều trang tổng hợp từ những dữ liệu nguồn có cùng cấu trúc 

Trong công việc hằng ngày, nhất là khi phải thường xuyên tổng hợp những dữ liệu kiểu như: Báo 

cáo doanh thu quý I, Báo cáo doanh thu quý II, Báo cáo doanh thu quý III, v.v..., bạn nên sử dụng 

PivotTable, với tùy chọn thứ 2 khi đang ở trong Step 2a của PivotTable and PivotChart Wizard: 

I will create the page fields. 

Tùy chọn này rất thích hợp khi tổng hợp từ nhiều nguồn dữ liệu có cùng cấu trúc, mà những nguồn 

dữ liệu đó có cùng tiêu đề, chỉ khác vài con số dùng để tổng hợp (theo quý, theo năm, theo tháng...), 

chẳng hạn như bảng tính này: 

 

Đây là 4 bảng tổng hợp số học sinh đạt yêu cầu theo từng môn, và theo từng học kỳ trong hai năm 

học 2005, 2006; cả 4 đều có chung tiêu đề Year ... Semester .... 

Chúng ta hãy thử. Bạn hãy sử dụng PivotTable and PivotChart Wizard theo các bước tôi đã 

trình bày ở bài 2.3, và khi đang ở trong Step 2a, hãy đánh dấu vào tùy chọn I will create the page 

fields, rồi nhấn Next để sang Step 2b, rồi theo các bước sau: 

1. Nhập khối dữ liệu nguồn thứ nhất (A2:B8) vào trong khung Range 
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2. Nhấn nút Add để thêm nó vào trong danh sách All Ranges 

3. Lập lại hai bước trên ba lần, để thêm 3 khối dữ liệu còn lại (D2:D8, A11:B17, và D11:E17) 

vào trong danh sách All Ranges. Tại thời điểm này, màn hình của bạn sẽ giống như hình 

sau: 

 

4. Nhấn vào tùy chọn 2 ở phần How many page fields do you want? 

5. Bạn sẽ thấy phần đang mờ mờ ở dưới cùng của hộp thoại PivotTable and PivotChart 

Wizard mở ra 2 cái: Field one và Field two (bạn chỉ có thể có tối đa 4 trang tổng hợp). 

6. Tới đây, hãy tạm dừng một chút để vạch ra một vài ý tưởng cho việc thống kê dữ liệu. Bạn 

cần có bao nhiêu trang tổng hợp? Hay nói cách khác, bạn cần thống kê dữ liệu theo mấy 

tiêu chí? Hãy nhìn vào tiêu đề của 4 dữ liệu nguồn. Ở đó chúng ta có hai năm học: 2005 và 

2006, và hai học kỳ (semester): học kỳ 1 và học kỳ 2. Vậy, ý tưởng hay nhất, có lẽ là thống 

kê theo năm để lọc ra dữ liệu của từng năm, hoặc cả 2 năm; và đồng thời cũng thống kê 

theo từng học kỳ, để lọc ra dữ liệu của từng học kỳ hoặc cả 2 học kỳ. Như vậy, chúng ta 

cần có hai trang tổng hợp, đó là lý do tại sao ở bước 4 trên đây, tôi nói bạn nhấn vào tùy 

chọn 2. Mời bạn tiếp tục:  

7. Trong danh sách All Ranges, chọn dãy đầu tiên: A2:B8, dãy này là số liệu của học kỳ 1 

năm 2002. 
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8. Nhập Year 2002 vào trong Field one. 

9. Nhập Semester 1 vào trong Field two. 

10. Chọn tiếp dãy thứ hai: D2:E8, dãy này là số liệu của học kỳ 1 năm 2003. 

11. Nhập Year 2003 vào trong Field one. 

12. Bởi vì trong Field two đã có sẵn Semester 1, nên thay vì nhập, bạn có thể chọn nó từ nút 

mũi tên xổ xuống. 

13. Chọn dãy thứ ba: A11:B17, dãy này là số liệu của học kỳ 2 năm 2002. 

14. Chọn Year 2002 từ nút mũi tên xổ xuống cho Field one. 

15. Nhập Semester 2 vào trong Field two. 

 

16. Chọn dãy cuối cùng: D11:E17, chọn Year 2003 cho Field one và Semester 2 cho Field 

two từ các nút mũi tên xổ xuống. 

Nhấn Next để hoàn tất PivotTable và đặt nó ở trong cùng Sheet hay trong một Sheet khác, tùy bạn. 

Thành quả của chúng ta giống như sau, là một PivotTable tổng hợp tất cả số học sinh đạt yêu cầu 

của cả hai năm học 2002 và 2003, thống kê chi tiết theo từng môn học: 
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Nếu bạn nhấn nhãn Page 1, bạn sẽ có hai lựa chọn: Year 2002 và Year 2003; cũng vậy, khi nhấn 

nhãn Page 2, bạn sẽ có hai lựa chọn: Semester 1 và Semester 2.  

Bởi vì trong PivotTable này chỉ có 1 cột, nên bạn có thể bỏ cái Grand Total đi bằng cách: nhấn 

phải chuột vào ngay nhãn Grand Total, và chọn Remove Grand Total từ menu mở ra. 

 

- Tạo một PivotTable sử dụng dữ liệu nguồn từ một báo cáo PivotTable đã có 

Lựa chọn cuối cùng cho việc tạo một PivotTable là dựa vào một PivotTable hoặc một PivotChart 

đã có. Nói cách khác, ta sử dụng Summary Data của một PivotTable đã có làm Raw Data cho báo 

cáo thứ hai. 

Có hai cách để tạo một PivotTable là dựa vào một PivotTable đã có: 
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• Nếu bạn sử dụng Excel 2010, bạn chỉ việc gọi lệnh tạo một PivotTable như vẫn thường 

làm, và chọn một PivotTable có sẵn làm dữ liệu nguồn cho nó. 

• Nếu bạn sử dụng PivotTable and PivotChart Wizard, đánh dấu vào tùy chọn Another 

PivotTable or PivotChart Report ở bước 1 (tùy chọn này chỉ xuất hiện khi bảng tính của 

bạn đã có chứa ít nhất một PivotTable). Sau khi bạn nhấn Next, bạn sẽ thấy một danh sách 

các PivotTable hoặc PivotChart đang có, rồi bạn chọn một cái để làm dữ liệu nguồn. 

Tại sao lại sử dụng một PivotTable đã có để làm dữ liệu nguồn cho một PivotTable khác? Trong 

nhiều trường hợp, ít nhất là lúc ban đầu, bản PivotTable thứ hai sẽ có cùng một dữ liệu nguồn với 

bản PivotTable thứ nhất. Nhưng với việc định dạng cho bản PivotTable thứ hai, bạn sẽ tạo ra được 

hai cách xem cho cùng một dữ liệu nguồn, rất hữu dụng cho một số giải pháp xử lý dữ liệu. Ví dụ, 

bạn đã có một PivotTable tổng hợp dữ liệu, nhưng có lẽ vẫn còn một ít rắc rối (vì dữ liệu có nhiều 

vấn đề cần xử lý). Bằng cách tạo thêm một PivotTable nữa dựa vào PivotTable đã có, bạn sẽ có 

được một cái nhìn cụ thể hơn, dễ xem hơn về dữ liệu nguồn. 

Thêm nữa, việc tạo một PivotTable sử dụng dữ liệu nguồn từ một PivotTable đã có, sẽ ít chiếm 

dụng bộ nhớ hệ thống hơn là tạo 2 PivotTable từ một dữ liệu nguồn. Thiết nghĩ đây cũng là một 

vấn đề cần cân nhắc khi chúng ta phải xử lý những dữ liệu lớn. 

4.2.3 Sử dụng các công cụ của PivotTable và định dạng PivotTable 

Excel có một số công cụ được thiết kế đặc biệt cho các báo cáo PivotTable. Bạn sẽ thấy những 

công cụ này trên Ribbon Options và Design, xuất hiện khi có một PivotTable được kích hoạt. 

 

Khi kích hoạt một PivotTable, bạn sẽ thấy có thêm Ribbon Options và Design 

- Tìm hiểu PivotTable Field List 

Có lẽ công cụ mà bạn sẽ phải đụng đến thường xuyên nhất khi làm việc với PivotTable là Field 

List. Bạn dùng Field List để chỉ ra loại dữ liệu nào sẽ được đưa vào báo cáo PivotTable, và sắp 

xếp chúng trong báo cáo. 

Khi bạn vừa ra lệnh tạo mới một PivotTable, bạn sẽ có một báo cáo rỗng. Khi đó, PivotTable Field 

List hiển thị tất cả những Field có trong dữ liệu nguồn. Đây là một ví dụ: 
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Một PivotTable mới tinh, phía bên phải là PivotTable Field List, chưa có field nào được chọn 

Để thêm một field nào vào trong báo cáo PivotTable, bạn chỉ cần đánh dấu vào hộp kiểm ngay bên 

cạnh tên field. Excel sẽ thêm field đó vào một trong 4 vùng nằm ở phần dưới của PivotTable Field 

List. 

Bốn vùng này là: 

1. Report Filter: Những Field nào được thêm vào trong vùng này, sẽ được dùng để lọc toàn 

bộ dữ liệu nguồn. Nói cách khác, PivotTable chỉ hiển thị những dữ liệu nào thỏa mãn điều 

kiện của Report Filter. 

2. Columns Label: Những Field nào được thêm vào trong vùng này, sẽ được dùng làm tiêu 

đề cột cho báo cáo PivotTable. 

3. Row Label: Những Field nào được thêm vào trong vùng này, sẽ được dùng làm tiêu đề 

hàng cho báo cáo PivotTable. 
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4. Values: Những Field nào được thêm vào trong vùng này sẽ được tính tổng theo mặc định 

và hiển thị trên vùng nội dung chính (main body) của PivotTable, nói cách khác, đây chính 

là những thống kê từ dữ liệu nguồn, mà bạn muốn có khi sử dụng PivotTable. 

Khi bạn đánh dấu kiểm vào một field nào đó, làm sao Excel biết bạn muốn đem field đó vào vùng 

nào ? Đơn giản thôi: Nếu field chỉ chứa những dữ liệu là số, thì nó sẽ được đem vào trong vùng 

Values, còn nếu field có chứa những loại dữ liệu khác (text, ngày tháng...) thì nó sẽ được đem vào 

trong vùng Row Labels. Tuy nhiên, việc Excel đem field vào trong vùng nào thì không quan trọng. 

Bởi vì bạn có thể di chuyển các field từ vùng này sang vùng khác, nếu thấy cần thiết. 

Xem ví dụ sau đây, minh họa một PivotTable cùng với Field List của nó. Bạn sẽ biết cách tạo ra 

PivotTable này trong bài sau. Còn bây giờ, hãy lướt qua các vùng mà tôi đã đánh số trong hình, 

tương ứng với 4 vùng của Field List mà tôi vừa trình bày ở trên.  

1. Region được đặt trong vùng Report Filter, và nó nằm trong vùng Filter của báo cáo (ở 

trên cao, góc trái), có chức năng lọc toàn bộ dữ liệu nguồn. 

2. Date được đặt trong vùng Row Labels, và nó là các tiêu đề hàng của báo cáo PivotTable.  

3. Store được đặt trong vùng Column Labels, và nó là các tiêu đề cột của báo cáo PivotTable.  

4. Camping (chính xác hơn, là Sum of Camping) được đặt trong vùng Values, và nó là các 

dữ liệu đã được lọc ra trong báo cáo PivotTable. 

Bài tiếp theo sẽ trình bày cách sử dụng Field List để sắp xếp cách trình bày một PivotTable theo 

như ý bạn muốn. 
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..............

 

PivotTable Field List, với các field đã được thêm vào trong 4 vùng bên dưới 

- Sử dụng PivotTable Field List 

Ở bài trước, bạn đã biết rằng khi đưa một Field vào trong một vùng của Field List, thì nó sẽ nằm 

ở đâu trong PivotTable, hay nói cách khác, việc đưa Field vào một trong bốn vùng của Field List 
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sẽ ảnh hưởng thế nào đến cấu trúc của PivotTable. Bài này sẽ trình bày cho bạn thay đổi cấu trúc 

đó bằng cách sử dụng Field List. 

Trước hết, mời bạn mở file SportingGoodsRawData.xlsx (ở cuối bài này). Yêu cầu đặt ra là thống 

kê lượng hàng phục vụ cho dã ngoại (Camping) đã bán được theo cửa hàng (Store) và theo ngày 

(Date) của từng vùng (Region). 

Bạn theo các bước sau: 

1. Nhấn con trỏ vào bất kỳ ô nào trong vùng dữ liệu. 

2. Nhấn nút PivotTable từ Ribbon Insert để mở hộp thoại Create PivotTable. 

3. Nhấn OK. Excel sẽ tạo một PivotTable "rỗng" như hình sau: 

 

Hình 3.4. PivotTable, lúc ban đầu 

4. Trong Field List, chọn (click vào hộp kiểm ở ngay bên trái) các Field Store, Region, 

Camping, và Date. 

Tới lúc này, bảng tính của bạn sẽ giống hình 3.5. 
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PivotTable với cấu trúc theo mặc định, chưa chỉnh sửa 

Bạn thấy đấy. Field Camping và Store đều được đặt trong vùng Values, bởi Excel thấy chúng 

chứa toàn các dữ liệu kiểu số. Field Region và Date được đem vào trong vùng Row Labels bởi 

chúng có chứa những dữ liệu kiểu ngày tháng và text.  

Dĩ nhiên, cấu trúc này của PivotTable không phải là thứ chúng ta cần, chính xác hơn, về cơ bản 

thì nó chả có ích lợi gì, bởi vì mục đích của chúng ta là thống kê lượng hàng phục vụ cho dã ngoại 

(Camping) đã bán được theo cửa hàng (Store) và theo ngày (Date) của từng vùng (Region). Tất cả 

những gì cần làm để đạt được mục đích, là sắp xếp lại các field trong các vùng của Field List. 

Bạn có thể di chuyển một field sang vùng khác bằng hai cách: 

• Click vào field muốn di chuyển và rê (drag) nó vào trong vùng khác. 

• Nhấn vào nút mũi tên xổ xuống bên cạnh tên field (ở trong một vùng nào đó), rồi chọn lệnh 

Move to XXXX (với XXXX là tên của vùng bạn muốn dời field này đến). 
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Dùng nút mũi tên xổ xuống để dời field Region vào vùng Report Filter 

Và thực hiện những việc sau: 

• Dời field Region vào vùng Report Filter 

• Dời field Store (đang mang tên là Sum of Store) vào vùng Column Labels 

PivotTable của bạn lúc này sẽ giống như hình sau: 
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PivotTable sau khi được chỉnh sửa 

Cuối cùng, bạn hãy định dạng cho giá trị trong PivotTable theo dạng tiền tệ: 

• Nhấn vào nút mũi tên xổ xuống cạnh field Sum of Camping trong vùng Values 

• Chọn Value Field Settings trong danh sách mở ra, để mở hộp thoại Value Field Settings.  
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Chọn Value Field Setting cho field Sum of Camping 

• Nhấn vào nút Number Format để mở hộp thoại Format Cells quen thuộc. 
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Nhấn nút Number Format để mở hộp thoại Format Cells 

• Chọn loại định dạng Currency (tiền tệ), rồi nhấn OK hai lần để trở về PivotTable. 

PivotTable của bạn cuối cùng sẽ giống như sau, và đó cũng là tất cả những gì chúng ta muốn. 

 

PivotTable đã hoàn chỉnh theo yêu cầu 

- Thiết lập các tùy chọn cho PivotTable Field List 

Hộp thoại Field List sẽ tự động hiện ra mỗi khi bạn nhấn chuột vào bất kỳ chỗ nào trong 

PivotTable, nghĩa là khi PivotTable được kích hoạt thì hộp thoại Field List sẽ tự động mở ra. Tuy 

nhiên, bạn có thể đóng hộp thoại Field List bằng cách nhấn vào nút Field List trên Ribbon Options 

(và nhấn vào một lần nữa để mở nó ra lại). 

 

Nhấn vào nút này để đóng hoặc mở hộp thoại Field List 
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Cũng giống như mọi hộp thoại khác, bạn có thể di chuyển Field List tới bất kỳ nơi nào bạn thích 

bằng cách nhấn vùng tiêu đề của hộp thoại và rê chuột đi, hoặc thu nhỏ nó lại hay mở rộng nó ra 

bằng cách nhấn và kéo các cạnh biên.  

Bình thường, hộp thoại Field List hiển thị danh sách các Field ở phía trên, và sắp xếp 4 vùng dữ 

liệu sẽ hiển thị trong PivotTable ở bên dưới. Bạn có thể thay đổi sự sắp xếp này bằng cách nhấn 

vào cái nút nằm ở phía trên bên phải của hộp thoại Field List, và chọn 1 trong 5 kiểu hiển thị từ 

menu mở ra: 

 

Chọn các kiểu hiển thị khác cho hộp thoại Field List 

Hộp thoại Field List còn có một tùy chọn nữa, nằm ở góc dưới bên trái: Defer Layout Update, 

giúp bạn tạm ngưng việc tự động cập nhật dữ liệu trong PivotTable.  
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Nhấn vào nút này để tạm thời ngưng chức năng tự động cập nhật cho PivotTable 

Bình thường, tùy chọn này không được bật. Bất kỳ những thay đổi nào của bạn trong hộp thoại 

Field List (di chuyển, thêm, xóa các field, thiết lập định dạng số cho một field nào đó, v.v...) sẽ 

được cập nhật ngay tức khắc trong PivotTable. Nếu bạn có môt PivotTable lớn, phức tạp, nhất là 

khi PivotTable sử dụng nguồn dữ liệu từ bên ngoài Excel, việc tự động cập nhật này sẽ diễn ra khá 

chậm chạp và mất thời gian. Bạn có thể bật tùy chọn Defer Layout Update để tạm ngưng việc tự 

động cập nhật, và sau khi đã hài lòng với cách bố trí các Field vào các vùng dữ liệu, bạn nhấn nút 

Update để tất cả những thay đổi của bạn được cập nhật cùng một lúc.  

Chương 5: Đồ Thị Trong Excel 

5.1 Giới thiệu đồ thị  

Đồ thị giúp trình bày các số liệu khô khan bằng việc vẽ thành các hình ảnh trực quan, dễ hiểu. Đồ 

thị được liên kết với dữ liệu của nó trong bảng tính, do đó khi thay đổi dữ liệu của nó trong bảng 

tính thì lập tức đồ thị sẽ thay đổi tương ứng theo. Trong Excel 2010 việc vẽ đồ thị chưa bao giờ dễ 

dàng và đẹp như bây giờ. Excel có rất nhiều kiểu đồ thị khác nhau phục vụ cho nhiều mục đích 

khác nhau của rất nhiều loại đối tượng sử dụng bảng tính, chúng ta sẽ cùng nhau khám phá thế 
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giới đồ thị của Excel trong bài học này. Đồ thị là một đối tượng (object) của Excel, đối tượng này 

chứa các dữ liệu và biểu diễn thành hình ảnh với màu sắc và kiểu dáng rất phong phú. Nhìn chung, 

Excel có 2 loại đồ thị đó là đồ thị nằm trong WorkSheet (còn gọi là Embedded chart) và ChartSheet. 

Để chuyển đổi qua lại giữa 2 loại đồ thị này ta làm như sau: Chọn đồ thị → Chart Tools 

→ Design → Location → Move Chart → chọn Object in + Tên Sheet (đồ thị nằm trong 

Worksheet) hay chọn New sheet + Nhập tên ChartSheet vào. 

 

Chọn ChartSheet hay Embedded chart 

5.2. Vẽ đồ thị  

Phần này trình bày các bước vẽ đồ thị từ một bảng số liệu cho trước và một số tùy chọn của đồ thị. 

Kết quả nghiên cứu về sự thõa mãn của các nhóm khách hàng phân theo độ tuổi được cho như 

hình bên dưới, nếu chúng ta dùng kết quả này để báo cáo cũng không có vấn đề gì, tuy nhiên báo 

cáo sẽ sinh động và thuyết phục hơn nếu chúng ta biến các con số này thành đồ thị để được nhìn 

thấy một cách trực quan hơn. 
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Bảng số liệu nghiên cứu 

Hãy làm theo các bước sau để vẽ đồ thị: B1. Chọn vùng dữ liệu A3:D9, chọn luôn các nhãn của 

các cột. B2. Chọn kiểu đồ thị từ Ribbon → Insert → Charts. Mỗi nhóm đồ thị bao gồm nhiều 

kiểu khác nhau, ví dụ chúng ta chọn nhóm Column → Clustered Column. 

 

Chọn kiểu đồ thị 

B3. Xong bước 2 là chúng ta đã có ngay một đồ thị dạng cột như hình trên, tuy nhiên chúng ta có 

thể đổi các bố trí của các thành phần trên đồ thị. Chọn đồ thị → Chart Tools → Design 

→ Chart Layout → Chọn cách bố trí thích hợp. Ví dụ ta chọn kiểu Layout 3 trong Chart 

Layout. 
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Lựa chọn layout 

B4. Đảo các chuỗi số liệu từ dòng thành cột và ngược lại: Chart Tools → Design → Data 

→ Switch Row/Column. Chúng ta thực hiện lệnh này khi các đồ thị ở bước trên chưa hiển thị 

đúng như mong muốn. Ví dụ chúng ta muốn nhóm các nhóm tuổi lại để dễ so sánh giữa các tháng 

với nhau. 

 

Đảo dòng/ cột 
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B5. Nếu thấy kiểu đồ thị trên không đẹp, chúng ta có thể đổi sang kiểu khác bằng cách: Chart 

Tools → Design → Type → Change Chart Type, hộp thoại Insert Chart hiển thị liệt kê toàn 

bộ các kiểu đồ thị hiện có của Excel tha hồ cho bạn lựa chọn. 

 

Hộp thoại Insert Chart và chọn kiểu đồ thị khác 

B6. Ngoài ra, nếu bạn thấy tông màu của đồ thị chưa đẹp thì vào chọn Chart Tools → Design 

→ Chart Styles → chọn More ( ).  

 

Chọn Chart Style 
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5.3. Các thao tác trên đồ thị  

a. Nhận biết các thành phần trên đồ thị  

Các thành phần thông dụng 

 

 

1. Chart Title  7. Horizontal Axis  

2. Chart Area  8. Data Table  

3. Plot Area  9. Horizontal Axis itle  

4. Data Label  10. Vertical Gridlines  

5. Legend  11. Vertical Axis  

6. Horizontal Gridlines  12. Vertical Axis Title  

Một số thành phần chỉ có trong đồ thị 3-D 

o Back wall: Màu/ hình hền phía sau đồ thị  

o Side wall: Màu/ hình nền ở các cạnh bên của đồ thị  

o Floor: Màu/ hình nền bên dưới đồ thị  
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o Column depth: Độ sâu của các thành phần biểu diễn chuỗi số liệu dưới dạng 3-D.  

b. Các thao tác với đồ thị  

Chọn thành phần trên đồ thị  

o Cách dễ nhất là dùng chuột nhấp lên thành phần cần chọn, thành phần được chọn sẽ có 4 

hoặc 8 nút xuất hiện bao quanh.  

Khi đồ thị đã được chọn, chúng ta có thể dùng các phím mũi tên để di chuyển 

đến các thành phần trong đồ thị.  

o Ngoài ra, bạn có thể chọn các thành phần tại Chart Tools → Format → Current 

Selection  

 

Chọn thành phần trên đồ thị 

Di chuyển đồ thị  

Đồ thị là Embedded Chart, nhấp trái chuột lên đồ thị vùng Chart Area để chọn đồ thị di 

chuyễn, khi đó đầu con trỏ chuột có thêm ký hiệu mũi tên 4 chiều (xem hình dưới).  

Giữ trái chuột và di chuyển đồ thị đến nơi khác.  

Thay đổi kích thước đồ thị  

Đồ thị là Embedded Chart, hấp trái chuột lên đồ thị vùng Chart Area để chọn đồ thị cần thay 

đổi kích thước, khi đó xung quanh đồ thị xuất hiện 8 nút nắm.  

Di chuyển chuột vào các nút này, giữ trái chuột và kéo hướng vô tâm đồ thị để thu nhỏ và 

hướng ra ngoài để phóng to.  
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Sao chép đồ thị  

Chọn đồ thị, dùng tổ hợp phím <Ctrl+C> để chép đồ thị vào bộ nhớ, rồi di chuyển đến một ô 

nào đó trong bảng tính và nhấn <Ctrl+V> để dán đồ thị vào.  

Xóa đồ thị  

Chọn đồ thị sau đó nhấn phím Delete để xóa đồ thị. Để xóa Chart Sheet, trước tiên hãy chọn 

Chart Sheet, sau đó nhấp phải chuột và chọn Delete từ thực đơn ngữ cảnh hiện ra.  

Thêm các thành phần của đồ thị  

Chọn đồ thị → chọn Chart Tools → Design → Chart Layouts Sử dụng các nhóm lệnh 

tạo các thành phần tương ứng trên đồ thị được thiết kế sẵn như tựa đề, chú thích, các nhãn, 

đường lưới,…  

Sắp xếp và xóa các thành phần của đồ thị  

Một số thành phần trong đồ thị có thể di chuyển được như tựa đề, chú thích, nhãn. Muốn di 

chuyển thành phần nào trước tiên hãy dùng chuột chọn nó, sau đó nhấp và giữ trái tại cạnh của 

thành phần và kéo đến vị trí mới trong đồ thị.  

 Ngoài ra có thể vào Chart Tools → Layout → chọn từ các danh sách thiết kế sẵn.  

 Để xóa thành phần nào, bạn chỉ cần dùng chuột chọn thành phần đó và nhấn phím Delete.  

 

Các thành phần trên đồ thị 

In đồ thị  

 In đồ thị cũng giống như in các đối tượng khác của Excel lưu ý Print Preview trước khi in để 

đảm bảo trang in được trọn vẹn nội dung.  

 Nếu bạn muốn in đồ thị thành một trang riêng thì hãy chọn đồ thị và nhấp nút Print để in, khi 

đó Excel chỉ ra lệnh in đồ thị mà bạn đang chọn.  

c. Hiệu chỉnh và định dạng đồ thị  

Việc hiệu chỉnh và định dạng các thành phần trên đồ thị ta có thể dùng Ribbon hay dùng các hộp 

thoại. Cách dễ thực hiện nhất là nhấp phải chuột lên thành phần cần định dạng và chọn Format 

… hay nhấn <Ctrl+1>. Sau đây là minh họa hiệu chỉnh và định dạng một số thành phần của đồ 

thị.  
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Hiệu chỉnh Chart Area  

 Chúng ta có thể hiệu chỉnh màu sắc, hiệu ứng, đường kẽ, khung, đổ bóng… cho Chart Area 

bằnh cách: chọn Chart Area → nhấp phải chuột → chọn Format Chart Area…  

 

Định dạng Chart Area 

 Ngoài ra bạn có thể vào Ribbon → Chart Tools → Format nhóm Shape Styles có cung  

cấp rất nhiều mẫu định dạng dựng sẵn rất đẹp.  

Ghi chú:  

 Fill: Nhóm lệnh liên quan đến tô nền cho thành phần đang chọn  

Border Color: Nhóm lệnh liên quan đến kẻ khung và màu sắc của thành phần đang chọn  

 Border Styles: Các kiểu đường két kẻ khung của thành phần đang chọn.  

 Shadow: Liên quan đến việc đổ bóng cho thành phần đang chọn  

 3-D Format: Tạo hiệu ứng 3-D cho thành phần đang chọn.  
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Định dạng bằng Ribbon 

Hiệu chỉnh Flot Area  

 Chọn Plot Area → Chart Tools → Format → Shape Styles → chọn kiểu định dạng  

Muốn phóng to/ thu nhỏ Plot Area → Nhấp chuột trái vào các nút bao quan Plot Area và 

kéo hướng vô Plot Area để thu nhỏ và hướng ra ngoài Plot Area để phóng to.  

Hiệu chỉnh tiêu đề đồ thị, chú thích, tiêu đề trục hoành và trục tung,…  

Tùy theo kiểu đồ thị đang xử lý mà E xcel cho phép bạn hiệu chỉnh các loại tiêu đề của kiểu đồ 

thị đó.  

 Để thêm tiêu đề chính cho đồ thị vào: Chart Tools → Layout → Labels → Chart Title 

→ lựa chọn kiểu từ danh sách  

 Để thêm tiêu đề cho trục hoành (hay trục tung) vào Chart Tools → Layout → Labels 

→ Axis Titles → lựa chọn kiểu từ danh sách  

 Để thêm chú thích vào Chart Tools → Layout → Labels → Legend → lựa chọn kiểu 

từ danh sách  

 Để thêm nhãn dữ liệu vào Chart Tools → Layout → Labels → Data Labels → lựa 

chọn kiểu từ danh sách  

 Để thêm bảng dữ liệu vào Chart Tools → Layout → Labels → Data Table → lựa 

chọn kiểu từ danh sách.  
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 Ngoài ra chúng ta có thể chèn các Text Box vào đồ thị Chart Tools → Layout → Insert 

→ Text Box.  

 

Hiệu chỉnh chú thích cho đồ thị từ hộp thoại Data Source 

Hiệu chỉnh đường lưới ngang và dọc  

 Muốn thêm hay bỏ đường lưới trước tiên bạn chọn Plot Area, rồi vào Chart Tools 

→ Layout → Axes → Gridlines → chọn kiểu phù hợp từ danh sách.  

 Để hiệu chỉnh màu sắc, kiểu của đường lưới nào thì chọn nó và vào Chart Tools → Format 

→ Shape Style → chọn kiểu và màu sắc theo nhu cầu.  

Hiệu chỉnh các trục Muốn hiệu chỉnh thông số cho trục trên đồ thị thì bạn hãy chọn trục 

→ nhấp phải chuột → chọn Format Axis… Sau đây là giải thích các thông số trong hộp 

thoại Format Axis. 
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Hộp thoại Format Axis tùy theo giá trị của trục mà bạn chọn 

Value Axis  

Hầu hết các đồ thị trình bày giá trị trên trục tung và phân nhóm trên trục hoành. Các bạn nên 

chọn thử để biết rõ hơn công dụng của các tùy chọn.  

Minimum Xác định giá trị nhỏ nhất trên trục (giá trị khởi đầu)  

o Auto Để Excel tự xác định  

o Fixed Qui định giá trị nhỏ nhất cho trục  

 Maximum Xác định giá trị lớn nhất trên trục (giá trị kết thúc)  

o Auto Để Excel tự xác định  

o Fixed Qui định giá trị nhỏ nhất cho trục  

 Major unit Xác định giá trị các khoảng chia chính trên trục.  

o Auto Để Excel tự xác định  
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o Fixed Qui định giá trị nhỏ nhất cho trục  

 Minor unit Xác định giá trị các khoảng chia phụ trên trục.  

o Auto Để Excel tự xác định  

o Fixed Qui định giá trị nhỏ nhất cho trục  

 Values in reverse order Đảo thứ tự sắp xếp các giá trị trên trục  

 Logarithmic scale Chuyển các giá trị trên trục sang hệ logarith với cơ số do ta qui định tại 

Base (không thể dùng cho giá trị âm hay bằng 0)  

 Display units Chọn đơn vị hiển thị trên trục.  

 Show display units label on chart Cho hiển thị các nhãn đơn vị trên đồ thị  

 Major tick mark type Qui định cách hiển thị ký hiệu phân cách chính trên đồ thị.  

o None Không sử dụng  

o Inside Hiển thị phía bên trong trục  

o Outside Hiển thị phía bên ngoài trục  

o Cross Hiển thị cắt ngang trục  

 Minor tick mark type Qui định cách hiển thị ký hiệu phân cách phụ trên đồ thị.  

 Axis labels Xác định cách hiển thị các nhãn trên trục  

o None Không sử dụng  

o High Hiển thị phía bên phải trục  

o Low Hiển thị phía bên trái trục  

o Next to Axis Hiển thị kế bên trục (theo mặc định)  

 Horizontal axis crosses Các lựa chọn qui định cách mà trục tung cắt trục hoành (Đối với đồ 

thị 3-D đó chính là tùy chọn Floor crosses at)  

o Automatic Do Excel tự xác định.  

o Axis value Xác định giá trị mà các trục sẽ giao nhau  

o Maximum axis value Hai trục sẽ giao nhau tại giá trị lớn nhất trên trục (tung)  

Category Axis  

 Interval between tick marks Xác định sự thể hiện các nhóm theo khoảng chia (có bao nhiêu 

nhóm trong một khoảng chia, thường là một nhóm).  
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 Interval between labels Xác định sự xuất hiện của nhãn theo khoảng chia  

o Automatic Excel tự xác định (thường là 1)  

o Specify interval unit Xác định nhãn sẽ xuất hiện sau bao nhiêu khoảng chia trên trục.  

 Categories in reverse order Các nhóm thể hiện theo thứ tự ngược lại  

 Label distance from axis Xác định khoảng cách của nhãn so với trục  

 Axis Type Xác định loại trục sử dụng như Automatic, Text axis hoặc Date axis  

 Major tick mark type Qui định cách hiển thị ký hiệu phân cách chính trên đồ thị.  

Minor tick mark type Qui định cách hiển thị ký hiệu phân cách phụ trên đồ thị.  

 Axis labels Xác định cách hiển thị các nhãn trên trục  

 Vertical axis crosses Các lựa chọn qui định cách mà trục tung cắt trục tung  

o Automatic Do Excel tự xác định.  

o At category number Xác định số nhóm mà tại đó các trục sẽ giao nhau  

o At maximum category Hai trục sẽ giao nhau tại giá trị lớn nhất trên trục  

 Position Axis Qui định cách hiển thị của các nhóm và nhãn trên trục (Dùng cho đồ thị 2-D area, 

column, và line).  

o On tick marks Hiện ngay ký hiệu phân cách  

o Between tick marks Hiện giữa các ký hiệu phân cách  

Time Scale Axis  

 Minimum Xác định giá trị (ngày) nhỏ nhất trên trục (ngày bắt đầu)  

 Maximum Xác định giá trị (ngày) lớn nhất trên trục (ngày kết thúc)  

 Major unit Xác định khoảng chia chính trên trục (đơn vị là ngày, tháng hay năm)  

 Minor unit Xác định khoảng chia phụ trên trục (đơn vị là ngày, tháng hay năm)  

 Base Unit Xác định đơn vị tính cho trục  

 Dates in reverse order Hiển thị theo thứ tự ngược lại trên trục  

 Axis Type Xác định loại trục sử dụng như Automatic, Text axis hoặc Date axis  

 Major tick mark type Qui định cách hiển thị ký hiệu phân cách chính trên đồ thị.  

 Minor tick mark type Qui định cách hiển thị ký hiệu phân cách phụ trên đồ thị.  
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 Axis labels Xác định cách hiển thị các nhãn trên trục  

 Vertical Axis crosses Các lựa chọn qui định cách trục tung giao với trục hoành  

o Between dates Do Excel tự xác định  

o At date Giao nhau tại ngày do bạn nhập vào  

o At maximum date Giao nhau tại ngày lớn nhất (gần đây nhất) trên trục  

 Position Axis Qui định cách hiển thị của các nhóm và nhãn trên trục (Dùng cho đồ thị 2-D area, 

column, và line).  

o On tick marks Hiện ngay ký hiệu phân cách  

o Between tick marks Hiện giữa các ký hiệu phân cách  

d. Các thao tác với chuỗi số liệu trong đồ thị  

Xóa bớt một chuỗi số liệu khỏi đồ thị  

 Chọn chuỗi số liệu trên đồ thị (Ví dụ: chọn đường cung)  

 Nhấn phím Delete trên bàn phím để xót chuỗi khỏi đồ thị  

 

Minh họa xóa chuỗi đường cung khỏi đồ thị 

Thêm chuỗi mới vào đồ thị  

 Chọn đồ thị cần thêm chuỗi mới vào.  

 Chart Tools → Design → Data → Select Data. Hộp thoại Select Data Source xuất hiện.  

 Nhấp nút Add, hộp thoại Edit Series xuất hiện  

 Đặt tên cho chuỗi mới tại Series Name (bằng tham chiếu hoặc nhập trực tiếp tên vào từ bàn 

phím) và chọn vùng chứa dữ liệu tại Series Values  
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 Ngoài ra ta có thể thêm nhanh chuỗi mới vào đồ thị bằng cách chép (Ctrl+C) dữ liệu của nó 

vào bộ nhớ, sau đó chọn đồ thị và dán (Ctrl+V) vào đồ thị.  

 

Minh họa thêm chuỗi dữ liệu của tháng 3/2008 vào đồ thị 

Thay đổi chuỗi số liệu  

Cũng với ví dụ trên nhưng ta muốn chỉ vẽ cho 2 sản phẩm Giày và Dép  

 Chọn đồ thị cần chỉnh sửa  

 Chart Tools → Design → Data → Select Data. Hộp thoại Select Data Source xuất hiện.  

 Chọn chuỗi cần chỉnh sửa, nhấp nút Edit, hộp thoại Edit Series xuất hiện  

 Chọn lại vùng dữ liệu mới tại Series Values. Làm tương tự cho các chuỗi số liệu khác.  
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Minh họa thay đổi chuỗi số liệu 

Ngoài ra chúng ta có thể sử dụng hàm Series cho đồ thị. Cú pháp như sau: = 

Series(series_name, category_labels, values, order, sizes) Trong đó:  

 Series_name: (tùy chọn) tham chiếu đến ô chứa tên chuỗi, bạn có thể nhập văn bản trực tiếp 

vào nhớ đặt trong cặp nháy kép.  

 Category_labels: (tùy chọn) tham chiếu đến vùng chứa các nhãn cho các nhóm số liệu trên 

trục, nếu bỏ trống Excel tự đánh số các nhóm bắt đầu là số 1. Có thể nhập trực tiếp các nhãn vào 

Tab cách nhau bằng dấu phẩy và đặt trong cặp ngoặc móc {}.  

 Values: (bắt buộc) tham chiếu đến vùng chứa số liệu của các chuỗi cần vẽ.  

 Order: (bắt buộc) Là số nguyên qui định thứ tự vẽ của các chuỗi (nếu đồ thị có nhiều hơn 1 

chuỗi)  

 Sizes: (chỉ dùng cho đồ thị bong bóng – Bubble chart) Tham chiếu đến vùng chứa dữ liệu về 

kích thước của bong bóng trong đồ thị kiểu Bubble (sử dụng trong phân tích tài chính). Các giá 

trị có thể nhập trực tiếp Tab cách nhau bằng dấu phẩy và đặt trong cặp ngoặc móc {}.  
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Minh họa hàm Series của chuỗi số liệu tháng 3/2008 

Thêm đường xu hướng vào đồ thị 

 Khi vẽ các đồ thị với dữ liệu theo thời gian chúng ta thường vẽ thêm đường xu hướng để biết 

được xu hướng trong tương lai của tập dữ liệu. Một tập số liệu có thể có nhiều đường xu hướng 

tùy theo cách phân tích của chúng ta. Để thêm đường xu hướng bạn vào:  

 Chart Tools → Layout → Analysis → Trendline → chọn kiểu đường xu hướng từ 

danh sách hay vào More Trendline Options…  



172 

Trung tâm Công nghệ thông tin và Truyền thông Nghệ An 

 

Minh họa thêm đường xu hướng vào đồ thị 

Chương 6: Định Dạng Trang Và In Bảng Tính 

6.1. Các chế độ hiển thị trang trong Excel 

Excel 2010 hỗ trợ mạnh hơn trong việc in ấn, với nhiều chế độ xem trực quan giúp bạn có thể thấy 

được kết quả in ngay trên màn hình. 

Có 3 chế độ hiển thị là Nornal View, Page Layout View và Page Break Preview. Để truy cập các 

chế độ xem vào nhóm View → chọn Workbook Views → chọn kiểu xem. 

• Normal View: Đây là chế độ bạn sử dụng thường xuyên trong quá trình nhập liệu, tính 

toán,… trên bảng tính và là chế độ mặc định của Excel. 

• Page Layout View: Là chế độ xem trước khi in, trong chế độ này bạn vẫn có thể tính 

toán và nhập liệu. 
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• Page Break Preview: Hiển thị bảng tính Excel với các dấu phân trang, tại đây bạn có thể 

chia lại trang bằng cách kéo thả các đường chia cách trang. 

6.2. Thiết lập thông số cho trang in 

Tất cả các tùy chọn thiết lập thông số trang in có tại nhóm Page Layout → nhóm Page Setup 

(Margins: tùy chọn lề trang, Orientation: chiều trang ngang hay dọc, Size: tùy chọn khổ giấy, Print 

Area: tùy chọn vùng in, Breaks: tùy chọn ngắt trang, Background: chèn hình nền, Print Titles: tùy 

chọn in tiêu đề lặp lại trên mỗi trang,…). Bạn có thể thiết lập các thông số tại đây hoặc vào hộp 

thoại Page Setup để điều chỉnh. Để vào hộp thoại Page Setup bạn vào nhóm Page Layout 

→ đến nhóm Page Setup → nhấn vào nút  
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Chiều trang in (Orientation) 

1. Ribbon → Page Layout → Page Setup → Orientation → chọn Portrait (trang dọc)/ 

chọn Landscape (trang ngang) 

2. Trong hộp thoại Page Setup → chọn ngăn Page → Orientation → chọn chiều trang in 

Portrait / Landscape  

Khổ giấy (Size) 

1. Ribbon → Page Layout → Page Setup → Size → chọn khổ giấy 

2. Trong hộp thoại Page Setup → chọn ngăn Page → Page size → chọn giấy 

Canh lề giấy (Margins) 

1. Ribbon → Page Layout → Page Setup → Margins → chọn kiểu chừa lề 

2. Trong hộp thoại Page Setup → chọn ngăn Margins → nhập các giá trị vào Top (lề trên), 

Bottom (lề dưới), Left (lề trái), Right (lề phải), Header (lề tiêu đề đầu trang), Footer (lề tiêu đề 

chân trang). Ngoài ra còn có tùy chọn canh giữa: Horizontally (canh giữa trang theo chiều ngang) 

và Vertically (canh giữa trang theo chiều dọc) 

Chọn vùng in (Set Print Area) 
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Quét chọn vùng cần in, vào Ribbon → Page Layout → Page Setup → Print Area → Set 

Print Area. 

Ngắt trang (Page Break) 

• Chèn ngắt trang ngang: Di chuyển ô hiện hành đến nơi sẽ chèn ngắt trang tại cột A, sau đó 

vào Ribbon → Page Layout → Page Setup Breaks → Insert Page Break. (Nếu 

không để ở cột A sẽ ngắt trang theo chiều ngang và dọc) 

• Bỏ từng dấu ngắt trang: Di chuyển ô hiện hành đến ô nằm ngay dưới dấu, sau đó vào 

Ribbon → Page Layout → Page Setup Breaks → Remove Page Break. 

• Bỏ tất cả đánh dấu ngắt trang: Ribbon → Page Layout → Page Setup Breaks 

→ Reset All Page Breaks. 

Thêm hình nền (Background) 

Vào Ribbon → Page Layout → Page Setup Background → chọn hình lưu trữ trên máy 

→ nhấn nút Insert 

In tiêu đề dòng và cột (Row and column headers) 

Vào Ribbon → Page Layout → Sheet Options Headings → chọn Print 

In tiêu đề cột và dòng lặp lại ở các trang 

B1. Vào Ribbon → Page Layout → Page Setup Print Title 

B2. Tại ô Rows to repeat at top ta quét chọn dòng số 1 vào → $1:$1 

B3. Tại ô Columns to repeat at left ta quét chọn cột A → $A:$A 

B4. Nhấn OK hoàn tất. 
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Hình minh họa chọn in lặp lại các tiêu đề dòng 1 và cột A 

Điều chỉnh tỉ lệ phóng to/ thu nhỏ trang in 

Trong một số trường hợp ta cần in nén hay phóng to nội dung vào một số trang nhất định khi đó 

ta dùng Ribbon → Page Layout → Scale To Fit → Scale. Ta có thể thu nhỏ tài liệu đến 10% 

và phóng to tới 400%. 

Ngoài ra ta có thể ép Excel in tài liệu ra với số trang ta qui định tại Ribbon → Page Layout 

→ Scale To Fit → Width và Ribbon → Page Layout → Scale To Fit → Height. 

 In đường lưới của các ô 

Để in đường lưới kẽ các ô trong bảng tính ta chọn Ribbon → Page Layout → Sheet Options 

→ Gridline → Print. 

Thêm thông tin vào đầu trang và chân trang (Header và Footer) 

Header chứa các thông tin xuất hiện ở đầu mỗi trang và Footer chứa các thông tin xuất hiện ở cuối 

mỗi trang. Các phiên bản trước ta dùng ngăn Hearder/ Footer trong hộp thoại Page Setup để thêm 

Header và Footer nhưng phiên bản này làm bằng một cách khác dễ dàng và trực quan hơn, đặc 

biệt có thể chèn hình vào. 
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Vào Ribbon → View → chuyển sang chế độ xem Page Layout → Tiến hành thêm Header 

và Footer vào. 

Lưu ý bạn phải nhấp chuột vào vùng Header hoặc Footer thì nhóm lệnh Design mới hiện ra. 

 

Các nút lệnh trong thanh Design 

Các mã lệnh và nút lệnh trong Header và Footer 

Nút lệnh Mã lệnh  Chức năng 

 
&[Page] Hiển thị số trang tài liệu 

 
&[Pages] Hiển thị tổng số trang được in 

 
&[Date] Hiển thị ngày hiện tại 

 
&[Time] Hiển thị giờ hiện tại 

 
&[Path]&[File] Hiển thị đường dẫn đầy đủ đến nơi lưu tập tin 

và Tên tập tin 

 
&[File] Hiển thị tên tập tin 

 
&[Tab] Hiển thị tên sheet 

 
Không có Chèn hình lựa chọn vào. Bạn phải tìm đến 

hình cần chèn vào trong hộp thoại Insert 

Picture, chọn hình và nhấn nút Insert. 

 
Không có Thiết lập các thông cố cho hình chèn vào. 

 

Do Excel dùng ký hiệu & để bắt đầu mã lệnh, do vậy trong trường hợp đoạn văn bản trong Header 

và Footer cần dùng ký hiệu & thì bạn hãy nhập ký hiệu này 2 lần &&. Ví dụ bạn muốn nhập 
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“Công thức & Hàm” vào Header thì hãy nhập “Công thức && Hàm”. Các lựa chọn khác của 

Header và Footer: 

• Different First Page: Nếu chọn thì bạn có thể thiết lập thông tin khác vào header/ footer 

của trang đầu tiên so với header/ footer của các trang còn lại trong tài liệu. 

• Different Odd & Even Pages: Nếu chọn, thì bạn có thể đặt header/ footer khác nhau cho 

các trang chẵn và các trang lẻ. 

• Scale With Document: Nếu chọn, kích thước chữ của header/ footer sẽ tăng giảm theo 

tài liệu khi tài liệu sử dụng chức năng in có điều chỉnh tỉ lệ phóng to/ thu nhỏ. 

• Align With Page Margins: Nếu chọn, lề trái và lề phải của header/ footer canh đều với 

lề trái và lề phải của tài liệu. 

6.3. Thiết lập thông số hộp thoại Print 

Để gọi hộp thoại Print, bạn chọn nút Office → chọn Print hay nhấn tổ hợp phím <Ctrl+P>. Dùng 

hộp thoại này để chọn máy in, chọn trang cần in, chọn số lượng bản sao và một số tùy chọn khác. 
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• Selection: Chỉ in vùng đang chọn trước nhấn lệnh Office → Print 

• Active sheet(s): Chỉ in sheet hiện hành hay các sheet đang chọn. 

• Entire workbook: In toàn bộ workbook 

• Table: Chỉ có tác dụng khi ô hiện hành đang trong một bảng, nếu chọn thì chỉ in bảng 

này. 

• Ignore print areas: Khi chọn, Excel sẽ bỏ qua tất cả các thiết lập vùng in đã thực hiện. 

6.4. Các lưu ý khác 

Ngăn không cho in một số vùng 
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Trong một số trường hợp, dữ liệu có các thông tin nhạy cảm mà bạn không muốn in ra. Khi đó bạn 

làm theo các cách sau. Ẩn các dòng hay cột chứa thông tin đó. Home → Cells → Format 

→ Chọn lệnh ẩn. 

• Tô màu chữ giống với màu nền của các ô. 

• Vẽ hình đè lên vùng dữ liệu nhạy cảm. 

Ngăn không cho in các đối tượng 

Một số đối tượng trên bảng tính như đồ thị, hình vẽ, SmartArt mà bạn không muốn in thì làm như 

sau: 

B1. Nhấp phải chuột lên đối tượng và chọn Size and Properties. 

B2. Chọn ngăn Properties trong hộp thoại 

B3. Bỏ lựa chọn tại Print Object. 

Chương 7: Làm Việc Với Macro, Templates 

7.1 Macro 

Macros là các tính năng cao cấp, có thể làm tăng tốc độ chỉnh sửa hay định dạng mà bạn có 

thể thực hiện thường xuyên trong một bảng tính Excel. Chúng ghi lại những hành động mà bạn 

đã chọn ở menu để cho một chuỗi các hành động đó có thể được hoàn thành trong một bước. 

Ghi một Macro 

Để ghi một Macro: 

• Kích tab View trên vùng Ribbon 

• Kích Macros 

• Kích Record Macro  

 

 

• Nhập tên cho Marco (không chứa dấu cách)  
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• Nhập một phím tắt 

• Nhập vào mục Description để giải thích hay mô tả 

 

Để thực hiện Macro:  

• Kích Macro 

• Kích Stop Recording 

 

Thực thi Macro  

Để thực thi một Macro từ phím tắt, chỉ cần ấn vào phím mà bạn đã chọn để chạy Macro. Hoặc bạn 

có thể xem tất cả các Macro và thực thi bằng cách: 

• Kích Macros 

• Kích View Macros 

• Chọn một Macro và kích Run 



182 

Trung tâm Công nghệ thông tin và Truyền thông Nghệ An 

 

Chương 8: Phím Tắt Và Thủ Thuật 

8.1 Phím Tắt 

a. Truy cập Ribbon bằng bàn phím 

Mới nhìn qua giao diện Excel chúng ta có thể tưởng rằng phải sử dụng Ribbon bằng chuột không 

thể dùng tổ hợp <ALT+ký tự đại diện> vì không có các ký gạch chân như các phiên bản trước. 

Tuy nhiên thanh Ribbon vẫn có thể truy cập bằng bàn phím. 

Khi muốn truy cập đến các nhóm lệnh trên thanh Ribbon như Home, Insert, … ta nhấn phím 

ALT một lần (không cần giữ phím ALT). Các ký tự đại diện cho các nhóm lệnh sẽ hiện lên, bạn 

chỉ cần nhấn phím trên bàn phím tương ứng ký tự đại diện cần truy cập. Ngoài ra bạn cũng có thể 

dùng các phím → để di chuyển trong thanh Ribbon.  

 

Để biết ký tự đại diện cho các nút lệnh, bạn hãy nhấn nhấn tổ hợp phím <ALT + ký tự đại diện 

của nhóm lệnh>. Ví dụ nhóm lệnh Page Layout (ký tự đại diện là P) → <ALT+P>.  

Khi muốn thực hiện một lệnh nào đó trên thanh Ribbon thì ta di chuyển ( → ) đến 

lệnh đó và nhấn phím Enter hay dùng <ALT + Ký tự đại diện cho nút lệnh>.  
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Khi muốn trở lại vùng làm việc trên bảng tính, ta nhấn phím ALT một lần hoặc nhấn phím 

ESC. 

b. Phím tắt 

Đôi lúc con chuột của máy tính hơi “dở chứng” và việc “quẳng” nó đi nhiều khi lại là biện 

pháp hay nhất. Nếu gặp trường hợp như thế thì danh sách phím tắt dưới đây thật sự cần 

thiết cho bạn và cho cả những ai còn con chuột nhưng muốn thao tác nhanh hơn: 

Phím tắt Ý nghĩa 

Enter Cài dữ liệu vào ô, di chuyển xuống dưới 

ESC Bỏ qua dữ liệu đang thay đổi 

F4 hay Ctrl+Y Lặp lại thao tác vừa làm 

Alt+Enter Bắt đầu dòng mới trong ô 

Backspace Xóa ký tự bên trái hoặc vùng chọn 

Delete Xóa ký tự bên phải hoặc vùng chọn 

Ctrl+Delete Xoá tất cả chữ trong một dòng 

Phím mũi tên Di chuyển lên xuống hoặc qua lại một ký tự 

Home Chuyển về đầu dòng 

Ctrl+D Chép dữ liệu từ ô trên xuống ô dưới 

Ctrl+R Chép dữ liệu từ bên trái qua phải 

Shift+Enter Ghi dữ liệu vào ô và di chuyển lên trên 

trong vùng chọn 

Tab Ghi dữ liệu vào ô vào di chưyển qua phải 

vùng chọn 

Shift+Tab Ghi dữ liệu vào ô vào di chưyển qua trái 
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vùng chọn 

Phím tắt Ý nghĩa 

= Bắt đầu một công thức 

F2 Hiệu chỉnh dữ liệu trong ô 

Backspace Xoá ký tự bên trái trong ô đang hiệu chỉnh 

Ctrl+F3 Đặt tên cho vùng chọn 

F3 Dán một tên đã đặt trong công thức 

F9 Cập nhật tính toán các Sheet trong Workbook 

đang mở 

Shift+F9 Cập nhật tính toán trong sheet hiện hành 

Alt+= Chèn công thức AutoSum 

Ctrl+; Cập nhật ngày tháng 

Ctrl+Shift+: Nhập thời gian 

Ctrl+K Chèn một Hyperlink 

Ctrl+Shift+” Chép giá trị của ô phía trên vào vị trí con 

trỏ của ô hiện hành 

Ctrl+’ Chép giá trị của ô phía trên vào vị trí con 

trỏ của ô hiện hành 

Ctrl+A Hiển thị Formula Palette sau khi nhấp một 

tên hàm vào công thức 

Ctrl+Shift+A Chèn dấu ( ) và các đối số của hàm sau khi 

nhập tên hàm vào công thức 
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Định dạng dữ liệu 

Phím tắt Ý nghĩa 

Ctrl+1 Hiển thị lệnh Cell trong menu Format 

Ctrl+Shift+~ Định dạng số kiểu General 

Ctrl+Shift+$ Định dạng số kiểu Curency với hai chữ số 

thập phân 

Ctrl+Shift+% Định dạng số kiểu Percentage (không có chữ 

số thập phân) 

Ctrl+Shift+^ Định dạng số kiểu Exponential với hai chữ 

số thập phân 

Ctrl+Shift+# Định dạng kiểu Data cho ngày, tháng, năm 

Ctrl+Shift+? Định dạng kiểu Numer với hai chữ số thập 

phân 

Ctrl+Shift+& Thêm đường viền ngoài 

Ctrl+Shift+ - Bỏ đường viền 

Ctrl+B Bật tắt chế độ đậm, không đậm 

Ctrl+I Bật tắt chế độ nghiêng, không nghiêng 

Ctrl+U Bật tắt chế độ gạch dưới 

Ctrl+5 Bật tắt chế độ gạch giữa không gạch giữa 

Ctrl+9 Ẩn dòng 

Ctrl+Shift+( Hiển thị dòng ẩn 
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8.2 Thủ thuật 

- Dịch số tiền về chữ (Chuyển số thành chữ) 

Bước 1. Mở tập tin cần chuyển >> Nhấn tổ hợp phím Alt + F11 để mở trình soạn thảo VBA của 

Excell 

Bước 2. Nhấp chuột phải lên VBA Project >> Insert >> Module >> và dán đoạn mã bên dưới 

vào cửa sổ của Module mới chèn 

Function ConvertCurrencyToVietnamese(ByVal MyNumber) 

Dim Temp 

Dim Dollars, Cents 

Dim DecimalPlace, Count  

ReDim Place(9) As String 

Place(2) = " Nghin " 

Place(3) = " Trieu " 

Place(4) = " Ty " 

Place(5) = " Ngan ty "  

' Convert MyNumber to a string, trimming extra spaces. 

MyNumber = Trim(Str(MyNumber))  

' Find decimal place. 

DecimalPlace = InStr(MyNumber, ".")  

' If we find decimal place… 

If DecimalPlace > 0 Then 

' Convert cents 

Temp = Left(Mid(MyNumber, DecimalPlace + 1) & "00", 2) 

Cents = ConvertTens(Temp)  

' Strip off cents from remainder to convert. 

MyNumber = Trim(Left(MyNumber, DecimalPlace - 1)) 

End If  

Count = 1 

http://helloict.com/excel-dich-so-tien-ve-chu-546
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Do While MyNumber <> "" 

' Convert last 3 digits of MyNumber to English dollars. 

Temp = ConvertHundreds(Right(MyNumber, 3)) 

If Temp <> "" Then Dollars = Temp & Place(Count) & Dollars 

If Len(MyNumber) > 3 Then 

' Remove last 3 converted digits from MyNumber. 

MyNumber = Left(MyNumber, Len(MyNumber) - 3) 

Else 

MyNumber = "" 

End If 

Count = Count + 1 

Loop  

' Clean up dollars. 

Select Case Dollars 

Case "" 

Dollars = "khong Nghin" 

Case "One" 

Dollars = "Mot Nghin" 

Case Else 

Dollars = Dollars & " Nghin" 

End Select  

' Clean up cents. 

Select Case Cents 

Case "" 

Cents = " va khong Dong" 

Case "One" 

Cents = " va mot Dong" 
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Case Else 

Cents = " va " & Cents & " Dong" 

End Select  

ConvertCurrencyToVietnamese = Dollars & Cents 

End Function  

Private Function ConvertHundreds(ByVal MyNumber) 

Dim Result As String  

' Exit if there is nothing to convert. 

If Val(MyNumber) = 0 Then Exit Function  

' Append leading zeros to number. 

MyNumber = Right("000" & MyNumber, 3)  

' Do we have a hundreds place digit to convert? 

If Left(MyNumber, 1) <> "0" Then 

Result = ConvertDigit(Left(MyNumber, 1)) & " Tram " 

End If  

' Do we have a tens place digit to convert? 

If Mid(MyNumber, 2, 1) <> "0" Then 

Result = Result & ConvertTens(Mid(MyNumber, 2)) 

Else 

' If not, then convert the ones place digit. 

Result = Result & ConvertDigit(Mid(MyNumber, 3)) 

End If  

ConvertHundreds = Trim(Result) 

End Function  

Private Function ConvertTens(ByVal MyTens) 

Dim Result As String  

' Is value between 10 and 19? 
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If Val(Left(MyTens, 1)) = 1 Then 

Select Case Val(MyTens) 

Case 10: Result = "Muoi" 

Case 11: Result = "Muoi mot" 

Case 12: Result = "Muoi hai" 

Case 13: Result = "Muoi ba" 

Case 14: Result = "Muoi bon" 

Case 15: Result = "Muoi lam" 

Case 16: Result = "Moi sau" 

Case 17: Result = "Muoi bay" 

Case 18: Result = "Muoi tam" 

Case 19: Result = "Muoi chin" 

Case Else 

End Select 

Else 

' .. otherwise it’s between 20 and 99. 

Select Case Val(Left(MyTens, 1)) 

Case 2: Result = "Hai muoi " 

Case 3: Result = "Ba muoi " 

Case 4: Result = "Bon muoi " 

Case 5: Result = "Nam muoi " 

Case 6: Result = "Sau muoi " 

Case 7: Result = "Bay muoi " 

Case 8: Result = "Tam muoi " 

Case 9: Result = "Chin muoi " 

Case Else 

End Select  
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' Convert ones place digit. 

Result = Result & ConvertDigit(Right(MyTens, 1)) 

End If  

ConvertTens = Result 

End Function  

Private Function ConvertDigit(ByVal MyDigit) 

Select Case Val(MyDigit) 

Case 1: ConvertDigit = "Mot" 

Case 2: ConvertDigit = "Hai" 

Case 3: ConvertDigit = "Ba" 

Case 4: ConvertDigit = "Bon" 

Case 5: ConvertDigit = "Nam" 

Case 6: ConvertDigit = "Sau" 

Case 7: ConvertDigit = "Bay" 

Case 8: ConvertDigit = "Tam" 

Case 9: ConvertDigit = "Chin" 

Case Else: ConvertDigit = "" 

End Select 

End Function 

Bước 3. Nhấn phím Alt + F11 một lần nữa và nhấn Ctrl + S để save lại toàn bộ tài liệu. 

Bước 4. Đến đây, bạn có thể sử dụng công thức =ConvertCurrencyToVietnamese(B3) để 

chuyển đổi tiền tệ từ số về chữ (với B3 là số tiền bằng chữ số) 

Ví dụ: B3 có giá trị là: 123456 thì kết quả =ConvertCurrencyToVietnamese(B3) trả về là Mot 

Tram Hai muoi Ba Nghin Bon Tram Nam muoi Sau Nghin va khong Dong 

- Giấu bảng tính Excel chuyên nghiệp 

Trong công việc văn phòng, nếu bạn cần giấu một bảng tính trong tài liệu Excel mà không muốn 

người khác dùng lệnh Format > Sheet > Unhide để xem bảng tính, mà theo cách thông thường khi 

bạn dùng lệnh Format > Sheet > Hide để giấu các bảng tính (nếu không được bảo vệ bằng mật 
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khẩu) thì chỉ cần người không chuyên thôi cũng đã có thể dùng lệnh Format > Sheet > UnHide để 

làm cho nó hiện ra bảng tính rồi. 

 

Nhưng khi bạn áp dụng thủ thuật này thì bảng tính của bạn sẽ được an toàn hơn rất nhiều và đây 

cũng là một "phương án" mới để các bạn đọc tham khảo và có thêm được nhiều sự lựa chon trong 

công việc của mình Các thực hiện như sau: Trong bảng tính cần được bảo mật, bạn hãy nhấn 

ALT+F11 để mở cửa sổ Microsoft Visual Basic ra. Trong cửa sổ Project - VBA Project, nhắp đúp 

vào VBA Project, tiếp tục nhắp đúp vào Microsoft Excel Objects để mở các bảng tính trong tài 

liệu sau đó rồi chọn bảng tính mà bạn muốn giấu -> rồi nhấn F4. Trong tùy chọn Visible bạn nhắp 

vào dấu tam giác chọn 2-xlSheetVeryHidden, cuối cùng đóng Microsoft Visual Basic này lại và 

xem kết quả thế nào Khi nào muốn bảng tính hiện ra trở lại, thì bạn chỉ cần thực hiện lại các thao 

tác trên và chọn -1-xlSheetVisible là được. 

- Khóa và bảo vệ những ô có chứa công thức 

Chiêu này giúp bạn cho phép người khác thay đổi các ô có chứa dữ liệu, nhưng cấm họ thay 

đổi các ô chứa công thức. Bạn cũng có thể bảo vệ các ô có chứa công thức mà không cần phải 

bảo vệ toàn bộ trang tính của bạn. 

Khi tạo một bảng tính, thường chúng ta sẽ phải dùng đến một số công thức, và khi chia sẻ bảng 

tính cho mọi người, có thể bạn muốn rằng, không ai có thể can thiệp (xóa, sửa...) những vào những 

ô có chứa công thức. Cách dễ nhất là cũng phổ biến nhất là Protect (bảo vệ) bảng tính. Tuy nhiên, 

Protect bảng tính không chỉ ngăn không cho can thiệp vào các ô chứa công thức, mà nó không cho 

can thiệp vào tất cả, nghĩa là không ai có thể làm gì bảng tính của bạn. Đôi khi, bạn lại không 
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muốn như vậy, bạn chỉ muốn bảo vệ các ô chứa công thức thôi, còn những ô chứa dữ liệu thì 

không. 

Có ba giải pháp để thực hiện điều này: Khóa những ô chứa công thức, sử dụng chức năng Data-

validation cho các ô chứa công thức, và tự động bật tắt chức năng bảo vệ. 

Khóa các ô chứa công thức 

Theo mặc định, tất cả các ô trong bảng tính đều được khóa (locked), tuy nhiên, nó chẳng có tác 

dụng gì trừ phi bạn áp dụng lệnh Protect bảng tính. Đây là cách dễ nhất để áp dụng lệnh Protect 

cho bảng tính, nhưng chỉ những ô chứa công thức thì mới bị khóa, và được bảo vệ: 

Chọn toàn bộ bảng tính, bằng cách nhấn Ctrl+A, hoặc nhấn vào cái ô vuông nằm ở giao điểm của 

cột A và hàng 1. Rồi nhấn nút phải chuột và chọn Format Cells, rồi trong tab Protection, bỏ đánh 

dấu ở tùy chọn Locked, rồi nhấn OK: 

 

Mở khóa (Unlock) toàn bộ bảng tính bằng cách bỏ tùy chọn Locked 

Sau đó, bạn chọn đại một ô nào đó, chọn Home ➝ Find & Select ➝ Go To Special; hoặc nhấn 

Ctrl+G hay F5 rồi nhấn vào nút Special.... Hộp thoại sau đây sẽ mở ra: 
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Dùng hộp thoại Go To Special để chọn các ô có chứa công thức 

Trong hộp thoại đó, bạn nhấn vào tùy chọn Formulas, và nếu cần thiết thì chọn hoặc không chọn 

thêm 4 ô nhỏ ở dưới (liệt kê các loại công thức, mặc định thì cả 4 ô này đều được chọn), và nhấn 

OK. Sau đó, bạn mở lại hộp thoại Format Cells đã nói ở trên, nhưng lần này thì bạn đánh dấu vào 

tùy chọn Locked, và nếu bạn thích ẩn luôn công thức (không cho thấy) thì đánh dấu vào tùy chọn 

Hidden, nhấn OK. 

Việc cuối cùng là Protect bảng tính: Chọn Home trên Ribbon, nhấn vào Format trong nhóm Cells, 

rồi nhấn vào Protect Sheet...; hoặc chọn Review trên Ribbon, rồi nhấn vào Protect Sheet [E2003: 

Tools | Protection | Protect Worksheet]:  
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Chọn Protect Sheet từ Home 

 

Chọn Protect Sheet từ Review 

Trong hộp thoại Protect Sheet, bỏ đánh dấu ở tùy chọn Select locked cells, chỉ cho phép Select 

unlocked cells (chọn những ô không khóa), và nhập vào một password, nếu cần thiết: 
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Bỏ tùy chọn Select locked cells trong hộp thoại Protect Sheet 

Vậy là xong. Từ bây giờ, những ô chứa công thức của bạn sẽ được bảo vệ, có thể không xem thấy 

được nếu bạn đã chọn Hidden, bạn không lo những công thức này bị can thiệp nữa. 

Sử dụng Data-validation 

Sử dụng Data-validation, chỉ là đơn giản không cho ghi đè vào những ô có chứa công thức, nghĩa 

là không cho sửa công thức. Tuy nhiên, phương pháp này chỉ phòng ngừa cho chính bạn, nghĩa là 

tránh việc táy máy sửa lại cái gì đó trong những ô chứa công thức, chứ thật ra, mặc dù đã được 

"Validation", bạn vẫn có thể xóa công thức, hoặc dán vào những ô đó bất kỳ dữ liệu nào bạn thích... 

Nói chung nó không bảo vệ được gì nhiều. Nhưng cũng xin nói sơ qua về phương pháp này: 

Để thực hiện, bạn hãy chọn những ô chứa ô công thức bằng chức năng Go To Specials mà tôi đã 

nói ở trên. Rồi, với những ô chứa công thức đang được chọn, bạn gọi Data Validation từ menu 

Data trên Ribbon [E2003: Data | Validation]. Trong hộp thoại này, chọn tab Settings, chọn 

Custom cho khung Allow, và nhập công thức này: =" " vào khung Formula, rồi nhấn OK, như 

hình sau: 
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Sử dụng Data Validation để bảo vệ những ô chứa công thức 

Kể từ đây, mỗi khi bạn nhập bất kỳ thứ gì vào trong những ô chứa công thức, hoặc bạn muốn sửa 

lại công thức, sẽ có một cảnh báo xuất hiện, ngăn không cho bạn nhập vào. Xin nhắc lại, phương 

pháp này không cấm việc xóa hẳn công thức, cũng như dán đè thứ gì đó vào những ô chứa công 

thức. 

Tự động bật tắt chức năng bảo vệ 

Phương pháp này, sẽ tự động bật chức năng bảo vệ bảng tính (Protect) mỗi khi bạn chọn một ô đã 

được khóa (locked), nhưng nó cũng sẽ tự động tắt chức năng bảo vệ khi bạn chọn một ô không bị 

khóa. 

Để bắt đầu, bạn hãy chắc chắn rằng những ô bạn muốn bảo vệ (ô chứa công thức) đã được khóa, 

còn những ô không cần bảo vệ thì không bị khóa, như tôi đã trình bày ở phương pháp thứ nhất. 

Sau đó, bạn nhấn Alt+F11, nhấn vào Sheet mà bạn muốn bảo vệ các ô đã khóa ở trong đó, rồi 

nhập vào trong khung soạn thảo đoạn code sau đây:  

Private Sub Worksheet_SelectionChange(ByVal Target As Range)  

  If Target.Locked = True Then  

    Me.Protect Password:="Secret"  

  Else  

    Me.Unprotect Password:="Secret"  

  End If  

End Sub  
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Nếu không cần đến password, bạn không cần dùng đoạn Password:="Secret", hoặc nếu muốn 

Password là thứ gì khác, bạn sửa lại chữ Secret bằng cái bạn muốn. 

Nếu bạn lo rằng người ta có thể vào trong khung soạn thảo VBA để xem password, bạn có thể bảo 

vệ các code này (không cho xem) bằng cách chọn Tools ➝ VBAProject Properties, chọn tab 

Properties, chọn Lock Project for Viewing, và nhập vào một password. 

Tuy nhiên, phương pháp này cũng không hoạt động hoàn hảo, mặc dù nó cũng giúp bạn được phần 

nào việc bảo vệ các công thức. Từ khóa Target được sử dụng trong đoạn code sẽ chỉ để tham chiếu 

đến ô đang "active" ngay tại thời điểm nó được chọn (xin nói thêm, cho dù bạn chọn một dãy, 

nhưng trong dãy đó, chỉ có một ô "active" mà thôi, là ô đang có màu khác với những ô còn lại). Vì 

lý do này, nếu một người nào đó chọn một dãy các ô (với ô "active" không bị khóa), thì người đó 

có thể xóa toàn bộ dãy ô này, bởi vì khi đó thì chức năng Unprotect đã được tự động bật! 

- Sử dụng Data-Validation khi danh sách nguồn nằm trong một Sheet khác  

Sử dụng Data-Validation là một cách dễ nhất để áp dụng một quy tắc nhập liệu cho một dãy dữ 

liệu. Theo mặc định, Excel chỉ cho phép Data-Validation sử dụng những danh sách nguồn nằm 

trong cùng một Sheet với dãy dữ liệu sẽ được áp dụng quy tắc này. Tuy nhiên, vẫn có cách để 

lách khỏi chuyện đó. 

Chiêu này sẽ giúp bạn làm cho Data-Validation có thể sử dụng những danh sách nguồn nằm trong 

một Sheet khác. Cách thứ nhất là lợi dụng chính việc đặt tên cho một dãy của Excel, cách thứ hai 

là sử dụng một hàm để gọi ra danh sách đó. 

Cách 1: Sử dụng Name cho dãy nguồn 

Có lẽ cách nhanh nhất và dễ nhất để vượt qua rào cản Data-Validation của Excel là đặt tên cho dãy 

mà bạn sẽ dùng làm quy tắc nhập liệu. Để biết cách đặt tên cho dãy, bạn xem ở loạt bài này: Sử 

dụng tên cho dãy.  

Giả sử bạn đã đặt tên cho dãy sẽ dùng làm quy tắc nhập liệu là MyRange. Bạn chọn ô (hoặc dãy) 

trong bất kỳ Sheet nào mà bạn muốn có một danh sách xổ ra để nhập liệu, rồi trong menu Data 

trên Ribbon, bạn chọn Data Tools | Data Validation [E2003: Data | Validation]. Chọn List trong 

danh sách các Allow, và trong khung Source, bạn nhập vào =MyRange. Nhấn OK. Bởi vì bạn đã 

sử dụng một Name để làm List, nên bạn có thể áp dụng Data-Validation này cho bất kỳ Sheet nào. 
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Cách 2: Sử dụng hàm INDIRECT 

Hàm INDIRECT() cho phép bạn tham chiếu đến ô chứa dữ liệu text đại diện cho một địa chỉ ô. 

Và rồi bạn có thể sử dụng ô đó như môt tham chiếu cục bộ, cho dù nó tham chiếu đến dữ liệu trong 

một Sheet khác. Bạn có thể sử dụng tính năng này để tham chiếu đến nơi chứa dãy mà bạn sẽ dùng 

làm danh sách nguồn cho quy tắc Data-Validation. 

Giả sử, dãy chứa danh sách nguồn này nằm ở Sheet1, trong dãy $A$1:$A$8. Để tạo một Dala-

Validation, bạn cũng làm những bước như tôi đã nói ở cách 1, nhưng thay vì gõ tên dãy vào trong 

Source, thì bạn nhập vào đó công thức: =INDIRECT("Sheet1!$A$1:$A$8"). Hãy chắc chắn rằng 

tùy chọn In-cell drop-down đang được kích hoạt, và nhấn OK.  
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Nếu tên Sheet của bạn có chứa khoảng trắng, hoặc có dấu tiếng Việt, bạn phải đặt tên Sheet trong 

một cặp nháy đơn ('). Ví dụ, giả sử tên Sheet chứa danh sách nguồn là Sheet 1 (chứ không phải 

Sheet1), thì bạn sửa công thức trên lại như sau: =INDIRECT("'Sheet 1'!$A$1:$A$8"). Chỗ khác 

nhau so với công thức hồi nãy là có thêm một dấu nhấy đơn (') sau dấu nháy kép ("), và một dấu 

nháy đơn (') nữa trước dấu chấm than (!). 

Xin mở một ngoặc đơn: Nếu như có thể được, khi gặp những tham chiếu đến tên Sheet, bạn nên 

tập thói quen luôn luôn bỏ nó vào trong cặp dấu nháy đơn. Điều này, tuy chẳng có tác dụng gì với 

những tên sheet như Sheet1, DMHH... nhưng nó sẽ giúp bạn không bao giờ gặp lỗi, khi bạn hay 

đặt tên Sheet có khoảng trắng, hay là có bỏ dấu tiếng Việt... 

Ưu điểm và Khuyết điểm của cả hai cách đã nêu trên 

Đặt tên cho dãy, và dùng hàm INDIRECT, đều có cái tiện lợi và cả cái bất tiện. 

Tiện lợi của việc đặt tên cho dãy, là việc bạn thay đổi tên Sheet chẳng có ảnh hưởng gì đến Data-

Validation. Và đó chính là cái bất tiện của việc dùng INDIRECT, khi bạn đổi tên Sheet, tên mới 

sẽ không tự động cập nhật trong công thức dùng INDIRECT, cho nên nếu vẫn muốn dùng công 

thức này, bạn phải mở Data-Validation ra và sửa lại tên Sheet trong công thức. 

Tiện lợi của việc dùng INDIRECT, là dãy dùng làm danh sách nguồn của bạn luôn luôn nằm yên 

chỗ đã chọn (A1:A8 trong ví dụ trên chẳng hạn). Còn nếu bạn dùng Name, mà bạn lỡ tay xóa mất 

vài hàng (hoặc cột) ngay chỗ chứa Name, thì bạn phải điều chỉnh lại cho đúng...    

- Điều khiển Conditional Formating bằng checkbox.  

Mặc dù Conditional Formating là 1 trong những chiêu mạnh của Excel, nhưng muốn bật hay tắt 

nó bằng ribbon hay menu thì khá bực bội. Bây giờ ta biến hoá bằng cách điều khiển bằng 1 

checkbox giống như 1 công tắc (hoặc 1 cái toggle Button càng giống hơn). 

Conditional Formating có từ đời Excel 97, gán định dạng cho những ô nào thoả 1 số điều kiện nào 

đó. Điều kiện có thể là 1 điều kiện về giá trị, nhưng ta có thể tuỳ biến nhiều hơn khi dùng điều 

kiện là công thức, dựa vào đó ta có thể thay đổi định dạng cho những ô này, khi có sự thay đổi giá 

trị của ô khác. 

1. Dùng 1 Checkbox hoặc 1 Toggle Button để xem và ẩn dữ liệu: 

Bạn muốn một vùng dữ liệu nào đó chỉ hiện ra lúc cần xem, xem xong thì biến đi cho rảnh. Trước 

tiên bạn phải gán lên sheet 1 Checkbox hoặc 1 Toggle Button. Trong Excel 2010, vào tab 

Developer, nhấn Insert trong Controls - chọn Checkbox hoặc Toggle Button trong Control 

Toolbox, trong Excel 2003 chọn trong view – Toolbar – Control Toolbox, vẽ lên sheet 1 cái. Trong 

hình, tôi làm thử 2 cái. 
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.................

 

Nhấn vào nút design, click chọn cái control bạn vừa vẽ, nhấn thêm nút Property. Trong cửa sổ 

Property, sửa dòng Caption thành View/ Hide, sửa dòng Linked Cell thành $C$2. (cả 2010 và 

2003 như nhau, cả checkbox và Toggle Button như nhau). 
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Bây giờ khi bạn click chọn checkbox hoặc nhấn nút Toggle, ô C2 sẽ lần lượt có các giá trị TRUE 

và FALSE. 

..................  

Bây giờ giả sử vùng dữ liệu của bạn gồm 4 fields, trong đó bạn chỉ muốn 3 fields hiện thường 

xuyên, còn field thứ 4 thì khi nào cần mới hiện ra để xem, không cần thì dấu đi. Bạn đánh dấu 

chọn vùng chứa field 4, trong 2010 bạn vào tab Home, Conditional Formating, New Rule, chọn 

tiếp “use a formula to determine which cells to format”, trong 2003 là Fornat - Conditional 

Formating - chọn tiếp “Formula is”. Trong ô kế bến, bạn gõ: = $C$2=FALSE. 
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Nhấn vào nút Format, định dạng font chữ màu trắng. Nhấn OK và OK. Nhấn nút design 1 lần nữa 

để thoát ta khõi chế độ design Mode. Và nhấn nút toggle hoặc click chọn cái checkbox xem kết 

quả. 
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............

 

Nếu bạn không thích thì định dạng ô C2 chữ trắng luôn, để khỏi thấy chữ TRUE, FALSE hiện lên. 

2. Tắt mở định dạng màu cho ô: 

Dùng Conditional Formating nhằm tô màu ô theo điều kiện giúp ta dễ tìm được những ô có giá trị 

đặc biệt cho trước. Excel 2010 có nhiều định dạng khác nhau cho giá trị số nằm trong khoảng cho 

trước. Nhưng biện pháp để mở tắt bằng checkbox là không có sẵn. 
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Tương tự như phần trên, ta tạo ra 1 checkbox hoặc 1 Toggle Button link tới ô $C$2. Nhưng lần 

này ta đặt name cho nó là IsFill chẳng hạn. Ta cũng đặt name cho ô $A$2 là BeginNum và $B$2 

là EndNum, với A2 là giới hạn dưới thí dụ 100, và B2 là giới hạn trên thí dụ 1.000. 

Trong vùng dữ liệu B5:B16, ta muốn giá trị nào nằm trong khoảng BeginNum và EndNum sẽ được 

tô màu. Vậy dùng conditional Formating như trên, chọn vùng C8:C18, lần này công thức là:  

=AND($C8>=BeginNum,$C8<=EndNum,IsFill) 

Chọn cho nó 1 định dạng màu theo ý muốn. 

Kết quả: khi nhấn button hoặc click checkbox thay đổi trạng thái thành True, các ô chứa số trong 

khoảng (100, 1.000) sẽ được tô màu, các ô còn lại không tô. Khi thay đổi thành False, các ô trở lại 

bình thường. 

Đồng thời, vì bạn đặt công thức liên quan đến BeginNum và EndNum, nên khi thay đổi 2 số này, 

kết quả tô màu cũng thay đổi.  
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............

 

Bạn thấy đấy, nếu bạn chưa xem bài này mà thấy 1 file tương tự của người khác, bạn có thể lầm 

tưởng người ta sử dụng code của VBA.  

- Đánh dấu những ô chứa công thức bằng Conditional Formatting  

Khi một ô có chứa dữ liệu, bạn có thể muốn biết dữ liệu trong ô đơn thuần là dữ liệu nhập vào, 

hay dữ liệu là kết quả của 1 công thức. Bạn có thể chỉ cần click chọn ô đó và xem trên thanh công 
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thức. Bạn cũng có thể dùng phím tắt Ctrl + ~ để chuyển qua lại giữa chế độ xem giá trị và xem 

công thức. 

Chiêu số 19 này sẽ giới thiệu với bạn 1 hàm tự tạo, kết hợp với Conditional Formatting để đánh 

dấu ô chứa công thức. Bằng cách này có thể giúp bạn tìm ra tất cả những ô chứa công thức trong 

số 10.000 ô mà không phải ngó từng ô một. 

Mặc dù bạn có thể dùng 1 hàm có sẵn của Macro4 trong Conditional Formatting, như sau: 

Trong hộp thoại Conditional Formatting, chọn công thức, gõ công thức này: = CELL(“type”,A1). 

Nhưng hạn chế của việc dùng hàm Cell() là công thức sẽ tự tính lại mỗi khi có sự thay đổi nhỏ xíu 

trong bảng tính. Vì Cell() là 1 hàm thuộc loại volatile. Khi Excel tính lại Cell() cho 10.000 ô như 

trên sẽ khiến cho bạn bực mình vì chờ đợi. 

Do đó bạn hãy dùng tuyệt chiêu sau đây, đơn giản, dễ làm và không phải hàm loại volatile: 

Bạn hãy nhấn Alt – F11 để vào cửa sổ VBA, nhấn chuột phải vào This Workbook để insert vào 1 

module. Nhập đoạn code sau vào khung soạn thảo:  

Function IsFormula (CheckCells As Range)  

IsFormula = CheckCells.HasFormula  

End Function  

Do tính chất của Property HasFormula, hàm bạn mới tạo sẽ trả về các giá trị luận lý True, False. 

Nghĩa là khi bạn gõ vào ô bất kỳ công thức = IsFormula(A1) sẽ cho kết quả True nếu A1 chứa 

công thức và cho kết quả False nếu A1 chứa giá trị. 

Đóng cửa sổ VBA lại, trở về bảng tính. Bây giờ đánh dấu toàn bộ vùng dữ liệu của bạn (có thể 

chọn dư ra một số cột và dòng, phòng khi bạn cập nhật thêm dữ liệu) sao cho ô A1 là ô hiện hành. 

Bằng cách như chiêu số 18, bạn vào được chỗ cần thiết để gõ công thức trong hộp thoại Conditional 

Formatting, và gõ vào: 

=IsFormula(A1), sau đó định dạng tô màu hoặc đổi màu chữ cho khác những ô còn lại. 

Sau khi nhấn OK bạn sẽ được kết quả là tất cả những ô chứa công thức sẽ được tô màu. Nếu bạn 

thêm hoặc thay đổi 1 ô, nếu ô đó trở thành công thức thì lập tức ô đó đổi màu. 

Đôi khi bạn không thấy kết quả, vì anh Bill lanh chanh và chậm hiểu, anh ta cho rằng công thức 

sử dụng hàm của bạn là 1 text nên ảnh tự sửa thành : =”IsFormula(A1)”. Vậy bạn phải vào chỗ cũ 

sửa lại. 

Bây giờ mỗi khi bạn sửa hoặc thêm 1 ô trở thành công thức, ô đó sẽ có màu. ngược lại, nếu bạn 

sửa 1 công thức thành giá trị hoặc thêm giá trị vào 1 ô, ô đó sẽ không có màu. 
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- Sử dụng chức năng thay thế (Replace) để gỡ bỏ các ký tự không mong muốn. 

Khi nhập dữ liệu hay khi sao chép và dán dữ liệu từ nguồn khác vào Excel thì các ký tự không 

mong muốn sẽ xuất hiện trong toàn bộ bảng tính của bạn. Sử dụng chiêu này bạn có thể khắc phục 

được những rắc rối khi gỡ bỏ các ký tự không mong muốn bằng tay. Chức năng thay thế (replace) 

trong Excel có thể giúp bạn gỡ bỏ các ký tự không mong muốn trong bảng tính, nhưng phải qua 

một vài bước phụ. 

Ví dụ như, bạn có thể thay thế những ký tự không mong muốn bằng chuỗi rỗng tựa như nó chưa 

hề tồn tại. Muốn vậy bạn cần biết mã của từng ký tự mà bạn muốn gỡ bỏ. Tất cả các ký tự đều 

mang một mã riêng và Excel sẽ cho bạn biết nó là gì khi bạn sử dụng hàm CODE. 

Hàm CODE sẽ trả về một mã số cho ký tự đầu tiên trong một chuỗi. Mã này tương đương ký tự 

mà máy tính của bạn đã thiết lập. 

Để thực hiện điều này, chọn một trong các ô có chứa những ký tự không mong muốn. Từ thanh 

công thức, bôi đen ký tự và sao chép ký tự đó. Tiếp theo chọn ô trống bất kỳ (A1 chẳng hạn) và 

dán ký tự đó vào ô đã chọn (A1). 

Tại ô khác, nhập công thức sau: 

=CODE($A$1) 

Công thức này trả về mã của ký tự không mong muốn. 

Chọn toàn bộ dữ liệu của bạn, chọn Home ➝ Editing ➝ Find & Select ➝ Replace (với phiên bản 

trước Excel 2010: chọn Edit ➝ Replace…), ở khung Find what: nhấn phim Alt và gõ số 0 kèm 

theo code đã đưa ra bởi công thức trên. Nếu mã số là 163 thì nhấn Alt và nhấn 0163. (Hoặc bạn có 

thể để con trỏ chuột tại ô có ký tự không mong muốn, sao chép ký tự đó và dán vào ô Find what 

cũng được) 

Bỏ trống khung Replace With và nhấn Replace all. Việc làm này sẽ xóa bỏ tất cả những ký tự 

không mong muốn rất nhanh qua việc dò tìm mã ký tự. Lặp lại các bước ở trên cho mỗi ký tự 

không mong muốn tiếp theo.  

- Chuyển đổi con số dạng văn bản sang số thực 

Các giá trị số (number) trong Excel được mặc định canh lề phải và văn bản (text) thì canh lế trái. 

Do vậy, cách đơn giản để nhận biết các giá trị số và văn bản trong một cột trên bảng tính là bạn 

thiết lập chế độ canh lề mặc định cho cột đó. Bạn vào Home ➝ nhóm Alignment ➝ chọn Format 

Cells ➝ vào Tab Alignment ➝ chọn General tại hộp Horizontal để thiết lập việc canh lề mặc định 

cho cột đang chọn ➝ nhấn OK để đóng hộp thoại Format Cells lại. 
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Bạn kéo cột rộng ra một ít để đễ phân biệt việc canh lề, khi đó bạn sẽ thấy các giá trị số, ngày 

tháng sẽ được canh lề phải và văn bản sẽ được canh lề trái. 

Dùng Paste Special để chuyển giá trị số dạng văn bản sang số thực 

Đây là cách nhanh và dễ dàng nhất để chuyển các giá trị số dang văn bản sang số thực. Các bước 

thực hiện như sau: 

Chọn một ô trống nào đó và nhấn lệnh Copy (Ctrl + C)➝ quét chọn vùng số liệu dạng văn bản 

định chuyển đổi (ví dụ như vùng A1:A9 ở hình trên) ➝ nhấp phải chuột và chọn Paste Special… 

➝ chọn Add tại nhóm Operation ➝ nhấn OK để hoàn tất. 

 

Việc làm trên sẽ giúp chuyển toàn số các con số dạng văn bản sang số thực, vì ô rỗng có giá trị là 

0 và khi bạn cộng bất kỳ số nào vào một con số lưu dưới dạng văn bản trong Excel thì bạn đã làm 

cho con số dạng văn bản chuyển thành số thực. 
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Dùng các hàm TEXT để chuyển đổi 

Bạn có thể áp dụng nguyên tắc như cách trên vào một số hàm có sẵn của Excel để thực hiện việc 

chuyển đổi. Thông thường, khi bạn dùng một hàm thuộc nhóm TEXT và kết quả trả về dưới dạng 

con số thì Excel vẫn xem con số đó là giá trị dạng văn bản. 

Giả sử bạn có một vùng dữ liệu A1:A7 như hình sau: 

 

Bạn dùng hai hàm trong nhóm TEXT là LEFT và FIND để tách các giá trị ra khỏi các chuỗi văn 

bản như sau: 

 

=LEFT(A1,FIND(" ",A1)-1) 

Sau khi dùng hàm để tách phần giá trị ra thì các kết quả trả về vẫn được Excel xem như là văn bản 

vì chúng được canh lề trái như hình sau: 

Do vậy, bạn cần phải hiệu chỉnh công thức tác chuỗi trên một ít để kết quả trả về là các con số 

thực sự bằng cách cộng thêm số 0 vào sau công thức trên: 

=LEFT(A1,FIND(" ",A1)-1) + 0 

 

- Tăng thêm số lần Undo cho Excel  

Tất cả chúng ta đều đã quen thuộc với chức năng Undo của Excel, cho phép chúng ta làm lại những 

sai lầm của mình. Tuy nhiên, mặc định, chúng ta chỉ có thể Undo được 16 lần. Chiêu này giúp bạn 

có thể tăng số lần Undo lên nhiều hơn, có thể đến 100 lần. 
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Khi bạn sử dụng chức năng Undo của Excel, và bạn đã thực hiện Undo 16 lần, thì nút Undo bị mờ 

đi, không thể Undo được nữa. Ngoài ra, khi bạn nhấn nút Save để lưu bảng tính, thì nút Undo cũng 

bị mờ đi, và danh sách những tác vụ (những hành động đã thực hiện trên bảng tính) mà bạn đã 

thực hiện bị mất sạch. Đó là do khi bạn lưu bảng tính, Excel cho rằng bạn đã hài lòng với bảng 

tính này (thì mới nhấn Save), và nó thấy rằng không cần thiết phải giữ lại danh sách những tác vụ 

trước khi lưu nữa. 

Bạn có thể thấy rằng, quay lui lại 16 lần là không đủ, nhưng làm cách nào để tăng số lần này lên? 

Nghĩa là làm cách nào để tăng danh sách các tác vụ của bạn lên? Thưa rằng, có cách, và bạn có 

thể tăng con số này lên đến 100 lần. 

Để làm điều này, trước hết, bạn hãy thoát khỏi Excel. Sau đó bạn chạy lệnh Run của Windows 

(Start | Run, hoặc nhấn phím Window + R), gõ vào đó Regedit.exe và nhấn OK.  

 

Khi bạn đã mở được chương trình Regedit, hãy tìm đến khóa: 

HKEY_CURRENT_USER \ Software \ Microsoft \ Office \ 11.0 \ Excel \ Options  

Con số 11.0 ở trên đây có thể khác, ví dụ với Excel2000 thì nó là 10.0, với Excel 2010 thì nó là 

12.0 



211 

Trung tâm Công nghệ thông tin và Truyền thông Nghệ An 

 

Nhấn Edit | New | DWORD Value (xem hình). Một mục mới New Value #1 sẽ được tạo ra trong 

khung bên phải, bạn nhập vào đó chữ UndoHistory, và nhấn Enter. 
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Nhấn đúp (double-click) vào mục UndoHistory mới tạo, rồi gõ vào hộp thoại mở ra một con số 

bất kỳ, miễn là lớn hơn 16 và nhỏ hơn 100. Nhấn OK, rồi thoát Regedit. 

 

Bạn hãy khởi động lại Excel và thử làm gì trong đó, rồi nhấn vào nút Undo xem bạn có thể Undo 

được bao nhiêu lần nhé. Hy vọng rằng Undo 100 lần, đã là quá đủ cho bạn. Tuy nhiên, nếu bạn 

nhấn lưu bảng tính, thì danh sách các tác vụ có thể Undo  

- Tách họ và tên trong cùng một cột trên bảng tính Excel 
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Bước 1: Khi nhập liệu vào bảng tính Excel, thông thường ta nhập cả họ và tên vào cùng một ô. 

Tuy nhiên, có khi sau đó ta cần phải tách riêng tên ra khỏi họ và tên đệm, nếu làm thủ công bằng 

thao tác sao chép rồi dán qua ô khác thì sẽ rất bất tiện. Nếu sử dụng hàm Right kết hợp với một 

vài hàm khác thì cũng có thể cho ra kết quả như bạn muốn, nhưng trong một số trường hợp sẽ cho 

kết quả không chính xác. Có một phương pháp tối ưu hơn sẽ giúp bạn hoàn thành tốt công việc 

này, cách thực hiện cũng khá đơn giản như sau: 

Bước 2: - Trên bảng tính chứa cột họ tên cần tách, nhấn Alt+F11 

Bước 3: - Tiếp theo, bạn nhấn menu Insert và chọn Module sẽ xuất hiện một cửa sổ soạn thảo.  

 

Bước 4: Bạn nhập đoạn mã lệnh sau vào cửa sổ soạn thảo: 

Private Function Tachten(ten As String, lg As Integer) 

Dim j As Integer 

Name = Trim(ten) 

For j = Len(Name) To 1 Step -1 

If Mid(Name, j, 1) = " " Then 

If lg = "1" Then 

Tachten = Right(Name, Len(Name) - j) 

Else 

Tachten = Left(Name, j) 

End If 

Exit For 

End If 
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Next 

End Function 

Bước 5:- Bạn nhấn Ctrl+S để lưu lại và quay trở về bảng tính Excel. 

Bước 6:- Bây giờ để tiến hành tách riêng họ và tên đệm vào một ô mới, bạn đặt con trỏ tại ô mới 

chứa họ và tên đệm rồi nhập vào công thức =TachTen(B3,0) và nhấn Enter sẽ thấy ngay kết quả. 

- Để tách riêng tên vào một ô mới, bạn đặt con trỏ tại ô sẽ chứa tên cần tách và nhập vào công thức 

=TachTen(B3,1) rồi nhấn Enter là xong. 

Ghi chú: B3 chính là địa chỉ của ô ban đầu chứa cả họ, tên đệm và tên. 

- Tạo mục lục trong Excel 

Nếu bạn đã tốn quá nhiều thời gian trong một workbook (bảng tính) với rất nhiều worksheet (trang 

tính), bạn sẽ cảm thông được sự khó khăn trong việc tìm kiếm một trang tính nào đó. Khi đó, có 

lẽ ta nên lập một chỉ mục các trang tính đang có để thuận tiện cho việc điều hướng trong bảng tính.  

Bằng cách sử dụng một chỉ mục các trang tính sẽ cho phép bạn nhanh chóng và dễ dàng điều 

hướng trong bảng tính, chỉ bằng một cú nhấp chuột sẽ đưa bạn đến chính xác nơi bạn muốn đến 

mà không lo bị nhầm lẫn. Bạn có thể tạo một chỉ mục trong một vài cách: bằng tay, tự động tạo ra 

bởi mã VBA, hoặc là sử dụng trình đơn tùy chọn theo ngữ cảnh (thậm chí có thể dùng các hàm 

Macro4 – không trình bày ở đây). 

Tạo chỉ mục thủ công 

Cách này rất dễ làm, bạn chỉ cần chèn mới một worksheet và đăt cho nó một cái tên, ví dụ như tên 

là Index. Sau đó, bạn nhận vào tên của các worksheet có trong workbook và tạo các siêu liên kết 

(hyperlink) đến các worksheet tương ứng với tên mà bạn nhập.  

Để tạo hyperlink bạn chọn tên sheet, sau đó vào Insert | chọn Hyperlink tại nhóm Links | Insert 

| Hyperlinks] hoặc nhấn phím tắt là Ctrl+K để mở hộp thoại Insert Hyperlink. 
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Chọn Place in This Document và chọn tên Sheet muốn kết nối tới. Nhấn nút OK để hoàn tất. 

Phương pháp này phù hợp khi bảng tính không có quá nhiều worksheet và tên worksheet không 

có sự thay đổi thường xuyên, nếu không sẽ gây ra nhiều khó khăn cho công tác bảo trì trang chỉ 

mục. 

Tạo chỉ mục tự động bằng cách sử dụng VBA 

Một cách thay thế khác là sử dụng VBA để tự động tạo ra các chỉ mục. Đoạn mã sau đây sẽ tự 

động tạo ra một bảng chỉ mục liên kết đến tất cả các worksheet mà bạn có trong workbook. Bảng 

chỉ mục này sẽ được tạo lại mỗi khi worksheet lưu chỉ mục được chọn.  

Đoạn mã này phải được đặt trong private module của Sheet chứa chỉ. Chèn một worksheet mới 

vào workbook và đặt tên cho nó là Index chẳng hạn. Nhấp chuột phải vào tên worksheet vừa tạo 

và chọn ViewCode từ trình đơn ngữ cảnh hoặc nhấn tổ hợp phím Alt+F11. 

Nhập đoạn mã VBA sau vào cửa sổ Code: 

Private Sub Worksheet_Activate() 

 Dim wSheet As Worksheet 

 Dim lCount As Long 

 lCount = 1 

    

With Me 

  .Columns(1).ClearContents 
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  .Cells(1, 1) = "INDEX" 

End With 

For Each wSheet In Worksheets 

  If wSheet.Name <> Me.Name Then 

   lCount = lCount + 1 

   With wSheet 

     .Range("A1").Name = "Start" & wSheet.Index 

     .Hyperlinks.Add Anchor:=.Range("A1"), Address:="", SubAddress:= _ 

     "Index", TextToDisplay:="Back to Index" 

   End With 

   Me.Hyperlinks.Add Anchor:=Me.Cells(lCount, 1), Address:="", SubAddress:= _ 

   "Start" & wSheet.Index, TextToDisplay:=wSheet.Name 

 End If   

Next wSheet 

End Sub  

Nhấn tổ hợp phím Alt+Q để thoát VBE và trở về cửa sổ bảng tính, sau đó lưu bảng tính lại. Để 

chạy đoạn mã vừa tạo, bạn dùng chuột chọn sang worksheet khác trong workbook và sau đó chọn 

lại worksheet Index để kích hoạt sự kiện Worksheet_Activate. 

Lưu ý rằng, đoạn mã sẽ các đặt tên (Name) cho các ô A1 ở mỗi worksheet kèm theo số chỉ mục 

của worksheet trong bảng tính (worksheet đầu tiên có chỉ mục là 1, kế đó là 2, 3…. n). Điều này 

bảo đảm rằng ô A1 trên mỗi trang tính có một tên khác nhau. Nếu ô A1 trên worksheet của bạn đã 

được đặt tên, bạn nên cân nhắc đến việc thay đổi ô A1 trong đoạn mã sang một địa chỉ khác phù 

hợp hơn. 

Lưu ý, nếu bạn có thiết lập Hyperlink base (siêu liên kết cơ sở) trong workbook thì các hyperlink 

được tạo ra từ đoạn mã trên sẽ không thể hoạt động được, do chúng đã liên kết đến các Name trong 

workbook hiện hành. Khi thuộc tính hyperlink base được thiết lập thì các siêu liên kết sẽ trỏ đến 

hyperlink base kết hợp với các Name. 

 


